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Introduction
Congratulations! As the owner of a ne
you have joined the worldwide comm
computer users. Once your computer 
the Internet, you can explore vast regi
entertainment, and online services.

This guide is designed to help you:

➜ Get acquainted with computer feat

➜ Keep your computer running smoo
tools

➜ Solve problems if they occur
1

w Compaq Internet PC, 
unity of Presario 
is set up and connected to 
ons of information, 

ures you’ll want to try

thly using its built-in 
In This Chapter

Who Should Read This 
Guide?,   1-2

Symbols and Graphics 
Used,   1-3

Where Can I Find 
Information?,   1-4

Safety,   1-5

How Do I Find Information 
in this Guide?,   1-6
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Who Should 
Read This 
Guide?

This guide is designed for 
both beginners and 
experienced computer 
users. You can read from 
cover to cover to gain basic 
information about your 
computer or scan the guide 
for information on a 
specific topic.

The Glossary in the back 
of this guide contains 
definitions of computer 
terms in everyday 
language. 

This chapter shows you 
how to use this guide and 
directs you to other sources 
of information.
1-2  INTRODUCTION
Who Should Read This Guide?

Using the My Presario—Learning More 
Guide
This easy-to-scan guide helps you find the information you 
want as quickly as possible. The page layout lets you see at a 
glance how the information is organized.

The first column lists major topics. It explains what the topic is 
and why it is important to you. This column also lists important 
warnings and useful tips, and it directs you to additional 
reference materials. 

The second column explains how to perform a procedure. It 
contains step-by-step instructions.

The third column uses graphics to help you visualize the task 
and to validate what you are doing, as you do it. Detailed 
graphics may span both columns.
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Symbols and 
Graphics Used

Warnings and cautions are 
displayed to protect you 
from injury, your 
equipment from damage, 
and your files from data 
loss.
MY PRESARIO—LEARNING MORE
Symbols and Graphics Used

The following words and symbols have special meaning in this 
guide:

Failure to follow directions 
may result in bodily harm or 
loss of life.

Understanding the background 
or concept may help you solve 
a problem.

These helpful hints make using 
your computer easier and 
faster.

Another document or another 
page in this document has 
related information.

�Caution:  Failure to follow directions may result in damage to your 
equipment or loss of data.

Computer Illustrations and Features
The computer illustrations shown and the features described in 
this guide may differ slightly from your Compaq Presario 
Internet PC.

Warning

Did you know ...

Tip

See also ...
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Where Can 
I Find 
Information?
Information is available in 
several forms: printed 
documents, electronic 
documents on this CD, and 
the Compaq Web sites. Use 
the My Presario—Getting 
Started guide first, then 
refer to this guide and the 
following documents as 
necessary:

➜ Quick Setup poster

➜ Safety and Comfort 
flyer

➜ Warranty Certificate

➜ Presario Newsletter

➜ Getting Started: 
Microsoft Windows 
manual

The Compaq Web site is 
available worldwide. As you 
explore the Internet, go to 
the following address for 
information about products, 
services, and “cool” 
activities:

www.compaq.com

Did you know ...
1-4  INTRODUCTION
Where Can I Find Information?

Warranty Certificate
The warranty details Compaq’s commitment to repair or replace 
parts during the warranty period and lists important Compaq 
telephone numbers. In the event of a mechanical problem 
contact Compaq, not the retailer who sold you the 
computer.

Keep the warranty in a safe place for future reference.

Replacing Parts
The Easy Access design of your Internet PC allows you to 
access internal components, in most cases without using any 
tools.

The document you are reading, My Presario—Learning More, 
describes procedures for upgrading and replacing computer 
components. If you are unable to resolve a problem after 
referring to this guide and the My Presario—Getting Started 
guide, call Compaq Technical Support. If a replacement part is 
needed, the technician will send the replacement part along with 
illustrated instructions for removing the factory-installed part 
and replacing it.

Upgrading Your Computer
Expand your Presario performance with component upgrades 
(such as more memory) and additional peripherals (such as 
digital cameras and printers). To learn more, visit the online 
store at:

www.compaq.com
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Safety

Your computer is an 
electrical device. Treat it 
with care to avoid personal 
injury and damage to the 
equipment.

To reduce the risk of electric 
shock and damage to the 
equipment, read the Safety 
and Comfort document before 
performing any procedures 
involving the internal 
components of your computer.

During an electrical storm, 
disconnect your computer 
(and all peripherals) from the 
power source. After shutting 
down your computer, turn off 
the power button(s) on the 
surge protector(s).

Warning

Warning
MY PRESARIO—LEARNING MORE
Safety

Safety and Comfort
The My Presario—Learning More CD contains safety and 
comfort information about how to:

➜ Set up your work area for maximum comfort

➜ Practice good posture, hand position, work habits, and 
health habits while using your computer

➜ Use a grounding plug to prevent electrical shorts, shocks, or 
fires

➜ Use a surge protector to regulate the flow of electricity to the 
computer, modem, and all peripherals—such as a printer, 
speakers, and monitor

➜ Become static-free before removing the side panel
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How Do I Find Information in this Guide?

Using the My Presario—Learning More CD
1. The screen displays the file 

hierarchy in the navigation 
panel on the left 1 and the 
contents on the right 2.

Note: Click the Plus + sign 3 
next to a topic in the left panel to 
display subtopics.

2. Click the topic you want to 
view. The topic you selected 
is displayed on the screen. 

Note: If necessary, use the scroll 
bars 4 to view all of the page.

3. To view additional topics, 
click additional topics from 
the navigation panel 1.

Note: You can click the navigation 
panel Show/Hide button 5 to 
close the navigation panel and 
enlarge the contents panel.

4. When you finish, click the 
word exit (a hyperlink) in 
the lower right corner of the 
screen or click the Close ∫ 
button in the upper right 
corner of the screen (on the 
title bar).

Note: You can print individual pages 
from the CD or the entire set of 
documents. You can also print pages 
from a Web site.

4

 

 

 

 

 

 

How Do I Find 
Information in
this Guide?

This guide has information
on the following topics:

➜ Advanced features of 
your computer

➜ Solving computer 
problems

➜ Creating CDs

➜ Connecting to the 
Internet

➜ Home networking

➜ Compaq service and 
support

➜ Upgrading your 
computer

➜ Government regulatory
information

Electronic documents often 
have hyperlinks to help you 
find information quickly. 
When you pass the cursor over
a hyperlink, a small hand S

is displayed. When you click a
hyperlink, it jumps to the 
referenced page. Hyperlinks 
are represented by navigation
buttons, colored text, and 
images.

Did you know ...
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Features 
Inside Your 
Computer

Your Internet PC is designed for comp
setting up your computer to upgrading

This chapter introduces you to the inte
of both the Presario 7000 Series and 5
you through the processes of registerin
setting up an Internet Service Provider

The remaining chapters of this guide s
use your Compaq Presario.

Note: Illustrations and features shown may d
computer.
2

lete ease of use—from 
 new components.

rnal and external features 
000 Series. It also walks 
g your computer and 
 (ISP) account.

how you how easy it is to 

iffer slightly from your 
In This Chapter

Your Presario at a Glance,   
2-2

System Board,   2-5

Plug In and Go!,   2-7

Registration,   2-8

Internet Service Provider 
(ISP),   2-9

Printer Setup,   2-10
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Your Presario 
at a Glance

Before you begin, you’ll 
want to become familiar 
with the components of 
your Compaq Presario. The 
components on the front of 
the 5000 and 7000 Series 
computers are similar.
2-2 FEATURES INSIDE YOUR COMPUTER
Your Presario at a Glance

What’ s in Front? (5000 and 7000 Series)

Note: The blank panels below the optical disk drives and the diskette drives 
are the areas reserved for adding additional drives. 

1 CD-ROM, CD-RW, or DVD-ROM 
Drive

4 Hard Drive Activity Light

2 Diskette Drive 5 Power On Button

3 Dual USB and 1394 (varies by 
model) Port for connecting 
Peripheral Devices, such as 
Gamepads, Joysticks, and 
Video Cameras

6 CD Storage for Storing Five 
CDs
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s 
Some components have 
color-coded connectors that 
match the ports on the back of 
your computer.

Tip
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What’ s in Back? (5000 Series)

Note: Connectors may vary by model.

1 Power Port 9 Microphone (light pink)

2 Voltage Switch - Ethernet Port for Connectin
to a Network (if equipped)

3 PS2 Port for Connecting a 
Keyboard

q Modem Port for Connectin
a Phone Line

4 USB Port for Connecting an Internet 
Keyboard or other USB Devices

w PS2 Port for Connecting a 
Mouse

5 Serial Port e Parallel Port for Connecting
Peripheral Devices, such a
Printers

6 Video Port (blue) r Game/MIDI Port

7 Audio Out (speakers) (light green) t Phone Connection

8 Audio In (MP3 Player) (light blue)
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to a 

lue)

en)
Some components have 
color-coded connectors that 
match the ports on the back of 
your computer.

Tip
2-4 FEATURES INSIDE YOUR COMPUTER
What’ s in Back? (7000 Series)

Note: Connectors may vary by model.

1 Power Port 9 Game/MIDI Port

2 Voltage Switch - Ethernet Port for Connecting 
Network (if equipped)

3 PS2 Port for Connecting a 
Keyboard

q Modem Port

4 USB Port for Connecting an 
Internet Keyboard or other 
USB Devices

w PS2 Port for Connecting a 
Mouse

5 Serial Port e Microphone (light pink)

6 Parallel Port r Audio In (MP3 Player) (light b

7 1394 Port t Audio Out (Speaker) (light gre

8 Video Port (blue) y Phone Connection
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System Board

The system board of your 
computer, sometimes called 
the motherboard, is the 
large Printed Circuit Board 
(PCB) inside your 
computer. It contains all the 
circuits that define the 
major parts of the 
computer. Every part of the 
computer is connected to 
the system board. 

The following components 
are located on a computer’s 
system board: 

➜ Processor 

➜ Memory modules 

➜ Real-time clock (RTC) 
and RTC battery 

➜ Jumpers 

➜ Expansion slots 
MY PRESARIO—LEARNING MORE
System Board

System Board (5000 Series)

1 Processor (your computer 
may include a heat-sink fan)

9 Real Time Clock Battery

2 Power Connection - PCI Slots (4)

3 Memory Slots (2) q Active (Fan) Heat Sink Plug

4 System Fan Plug (optional) w Game Port (top)/Audio Micropho
(bottom)

5 Diskette Drive Connection e Parallel Port/Video Port/Serial P

6 Power Button Connection r USB Port

7 USB Front I/O Board t Keyboard/PS2 Mouse

8 IDE Connectors HDD/CD-ROM
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System Board (7000 Series)

1 Processor - Power Button Connector

2 Active (Fan) Heat Sink Plug q Real Time Clock Battery

3 Power Connection w PCI Slots (5)

4 Memory Sockets (3) e 4X AGP Slot (Graphics)

5 1394 Front I/O Board r 1394 Connector

6 USB Front I/O Board t Parallel Port

7 Diskette Connector y Serial Port

8 IDE Connectors: 
CD-ROM (top)/HDD (bottom)

u USB Port

9 System Fan Plug i PS2 Mouse Port; Keyboard Port
   MY PRESARIO—LEARNING MORE
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Plug In and Go!

Setting Up Your Computer

Note: Do not set up the printer until your computer is set up and you have 
registered your computer with Compaq.

1. Connect the monitor 
according to the 
color-coding, icons, and the 
instructions from the 
monitor manufacturer.

2. Connect the speaker cable 
and microphone cable (if 
applicable).

3. Connect the power cable.

4. Connect the keyboard to the 
rear USB port and the 
mouse to the PS2 port.

5. Connect the telephone cable 
between the Modem Line In ~ 
port and the wall outlet.

6. Plug the monitor and 
computer power cables into 
the wall outlet or surge 
protector.

7. Turn on the monitor and 
press the Power On 1 
button to turn on your 
computer.

Note: If you are setting up your computer for the first time, follow the 
on-screen instructions to register both your operating system and your 
computer. The next topic discusses the registration process.

 
 

 

 

 
 

 

t 
Plug In and Go!

If a cable is disconnected or
you move your computer to
another location, this topic
helps you to set up again 
quickly.

It’s important to purchase a 
surge protector to protect your
computer from electrical 
spikes and power surges.

The Quick Setup poster that 
came with your computer is a
visual guide to setting up your
computer.

If you have home networking,
refer to the home networking 
documentation for 
instructions on how to connec
your phone lines.

Tip

See also ...

Tip
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Registration

Registering with Microsoft

To register the Windows operating system with Microsoft, 
follow the on-screen instructions. After entering the appropriate 
information on each screen, click the Next button to move to 
the next screen.

When you have finished, register your computer with Compaq.

 
Registering with Compaq

To register your computer with Compaq, follow the on-screen 
instructions. After entering the appropriate information on each 
screen, click the Next button to move to the next screen.

When you have finished, you are ready to set up an account 
with an Internet Service Provider (ISP). Refer to the next page 
for details.

 

 

 
 

 

Registration

The first time you turn on 
your computer, you are 
guided through the 
registration process before 
you can access the 
Windows desktop. It is very
important that you register

➜ Windows with 
Microsoft

➜ Your computer with 
Compaq

Registering with Microsoft
enables you to receive 
software updates and 
important notices about 
new Microsoft products.

Registering with Compaq 
enables you to receive 
technical support for the 
hardware, software updates
for Compaq programs, and
other special offers.

Any time you install new 
software or hardware, be sure
to register it with the 
manufacturer.

Did you know ...
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Internet Service Provider (ISP)

Setting Up an ISP Account

After registering with Microsoft and Compaq, you are prompted 
to set up an ISP account. 

Note: Credit cards are required to register with Compaq.NET powered by 
MSN and America Online. However, you can check your local area for ISPs 
that offer other financial arrangements.

To set up your ISP account, do one of the following:

➜ If you want Compaq.NET powered by Microsoft Network 
(MSN) as your ISP, click the Compaq.NET powered by 
MSN icon and follow the on-screen instructions.

➜ If you already have Compaq.NET powered by MSN as your 
ISP, click I already have Compaq.NET powered by MSN 
and follow the on-screen instructions.

➜ If you want America Online (AOL) as your ISP, click the 
America Online icon and follow the on-screen instructions.

➜ If you already have America Online as your ISP, click
I already have America Online and follow the on-screen 
instructions.

➜ If you already have an existing Internet account other than 
Compaq.NET powered by MSN or America Online, click 
I Already Have an Internet Provider and follow the 
on-screen instructions.

Note: If you do not sign up for an ISP account now, you can click the
Free Internet Trial icon on your desktop and sign up anytime you like.

 

 

 

 
!

 

Internet Service
Provider (ISP)

An ISP gives you access to
the Internet. Just as you 
need an account with a 
cable company to have 
cable service, you must also
have an ISP account to 
access the Internet and to 
use e-mail.

After setting up your 
Internet connection, you 
can press the Instant 
Internet ∆ button on your 
Internet keyboard, and like
magic—you’re on the Web

If you have problems 
connecting to an ISP, call the
ISP for assistance.

Did you know ...
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Printer Setup

Setting Up Your Printer

1. Complete the “Plug In and Go!” and “Registration” 
processes first (described on previous pages).

2. Set up the printer according to the printer manufacturer’s 
instructions.

3. Connect the printer to the back of your computer according 
to the illustration below.

4. Turn on your computer (if it’s not already on).

5. Turn on the printer.

6. Follow the on-screen instructions. If prompted, insert the 
printer set-up diskette.

     

Note: Location and style of connectors may vary by model.

 

 
 
 

 

Printer Setup

After setting up and 
registering your computer, 
you are ready to set up your
printer.

A printer allows you to 
print any document from 
your My Presario—
Learning More CD, your 
e-mail, and Web sites.

Compaq registration must be 
complete before you plug in 
your printer and run the 
printer set-up diskette.

Most new computers have a 
Universal Serial Bus (USB) 
port for a new printer that 
uses the latest technology. 
Older printers, which plug 
into a parallel port, cannot be
connected to a USB port. Your
printer may use a USB plug 1
(rather than a parallel
plug 2) for installation. USB
is new technology on all 
currently manufactured 
computers.

Did you know ...

Did you know ...
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3Using Your 
Computer
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Scroll Mouse,   3-6

Hard Drive, CD- ROM and 
DVD-ROM Drives,   3-9

Power Management,   3-10
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In this chapter, you will learn about the following exciting, 
easy-to-use features of your computer:

➜ Keyboard—Become 
familiar with some of the 
more advanced features of 
your keyboard. 

➜ Scroll Mouse—Learn how 
to use your scroll mouse to 
perform some of the more 
advanced functions.

➜ Hard Drive, CD-ROM, 
and DVD-ROM—
Determine the size of your 
hard drive and how to 
remove a CD or DVD disc manually.

➜ Power Management—Learn 
how to reduce the power 
consumption of your computer.
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Keyboard 
Buttons
The keyboard buttons make 
it easier and faster to get on 
the Internet and to use your 
favorite software. Imagine 
playing a CD while you use 
your computer. You might 
even want to watch a 
movie, send e-mail to 
someone, or pay your bills.
3-2 USING YOUR COMPUTER
Keyboard Buttons

All the keyboard buttons are shown in the following illustration. 
Some of the more advanced button functions are discussed 
below.

Note: Buttons may vary by model and region.

1 CD/DVD Control Buttons 5 Volume/Mute Button

2 Internet Zone Buttons 6 Sleep Button

3 Quick Launch Help Button 7 LED Status Lights

4 Quick Launch My Program Button
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The Help G button takes you 
to the Service and Support 
folder for help with the 
following programs:

➜ McAfee Active Shield

➜ Compaq Remote 
Support

➜ Compaq Service 
Connection

➜ Compaq Diagnostics

➜ Quick Restore

After you assign the Help G  
button, it remains set until you 
reassign it.

To restore the Help Web site, 
select Restore to Default 
Settings when reassigning the 
Help G button.

Tip
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Reassigning the Help Button
1. From the Windows desktop, 

click the Start button. 

2. Point to Settings and then 
click Control Panel. The 
Control Panel window is 
displayed.

3. Double-click the Easy Access Buttons ÿ  icon. The 
Compaq Easy Access Button Settings window is displayed.

4. Press the Help G button. 

5. Select either Program or Web site and click Next.

6. Select the program, document, or Web site you want help for 
to program the Help G button.

7. Click OK to verify your selection.

8. Click OK to apply your selection.
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If you have already 
assigned the 
My Program D button, this 
procedure allows you to 
reprogram it to a different 
program, document, or Web 
site as often as you like.

After you reassign the 
My Program D button setting, 
pressing the button 
automatically opens your 
selected program, document, 
or Web site.

Tip
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Reassigning the My Program Button
1. From the Windows desktop, 

click the Start button.

2. Point to Settings and then 
click Control Panel. The 
Control Panel window is 
displayed.

3. Double-click the Easy Access Buttons ÿ  icon. The 
Compaq Easy Access Button Settings window is displayed.

4. Press the My Program D button.

5. Select Launch a new program or Launch a new Web site.

6. Click Next.

7. Select the program, document, or Web site you want to 
program to the My Program button.

8. Click OK to verify your selection.

9. Click OK to apply your selection.
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Some Internet buttons have 
a default function, and 
others can be assigned a 
function such as calling up 
your favorite Internet page 
or reading your e-mail. 
After they have been 
assigned a function, these 
buttons can be reassigned 
to a different function.
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Customizing the Internet Zone Buttons
1. From the Windows desktop, click the Start button.

2. Point to Settings and then click Control Panel. The Control 
Panel window is displayed.

3. Double-click the Easy Access Buttons ÿ icon. The 
Compaq Easy Access Button Settings window is 
displayed—this is where you select the button you want to 
program.

4. Press the Internet button you would like to program. This 
will take you to a Web site that provides instructions for 
reassigning the Internet button.

1 Search 5 My Presario

2 Activity 6 Retail/Affinity Central

3 E-mail 7 Entertainment

4 Instant Internet
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Scroll Mouse
Your computer comes with 
a scroll mouse. The scroll 
mouse directs a cursor on 
the Windows desktop, and 
you use the cursor to move 
quickly and easily through 
a document or Web site.

Instead of using the scroll 
bar, you can move the 
scroll wheel forward or 
backward through a 
document or Web site.

Moving and copying text 
and graphics is known as 
dragging and dropping or 
drag and drop. As you 
perform this procedure, an 
outline of the graphic or 
text appears as you move 
your selection to the new 
location.

Some mouse functions may not 
work with all software.

Tip
3-6 USING YOUR COMPUTER
Scroll Mouse

Moving and Copying Text and Graphics

Text 

1. In some word processing programs, you can select the 
desired text by clicking and holding down the left mouse 
button and dragging to highlight the text.

2. Place the cursor inside the selected text. 

3. Press and hold down the left mouse button while dragging 
the text to a new location. 

4. Release the left mouse button.

Graphics

1. Position the cursor over a graphic.

2. Press and hold down the left mouse button while dragging 
the graphic to a new location. 

3. Release the left mouse button.
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In most programs, you can 
select large amounts of text 
and graphics. You can then 
move, copy, or delete your 
selected text, graphics, or 
files.

Zooming in reduces the 
view of a document page, 
and zooming out enlarges 
the view.
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Selecting and Moving Large Amounts of 
Text and Graphics
1. Select the text or graphics: 

• For text, click at the 
beginning of your 
selection, hold down the 
left mouse button, and 
move the cursor to the 
end of your selection. 

• For graphics, click on the 
center of the graphic.

2. Drag the selection to the desired destination while holding 
down the left mouse button.

3. When the selection is positioned in the desired location, 
release the left mouse button.

Zooming In and Out
1. Place the cursor in a document.

2. Press and hold the Ctrl key on 
the keyboard.

3. Determine how much of the 
page you want to view:

• To zoom in and enlarge the 
area you want to view, move the wheel on the 
mouse forward.

• To zoom out and see more of the page, move the wheel 
on the mouse backward.
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You can select features for 
setting up your mouse, 
choosing button 
assignments, and 
controlling cursor 
movements.
3-8 USING YOUR COMPUTER
Customizing Your Mouse
1. From the Windows desktop, 

click the Start button.

2. Point to Settings and then 
click Control Panel. The 
Control Panel window is 
displayed.

3. Double-click the Mouse z 
icon. The Mouse Properties 
window is displayed.

4. Select the tabs and settings 
you prefer. The settings are 
listed in the following table:

Setting Description

Quick Setup Resets the mouse properties to the factory defaults.

Pointers Changes the appearance of the pointer.

Buttons Changes the button and the wheel functions. Click the 
Options button to change the mouse button assignment 
options. For more information, click Help.

Motion Sets the cursor speed and acceleration. Also enables Smart 
Moves and creates a pointer trail.

Orientation Changes the angle of the mouse movement.

Devices Adds another pointing device.
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Hard Drive, CD- ROM and DVD-ROM Drives

Identifying Your Hard Drive Size
1. From the Windows desktop, 

double-click the My 
Computer g icon. The My 
Computer window is 
displayed.

2. Right-click the Hard Drive 
q icon (drive C).

3. Select Properties from the 
pop-up menu. The 
Properties window is 
displayed. The size of the 
hard drive and the amount of 
free space remaining is found 
on the General tab.

Note: Your hard drive may be partitioned into two drives—drive C and drive 
D. The two drives make up your total hard drive capacity. If the capacity of 
your C drive does not match what is stated in the documentation, you can 
find the remaining capacity located on the D drive. The D drive contains 
important system backup files and diagnostics.

Manually Removing a Disc from Your 
CD-ROM, CD-RW, or DVD-ROM Drive
1. Shut down your computer.

2. Gently push the tip of a 
paper clip into the hole 
under the 
CD-ROM/DVD-ROM 
drive. If the hole is not 
visible, you can locate it 
under the pull-down flap.

 

, 
Hard Drive, 
CD-ROM and 
DVD-ROM 
Drives
Your computer has an 
internal hard drive with a 
permanent storage disk. 
Each computer has a 
different capacity for 
storing information.

If the power fails while you’re
playing a CD or DVD disc, 
the disc may not eject 
automatically. If this happens
you can remove the disc 
manually. 

Tip
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Power Management

Setting Your Computer Power 
Management
1. From the Windows 

desktop, click the Start 
button, point to Settings, 
and then click Control 
Panel. The Control Panel 
window is displayed.

2. Double-click the Power 
Management : icon. The 
Power Management 
Properties window is 
displayed.

3. On the Power Schemes tab, 
click the drop-down arrow next 
to the System standby box 1, 
and select a time.

4. Click Apply 2, and then click 
OK 3.
Power 
Management
Power management lets 
you reduce the power 
consumption of selected 
devices or of your entire 
system.
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Creating 
Your Own 
CDs

As technology advances, so does the way
In the earlier years of personal computers
stored on diskettes. Now information can

Today, because of the limited capacity of
use them to store and carry information. T
that replaced phonograph records is now 
medium to use for storing and carrying in
personal computers. In fact, the audio CD
homes are physically identical to the data
computers.
4

 we store information. 
, information could be 
 be stored on a CD.

 diskettes, we seldom 
he same circular disc 

the most common 
formation to and from 
s we play in our 
 CDs we load into our 
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CD-RW Drive

Always handle a disc by 
holding it by the edges or the 
center hole to prevent 
scratches to the surface.

Your CD-RW drive has the 
following attributes:

➜ Supports standard CDs, 
write-once CD-R, and 
rewritable CD-RW discs.

➜ Can create your own 
audio CDs, share 
information, and save 
data for backups and 
other data storage needs.

If your CD tray fails to 
open when you press the 
Load/Eject ≤ button or 
when you right-click on the 
drive letter within Windows 
Explorer and select Eject, 
you must eject your CD 
manually.

Ensure that the power to the 
computer is turned off before 
manually ejecting a disc.

Tip

Did you know ...

Warning
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CD-RW Drive

Inserting a Disc Into a CD-RW Drive
1. Press the Load/Eject button 

1 that is located on the front 
of your CD-RW drive.

2. Carefully lift the disc from its 
case by holding the disc only 
by the inner and outer edges 
to avoid touching the surface.

3. Place the disc, label side up, into the round area of the tray. If 
the tray has support tabs, carefully slide the disc under the 
tabs to position it correctly in the tray.

4. Press the Load/Eject ≤ button again to close the drive.

Removing a Disc
1. Press the Load/Eject button 1 that is located on the front of 

your CD-RW drive.

2. Carefully lift the disc out of the tray and return it to its case.

3. Press the Load/Eject ≤ button again to close the drive.

Manually Ejecting a Disc
Gently push the tip of a paper 
clip into the hole under the 
drive. The disc should eject 
easily.
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CD-R/CD-RW 
Media Basics
Would you like to know 
how to use discs with your 
computer? This section 
helps you understand how 
creating CDs can make 
your computer experience 
more enjoyable and can 
expand your PCs capability.

Compaq recommends that the 
media used with your CD-RW 
drive be of high quality. 

While CD-R discs can be 
written to only once, CD-RW 
discs can be written to, 
erased, and rewritten many 
times.

CD-R/CD-RW discs must be 
purchased separately.

Did you know ...

Tip

Did you know ...
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CD-R/CD-RW Media Basics

Types of Media/Discs
CD-R media has the following features:

➜ CD-R discs can be read by virtually all CD-ROM, DVD-
ROM, and CD-RW drives.

➜ CD-R discs are recommended for copying music to play on 
a home or car stereo.

➜ CD-R discs are recommended for permanent data storage 
and archiving.

➜ CD-R discs can be written to only once. However, you can 
write to CD-R discs in multiple recording sessions. 
Information written to a CD-R disc cannot be erased from 
the disc.

CD-RW media has the following features:

➜ CD-RW discs can be used to create CD backups of files or 
other CDs.

➜ CD-RW discs are reusable and can be erased and rewritten 
as many times as you like.

➜ CD-RW discs can be used to make a practice CD or to test 
the contents of a CD before making a permanent one.
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Installing 
Adaptec Easy CD 
Creator 

You must close all other 
Windows programs before 
installing Adaptec Easy CD 
Creator.

Installation is only required 
when Easy CD Creator is not 
pre-installed or if you had to 
restore your computer to the 
original factory condition.

Internet Explorer 4.01 or 
higher must be installed on 
your system before you can 
install Easy CD Creator. If 
Internet Explorer is not found 
on your system, you are 
prompted to install Internet 
Explorer 5 before continuing 
with Easy CD Creator 
installation.

Tip

Tip

Did you know ...
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Installing Adaptec Easy CD Creator 

Steps to Install Adaptec Easy CD Creator 
Software

�Caution:  Before installing Adaptec Easy CD Creator, you must 
uninstall any other CD recording software. This includes deleting all 
shared files if prompted to do so.

1. Insert the Adaptec Easy CD Creator disc into the CD-RW, 
DVD-ROM, or CD-ROM drive and complete the following 
steps to install the Adaptec Easy CD Creator software.

Note: You must follow these instructions to install both Easy CD Creator 
and Direct CD.

If Autorun is enabled on your system, the Adaptec 
Installation window is displayed automatically and you can 
skip steps 2 and 3.

2. From the Start menu, select Run.

3. Type e:\setup (substitute “e” for the appropriate drive letter 
of your CD-RW, CD-ROM, or DVD-ROM drive).

4. From the Adaptec Installation window, select Easy CD 
Creator and the desired language.

5. Follow the installation instructions that are displayed on the 
screen.

6. When the installation is complete, click Finish. The Adaptec 
Installation window is displayed again (repeat steps 4-6 to 
install DirectCD).

7. Click Exit to exit the Adaptec Installation window.

8. Restart your computer when prompted so the changes take 
effect.
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Creating Your 
Own CDs
Easy CD Creator is the 
easiest way to put your 
world on CD. In just a 
couple of mouse clicks you 
can create audio CDs that 
can be played on your 
home or car CD players, or 
create data CDs to store 
data such as folders and 
files that are on your hard 
drive.

CD Guide (see graphic in 
right column) helps you step-
by-step through creating 
Audio CDs, Data CDs, and 
designing custom jewel case 
inserts and CD labels.

To show or hide CD Guide 
click the CD Guide button on 
the toolbar.

Tip
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Creating Your Own CDs

Opening Easy CD Creator
1. Click the Start button.

2. Select Programs from the pop-up menu.

3. Select Adaptec Easy CD Creator from the pop-up menu.

4. Select Create CD from the next pop-up menu.

The following menu options are 
available from the Easy CD 
Creator Main menu.

➜ Audio

➜ Data

➜ CD Copier

➜ Jewel Case Creator

➜ Deluxe Upgrade

�Caution:  Easy CD Creator is designed to assist you with 
reproducing material for which you own the copyright or have 
obtained permission to copy from the copyright owner. 
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Creating an 
Audio CD
An Audio CD is a compact 
disc (CD) used to record 
music from tracks and audio 
files (for example, WAV or 
MP3 files) and can be played 
on your home or car stereo 
CD player. Here are some of 
the things you should know 
about an Audio CD:

➜ An Audio CD is used for 
playing music and not 
for data storage.

➜ An Audio CD can also 
be played on most 
computers that have a 
CD-ROM, DVD-ROM, 
or CD-RW drive by 
using a program such as 
the Windows CD Player.

➜ An Audio CD is ideal for 
copying your favorite 
music from other CDs 
and from audio files to 
create new CDs. You can 
even create your own 
“greatest hits” Audio CD 
that contains tracks from 
multiple music CDs. 
Once you have 
completed your 
recording session, you 
must close (or finalize) 
the disc in order to listen 
to it on your home or car 
CD player. 
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Creating an Audio CD

Creating an Audio CD
1. Click the Audio button on the Easy CD Creator Main menu. 

2. Click the Audio CD button on the Audio menu.

3. An Easy CD Creator window with three panels is displayed.

• Explorer window—upper left

• CD Title window—upper left

• CD Layout window—lower half

Note: The CD Layout is where you assemble and organize the files, 
folders, and tracks that you want to record to a CD-R. The CD Layout 
must list all of the files and/or tracks you want recorded before you can 
record the CD-R.

4. If you are recording tracks from an existing music CD 
(source disc), insert the music CD into your CD-ROM, 
DVD-ROM, or CD-RW drive (the source drive). If you are 
recording WAV or MP3 files, continue with the next step.

Note: You can record any combination of tracks, WAV, or MP3 files to an 
Audio CD.

5. In the left pane of the 
Explorer section, select the 
letter of the drive containing 
the music CD. A list of the 
tracks on the CD is 
displayed to the right. If you 
are recording WAV or MP3 
files, select the folder where 
your files are located.

Note: If information about the music CD is located on your hard drive, 
the CD title, artist name, and the name of each track are displayed. If this 
information is not displayed, you must connect to the Internet and then 
click the CDDB Internet button on the toolbar to download the 
information from the online CDDB™ Music Service.
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Creating an 
Audio CD 
(continued)

1

1

1
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6. Highlight the tracks you want to record. Either click the Add 
button or click and drag the desired tracks (songs) to the CD 
Layout window. You may also record tracks from other 
sources, such as your hard drive, by using the Find Files 
button or by using the Explorer window.

Note: If you have tracks on other music CDs that you want to record, 
repeat steps 4-6 for each music CD from which you want to record. 
During the actual recording process, Easy CD Creator prompts you to 
reinsert the appropriate music CD for the track being recorded.

7. When you have organized your tracks (WAV or MP3) in the 
CD Layout section and you are ready to record, click the 
Create CD button. The CD Creation Setup box is displayed.

The CD Creation Setup box allows you to see the target 
device (the destination drive or drive you will be recording 
to), the write speed, and the number of copies. If you would 
like to view more of the recording options, click on the 
Advanced button. The default settings are as follows: Create 
CD, Track-at-Once, Leave Session Open.

8. When you have made your selection, click OK.

9. When you finish recording to your disc, you can either 
record additional tracks later if you didn’t close the CD, or 
you can close the CD.

0. When you click OK, you return to the CD Layout window.

1. If you plan to record additional tracks, delete all previously 
recorded tracks that are in the CD Layout window and repeat 
Steps 6 through 10.

2. When you are finished recording to your CD, click the 
Create CD button, select Close CD, and click OK. (When 
you have closed the CD, no additional tracks can be recorded 
to it).

�Caution:  When you choose to close/finalize a disc, the CD-RW 
drive tray ejects and then retracts during the closing process.
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Creating an 
Audio CD 
(continued)

See the “Troubleshooting” 
section in this chapter for 
hints on how to avoid buffer 
underruns.

To make a sleeve that lists the 
CD or audio titles and files, 
see the “Using Jewel Case 
Creator” section in this 
chapter.

Tip

Tip
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Suggestions for Creating Audio CDs
➜ Eliminating the two second gap between tracks: To 

prevent a two second gap from occurring between audio 
tracks, you can record sound files stored on your hard drive 
to a blank CD using the Disc-at Once option. When creating 
the CD, select the Disc-at-Once from the CD Creation Setup 
dialog box.

➜ Using CD Copier: If you want to make a backup copy of an 
entire CD from start to finish, use the Easy CD Creator CD 
Copier feature.

➜ Using a CD Image to Record Your CD: If you have 
enough space on your hard drive, you can create an Audio 
CD from a CD image and eliminate the possibility of a 
buffer underrun occurring. Using a CD image is also helpful 
when you are creating multiple copies of the same CD.

➜ Writing CD Text: CD Text is an Audio CD format that 
allows you to display CD information, such as the CD title, 
artist, and track titles on the CD. This information can then 
be displayed on consumer electronic devices that support 
CD Text information.

If your CD-RW drive supports CD text and the writing 
method currently selected is Disc-at-Once, you can enable 
the Write CD-Text Option from the CD Creation Setup 
dialog box.

➜ Entering UPC (Universal Product Code): With some CD 
recorders, you may define a thirteen-digit UPC catalog 
number for the entire CD. The number can be written in the 
CD’s Table of Contents. You can enter the UPC from the CD 
Layout Properties dialog box.
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Creating an 
Audio CD 
(continued)
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Advanced Settings Within Audio CD
The following options are available when you click the 
Advanced button (within the CD Creation Setup window).

Create Options
➜ Test Only: Select this option to perform a real test in which 

the files to be recorded are passed to the CD-RW. No actual 
information is recorded to the CD. Use this option if you 
have made any changes to your CD-RW setup.

➜ Test and Create CD: Select this option to perform a test in 
which the files to be recorded are passed to the CD-RW. No 
actual information is recorded to the CD. Recording begins 
after a successful test. Each time you create the CD and you 
do not want to perform the test, select Create CD below.

➜ Create CD: Select this option when you do not want to 
perform the test. This option begins the recording process 
immediately.

➜ Write CD-Text Info: Select this option if you want to 
include CD-Text information, such as CD title, artist, and 
track titles on the CD. This information can then be 
displayed on consumer electronic devices that support CD-
Text information. This option is available only when you 
write in Disc-at-Once mode and if your CD-RW supports 
CD-Text information.

Write Options
➜ Track-at-Once: Tracks recorded in Track-at-Once mode are 

separated by gaps. If a data track is followed by an audio 
track, the gap is two or three seconds. The gap between 
audio tracks is usually two seconds.

➜ Leave Session Open: Select this option to add more songs 
to the CD at a later time. By keeping the session open, you 
can record additional songs to the first session at different 
times. When you have added all the songs you want to the 
CD and you want to listen to it on a home or a car stereo CD 
player, you must close the session. (This is the default 
option.)
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Creating an 
Audio CD 
(continued)
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➜ Close Session and Leave CD Open: Select this option to 
close the session so that audio tracks (if in the first session) 
can be played back in home or car CD players. Because the 
CD remains open, you can continue to record additional 
sessions to the CD until it is full.

Note: When the session is closed, only audio on the first session can be 
played on home or car CD players. Home/car CD players are single 
session players; your computer is a multi-session player.

➜ Close CD: Select this option to write-protect the CD. When 
this option is selected, no more data can be recorded to the 
CD. (This enables audio to be played on home or car CD 
players).

➜ Session-at-Once: Select this option to record a single 
session and leave the CD open. For example, you can use 
the Session-at-Once to make CD Extra CD. First, record the 
audio tracks in the first session and leave the CD open. Then 
record a second (data) session and close the CD.

➜ Disc-at-Once: Select this option to write and close a CD in 
one operation without turning the writing laser on and off 
between tracks. This eliminates the two second gap between 
tracks and write-protects the CD. You can select this option 
if you are recording WAV or MP3 files stored on your hard 
drive or are recording music CD tracks.

➜ Set as Default: Select this button when you want to change 
the CD Creation Setup default options. 

Modifying an Audio CD Layout
The following sections describe how to make changes to the 
tracks listed in your Audio CD Layout.

Previewing a Track
Previewing a track allows you to hear a track as it will be 
recorded to your CD. This is especially useful if you want to 
preview any effects applied to the track.

Note: A sound card and speakers are required if you want to hear the tracks 
being previewed.
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Creating an 
Audio CD 
(continued)

A WAV is a file format in 
which Windows stores sounds 
as waveforms. Such files have 
the extension .wav. WAV files 
can be recorded at different 
rates. When WAV files are 
recorded at 44.1 kHz, 16-bits, 
and stereo, they are essentially 
identical to the music CDs 
that you buy.

Did you know ...
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To preview a track:

1. Select one or more tracks in the Audio CD Layout.

2. From the Track menu, select Preview. The Easy CD Creator 
CD Player appears and begins playing your tracks.

Extracting a Track to a WAV File

To extract a track from an existing CD:

1. Select the track you want to extract.

a. From the Start menu, open Easy CD Creator.

b. Click the small arrow next to the New button on the 
toolbar and then select Audio CD from the drop-down 
list.

c. Insert the music CD that contains the music track you 
want to extract into your CD-ROM, DVD-ROM, or CD-
RW drive (the source drive).

d. In the left pane of the Explorer section, select the CD-
ROM, DVD-ROM, or CD-RW drive containing the 
music CD, and a list of the tracks on the CD appears to 
the right.

e. In the right pane of the Explorer section, select the track 
you want to extract.

2. Click the Extract button on the toolbar. The Extract Audio 
Track(s) to File(s) dialog box appears.

3. Select a location for the file in the Save in drop-down list 
box.

4. Type a file name for the extracted file in the File name text 
box.

5. In the Save as type drop-down list box, select the appropriate 
file type or extension.

6. In the Format drop-down list box, select the audio format 
you want for the extracted file and click Save.
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Creating an 
Audio CD 
(continued)

A composite track is a 
single track that is made up 
of two or more separate 
tracks. Composite tracks 
are useful when you want 
to make a single track from 
several different tracks.
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Merging (Composite) Tracks

To make a composite track:

1. Select two or more tracks you want to merge into a single 
track.

2. From the Tracks menu, select Merge Tracks. The tracks 
appear as a single track in the Audio CD Layout.
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Creating a 
Data CD
Use Easy CD Creator to 
create a Data CD to store 
computer data such as the 
files and folders on your 
hard drive. This is 
especially useful for 
backing up your important 
files or for sharing them 
with your colleagues. 
Unlike an Audio CD, a 
Data CD is used for data 
storage only and cannot be 
played on your home or car 
stereo CD player.

Here are some of the things 
you should know about a 
Data CD:

➜ A Data CD is used for 
data storage only and 
cannot be played on your 
home stereo CD player 
or car CD player.

➜ A Data CD is ideal for 
sharing multimedia 
presentations, graphics, 
Word or Excel 
documents, Internet 
downloads, web sites, 
and company documents 
with your colleagues.

See the “Troubleshooting” 
section in this chapter for 
hints on how to avoid buffer 
underruns.

Tip
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Creating a Data CD

Suggestions for Creating Data CDs
➜ Duplicating CDs: Easy CD Creator includes CD Copier, an 

easy way to make backup copies of your original CDs.

➜ Creating Mixed-Mode CDs: A Mixed-Mode CD is a 
single-session CD that contains both computer data and 
audio tracks and typically is used for entertainment and 
educational programs.

➜ Creating CD Extra CDs: A CD Extra CD is a multi-session 
CD that contains both audio tracks and computer data. It is 
typically used when you want to provide music CD tracks 
and a music video on the same CD.

Creating a Data CD
1. Click the Data button on the Main menu. 

2. Select Data CD from the next menu. A Data CD Layout is 
displayed.

3. Insert a blank CD-R/CD-RW disc into your CD-RW drive 
(the destination drive).

4. In the Explorer section, select the data file or folder you want 
to record, then click Add. Repeat until the Data CD Layout 
contains all of the files and folders that you want to record.

5. Click Create CD. The CD Creation Setup box is displayed.

6. Click OK to start recording.
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Creating A 
Data CD 
(continued)

A multi-session CD is a 
Data CD to which data is 
added incrementally in 
more than one session, 
allowing you to 
periodically add and update 
files and folders to your 
CD.
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Creating Multi-Session CDs
1. To record the first session, follow the instructions in 

“Creating a Data CD.” In the CD Creation Setup dialog box 
on the Advanced tab, make sure Close Session and Leave 
CD Open is selected as the Write Method option (the default 
option for Data CDs).

2. When you are ready to add another session to the CD, insert 
the CD into your CD-RW drive and follow the instructions 
again in “Creating a Data CD.”
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What is CD 
Image? 
Creating a CD from a CD 
image is typically done 
when you want to write 
your data to the hard drive 
first, then record it to CD to 
avoid a buffer underrun; or 
when you want to write a 
CD image to the hard drive 
once, then record it several 
times to different CDs to 
save processing time.

When making a CD image, 
make sure you have enough 
space on your hard drive to 
store the image file. 

You can also create a CD 
image within the audio 
application. (See Online Help 
for steps to create an audio 
CD from a CD image).

Tip

Tip
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What is CD Image?

Creating a Data CD from an Image
1. Click the Data button on the Main menu. 

2. Select Data CD from the next menu. A Data CD Layout is 
displayed.

3. In the Explorer section, select the data file or folder you want 
to record, then click Add. Repeat until the Data CD Layout 
contains all of the files and folders that you want to record.

4. From the File menu, select Create CD Image.

5. Type a filename, and select a location for the file.

6. In the Save as type box, select CD Image Files (*.cif).

7. Click Save.

To Create a CD from the CD Image

1. From the File menu, select Create CD from CD Image.

2. Insert a blank CD-R/CD-RW disc into your CD-RW drive 
(the destination drive).

3. Select the image file (*.cif file) you want to make into a CD 
and click Open. The CD Creation Setup dialog box is 
displayed.

4. If necessary, change the CD Creation Setup settings and click 
OK.
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Modifying a 
Data CD Layout
You can create a new folder 
in your Data CD Layout 
and then add files and 
folders to that new folder.

You can remove files and 
folders (including 
everything within the 
folder) at any time before 
you create the CD. 
Removing a file or folder 
from your CD Layout does 
not affect the original items 
on your hard drive.

You can create a CD 
Layout, save it, then use it 
to record a CD later. When 
saving a CD Layout, you 
are saving a file that 
contains only the 
instructions that specify 
which files to include in the 
layout.
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Modifying a Data CD Layout

Changing the Order of Files and Folders
Once you have added files and folders to your CD Layout, you 
can change the order of the files at any time before you create 
the CD. For example, you can move a folder that is displayed at 
the end of the Data CD Layout to the top of the list.
Note: Changing the order of files and folders in your CD Layout affects only 
their physical position on the CD. Moving files and folders in the CD Layout 
does not change their original location on your computer.

To change the order of the files and folders:

1. Select the file or folder in the Data CD Layout.

2. Drag it to the position where it is to be displayed in the Data 
CD Layout.

Removing Files and Folders
1. Select the file or folder from your CD Layout.

2. Click the Remove button on the toolbar.

Renaming a File or Folder
1. Select the file or folder in the Data CD Layout.

2. From the Edit menu, select Rename.

3. Type in the new name.

Saving a CD Layout
1. From the File menu, select Save As.

2. Type a filename, and select a location for the file.

3. Click Save.

Opening a CD Layout
1. From the File menu, select Open CD Layout.

2. Select the CD Layout (.cl4) you want to open.

3. Click Open.
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What is DirectCD?

Creating a DirectCD CD
Before creating a DirectCD CD, you must verify that the 
DirectCD component is installed. Please refer back to the 
“Installing Adaptec Easy CD Creator” section in this chapter. 
DirectCD is software that makes it much easier to record data to 
CD-R or CD-RW than in the past. DirectCD allows your CD-
RW drive to appear just like any other drive letter in Windows 
Explorer. In other words, your CD-RW drive handles files just 
like a hard drive or floppy disk. Using Windows Explorer, you 
can drag and drop, rename, add or delete files and directories 
directly to your CD-R or CD-RW disc. You can use the Save or 
Save As command in your spreadsheet, Word document, or any 
other application to save files directly to a CD-R or CD-RW 
disc.

Note: Before you can write data to your CD-R or CD-RW, you must first 
format the CD-R or CD-RW disc. If the DirectCD CD Ready window is 
displayed, the disc is already formatted for DirectCD.

1. Insert a blank CD-R or CD-RW disc into the CD-RW drive.

2. From the Main menu, select Data.

3. From the next menu, select DirectCD.

4. The DirectCD Wizard is displayed and guides you 
step-by-step through how to prepare the CD-R or CD-RW 
disc so you can write data to it.

Formatting a CD/CD-RW
Before you write data to a CD-R or CD-RW, you must format 
the disc:

1. Start DirectCD, as described above. The DirectCD Wizard 
screen is displayed.

2. Click Next, and the Drive Information window is displayed.

3. Click Next, and the Format Disc window is displayed.

4. Click Next to continue, and the Name Your Disc window is 
displayed.

 
 

 
 

.

.

 

What is 
DirectCD?
DirectCD is designed to 
complement, not replace, 
pre-mastering software.

DirectCD is useful if you 
want to incrementally add 
small (or large) amounts of
data to your disc. DirectCD
is also convenient to use. 
You can save files directly 
to your CD-R/CD-RW disc
from Windows Explorer or
directly from your 
spreadsheet, word 
processor, or other 
application using the Save 
or Save As function. For 
example, you might want 
to:

➜ Archive data and then 
remove it from your 
hard drive.

➜ Back up the files on 
your hard drive to a CD

➜ Transfer files from a 
computer at work to a 
computer used at home

You can do other tasks on your
computer while the CD is 
being formatted. The 
DirectCD CD Ready window 
is displayed when CD 
formatting is complete.

Tip
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5. Type a name to identify your CD in the Name Your Disc 
window.

Note: The CD name can be up to 11 characters.

6. Click Finish and your disc begins formatting.

7. Click OK, and the DirectCD disc is ready for you to write 
data to it.

8. If you are formatting a CD-RW disc that has been formatted 
before, you can select either Quick format or Full format.

Note: If your computer system has more than one CD-RW drive, the 
drive information window is displayed. Select the drive you want to 
format and click Next. This window displays information about your 
CD-R drive:

• The Device section of the window lists the model number of your drive and 
indicates if it is locked or unlocked.

• Click the Properties button to view more detailed information about the 
drive.

• The Media Type section of the window lists information about the type of 
CD in the drive and how you can use it.

Note: DirectCD uses two new technologies called packet writing and UDF. 
DirectCD gives you the ability to add data incrementally to a disc in small or 
large quantities. Data is written to a disc in small packets. It is possible to 
record even a single file at a time. There is no arbitrary limit to the number 
of packets that can be written to a CD-R/CD-RW disc.

UDF (Universal Disk Format) is a new file system that is used on optical 
media (such as CD-ROM and DVD) and other media. UDF has several 
advantages over the ISO 9660 file system used by standard CD-ROMs. UDF 
is designed to take advantage of packet writing and is accepted and 
approved as the industry standard by all major players in compact disc 
storage.

 

 

 

 

What is 
DirectCD? 
(continued)

By formatting a disc within 
DirectCD, you can read and 
write files directly to your
CD-R/CD-RW disc while 
within any software 
application that can read from
and copy to a drive letter.

Some examples include:

➜ Software applications 
such as Microsoft Word, 
when you use the Save or
Save As commands.

➜ Windows Explorer, when 
you drag and drop files 
from one drive letter to 
another.

DirectCD provides a file 
system based on UDF v1.5 
and writes data to a CD-R or
CD-RW using packet writing 
technology. This file system 
gives you drive letter access to
your CD-RW drive.

Tip

Did you know ...
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To Add Data to a DirectCD CD

Once your CD-R/CD-RW disc is formatted as a DirectCD disc, 
there are a number of ways to add data to it:

➜ In Windows Explorer, drag and drop files or folders onto the 
drive letter that is the CD-RW drive.

➜ Select Save As from the Windows application’s File menu 
and select the drive letter of your CD-RW drive.

To Eject a DirectCD CD

1. Press the Eject button on the CD-RW drive, or right-click on 
the CD-RW drive in the Windows taskbar and select Eject. 
The Eject window is displayed. (The Window will vary 
based on media type.)

2. Read the text that is displayed in the window and select the 
option you want.

3. Click Finish or OK to eject the CD from the drive, and 
DirectCD ejects your CD from the drive.

Note: If you want to be able to read the DirectCD CD on a standard 
CD-ROM drive, see the “Ejecting a DirectCD CD to Read on Another 
Computer” section.

To Add More Data to the CD

1. Insert the DirectCD CD into your CD-RW drive.

2. Wait for the DirectCD CD Ready window to be displayed.

3. Click OK and continue writing more data to your CD.

 
 
 
 

 

 

 

What is 
DirectCD? 
(continued)

If you previously formatted
a CD-R or CD-RW disc for
DirectCD use, you can add
more data to it until the disc
is full.

When you instruct DirectCD 
to eject a CD from your CD-
RW drive, DirectCD gives you
various formatting options, 
depending on the type of disc 
in the drive and how you want
to use the disc.

When you eject a CD-R 
DirectCD disc from the drive 
and you want to read it on 
another computer that has a 
standard CD-ROM or DVD-
ROM drive, you must close or
finalize the CD-R before 
ejecting.

Did you know ...

Did you know ...
CREATING YOUR OWN CDS   4-19



4-20 CREATING YOUR OWN CDS
To Erase the Contents of a DirectCD
1. In Windows Explorer, select the files you want to erase.

2. From the File menu, select Delete or press the Delete key.

3. Click Yes to confirm that you want to erase the files from the 
CD. DirectCD erases the selected files from the CD-R/CD-
RW.

Note: Deleting files from a CD-R disc makes the files invisible to the file 
system but does not free up any space on the CD-R.

Advanced Options within DirectCD
Ejecting a DirectCD CD to Read on Another Computer
To close the session on the CD-R or CD-RW disc:

1. Right-click the CD icon on the Windows taskbar.

2. Select Properties from the drop-down list box.

3. Click the DirectCD Wizard tab.

4. Select the Enable standard CD-ROM Compatibility Eject 
option and click OK.

5. Right-click the CD icon on the Windows taskbar.

6. Select the appropriate option from the drop-down list box:

• Eject, if the Eject Wizard is turned ON. 

• Finalize, if the Eject Wizard is turned OFF.

7. Select Organize the CD so that it can be read in most 
standard CD-ROM drives…, and click Finish.

Ejecting a CD with Eject Wizard Turned Off
1. Right-click the CD icon on the Windows taskbar.

2. Select one of the following from the drop-down list box:

• Eject: to keep the CD in the DirectCD format and 
continue reading and writing files directly to the CD.

• Finalize: to close the CD to ISO 9660 format so you can 
read the CD on a standard CD-ROM or DVD-ROM 
drive (applies to CD-Rs only).
What is 
DirectCD? 
(continued)
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Adding Data to a Closed DirectCD CD-R Disc

1. Insert your CD-R (that was previously closed/finalized to 
read on a standard CD-ROM or DVD-ROM drive) in your 
CD-RW drive.

2. Start DirectCD.

3. Click the Next button two times. The Make CD Writable 
window is displayed.

4. Click Next.

5. Type the name you want to call your CD-R in the Name Your 
CD window, using up to 11 characters.

6. Click Finish and wait until the DirectCD Ready window is 
displayed.

You can now add more files to the CD-R using Windows 
Explorer or any Windows application.
What is 
DirectCD? 
(continued)

If you are using CD-R media 
and you closed a DirectCD 
disc, you can still add more 
data to the disc.

Tip
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What is CD Copier?

CD Copier
Use CD Copier to make backup copies of almost any type of 
CD. The following table lists the types of CDs that can be 
copied and some notes about making backup copies:

Type of CD Notes

Data Some commercial CDs are designed to prevent copying, 
and efforts to do so will fail. Only single session Data CDs 
can be copied in Disc-at-Once mode.

Audio The source drive (CD-ROM, DVD-ROM, or CD-RW), must 
be capable of reading audio digitally. Not all drives support 
digital audio extraction. See Testing Your System 
Configuration. Easy CD Creator tests your drive to 
determine its capabilities when the source CD is inserted. 
If your CD-RW drive supports Disc-at-Once mode, you can 
copy Audio CDs in Disc-at-Once mode.

DirectCD 
CDs

Some CD-ROM drives may not be able to read a DirectCD 
disc. If you have a CD-ROM drive that is MultiRead 
capable, there should be no problem.

Mixed-
Mode

Mixed results. Some CDs copy perfectly; others do not, 
possibly because the CD is formatted to circumvent 
copying or because some CDs are not made properly.

CD Extra Copy CD Extra CDs in Disc-at-Once mode; otherwise, 
some audio may be lost if there is less than a two-second 
gap between tracks on the source CD.

Photo CD Requires a source CD-ROM drive capable of reading CD-
ROM XA. Most current CD-ROM drives support this.

Video CD Requires a source CD-ROM drive capable of reading CD-
ROM XA. Most current drives support this.

. 

 

What is CD 
Copier?
CD Copier allows you to 
make an exact copy of an 
existing Audio or Data CD
The most common use for 
CD copier is to create a 
working copy of a CD and 
to archive the original in a 
safe place.

For helpful pointers when 
creating a backup copy of a 
CD, see the “CD Copier Tips”
section in this chapter.

See the “Troubleshooting” 
section in this chapter for 
hints on how to avoid buffer 
underruns.

Tip

Tip
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CD Copier Tips

The following sections provide useful information related to 
making backup copies of CDs using CD Copier.

Source CD-ROM Drives for CD-to-CD Copying

To copy directly from a source CD to a blank CD in your 
CD-RW drive, you must have a CD-ROM or DVD-ROM drive 
to use as your source. This is called write on-the-fly. See the 
drive’s guide for information.

When you insert a CD into your source drive and select the 
drive in the Source and Destination tab, Easy CD Creator 
automatically tests both the drive and the CD. The tests 
determine whether the selected drives can read and record 
successfully. If not, an error message is displayed.

Using the CD-RW Drive for CD-to-CD Copying

If you are using only your CD-RW drive to copy a CD and you 
have enough space on your hard drive, you can use the CD-RW 
disk as both the source and destination drive.

When you make a disc copy, CD Copier copies the CD as a 
temporary image file onto your hard drive, then records it to a 
blank CD.

Copying Audio and Mixed-Mode

Although most CD-ROM drives can play back music from an 
audio CD, not all are capable of reading and copying audio tracks 
in digital format. If you are not sure whether your drive supports 
digital audio extraction, see “Testing Your System 
Configuration.”

Making Multiple Copies

You can make multiple copies of a CD more quickly with CD 
Copier’s disc copy option if:

➜ Space is a available on your hard drive.

➜ Your source CD-ROM or DVD-ROM drive is slow.

➜ Your CD-RW drive serves as both your source and 
destination drive.
What is CD 
Copier? 
(continued)
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To Start CD Copier:

Note: System test runs automatically the first time you use the CD 
Copier application.

1. From the main menu, select CD Copier. The CD Copier 
Source and Destination window is displayed.

2. Insert the original CD from which you want to make copies 
into your CD-ROM, DVD-ROM, or CD-RW drive.

3. On the Source and Destination tab, select the appropriate 
drive from the drop-down list box. The source drive contains 
the CD from which you want to record. The destination drive 
is the one to which you want to record.

Note: If you are copying directly from a CD-ROM or DVD-ROM drive, see 
“Source CD-ROM drives for CD-to-CD Copying” in this chapter.

4. Select the destination drive that has the blank CD-R/CD-RW 
in the Record To drop-down list box. This is your CD-RW 
drive.

5. Make changes, if any, in CD Copier Advanced tab settings.

6. Click Copy to begin recording a copy of your CD.

To Make a Copy from Your Hard Drive: (use if making 
multiple copies)

1. Insert the original CD from which you want to make copies 
into your CD-ROM, DVD-ROM, or CD-RW drive.

2. Select the drive containing the original CD in the Copy from 
drop-down list box.

 

What is CD 
Copier? 
(continued)

CD Copier copies the files 
and folders from your 
source CD to a blank CD. A
final message box notifies 
you when the copying is 
complete.
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3. Click the Advanced tab and choose one of the following: 

• Target Devices: Allows you to select the CD-RW
you want to use for recording CDs. If more than one 
CD-RW is connected to your system, select the
CD-RW you want to use from the drop-down list box. 

• Write Speed: Selects the speed of the drive for 
recording CDs. Change this setting if you want to create 
the CD at a different speed. 

• Number of Copies: Type or select the number of copies 
you want to make from the CD layout you are about to 
record.

4. Under Disc Copy, select Copy source CD to the hard disk 
first.

5. Select a different location on your hard drive if you do not 
want to record the image file to your Windows Temp 
directory.

6. Click Copy.

CD Copier temporarily records the CD to your hard drive as an 
image file, then records it to the blank CD. CD Copier then 
automatically removes the image file after the CD is copied.
What is CD 
Copier? 
(continued)
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Advanced Tab Settings within CD Copier

Setting Description

Current CD-RW 
Speed

Select the speed at which you want to create the 
backup copy of the CD. For greater certainty, record 
at 1X.

Number of 
Copies

Select the number of copies you want to make.

Test Select this option to perform a test in which the files 
to be recorded are passed to the CD-RW drive. No 
information is recorded to the CD. Use this option if 
you want to make sure your system can keep up with 
the transfer rate.

Test & Copy Select this option to perform a test in which the files 
to be recorded are passed to the CD-RW drive. 
Recording begins after a successful test.

Copy By default, CD Copier uses this option to begin 
recording immediately after you click Copy and does 
not perform the test. Use this option if you have 
successfully recorded a number of similar CDs and 
you have not made any changes to your CD-RW 
setup.

Disc-at-Once By default, CD Copier uses this option to record the 
CD in a single operation and close the CD. If you are 
recording Audio CDs, the Disc-at-Once option 
maintains the pause between tracks as on the source 
CD.

Disc Copy Select this option to copy the source CD to your hard 
drive first to speed up the recording process if you 
are making more than one copy of a CD. Once the 
source has been copied to your hard drive, CD copier 
records the disc copy to the CD.

Set as Default Maintains your Advanced tab settings and uses 
them as the default.

Select Location To make a disc copy, type in a different location for 
storing the image file if you do not want to use the 
Temp directory.
What is CD 
Copier? 
(continued)

If you would like to make 
multiple copies of a CD, 
change the number of 
copies on the Advanced 
tab before the copying 
process begins.
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What is a Mixed-Mode CD?      

Creating CDs Containing Audio and Data
There are many reasons to combine data and audio on a CD. 
These include the ability to:

➜ Make an Audio CD and add text files of the song’s lyrics

➜ Use a CD to store data and later add songs to the same CD

➜ Make a multimedia CD (see “Multimedia CDs”)

Creating Mixed-Mode CDs

When you create a Mixed-Mode CD, the CD Layout contains 
both a data and an audio section. First add files and folders to 
the Data CD Layout section; then add the tracks, WAV, or MP3 
files to the Audio CD Layout section.

To create a Mixed-Mode CD:

1. Open Easy CD Creator from the Start menu. Click Start, 
point to Programs, point to Adaptec Easy CD Creator, 
point to Features, and then select Easy CD Creator.

2. Click the small arrow next to the New button on the toolbar 
and then select Mixed-Mode CD.

3. Add the data files you want to record to the Data CD Layout 
section of the Mixed-Mode Layout window.

a. Click Data Layout in the left pane of the Mixed-Mode 
CD Layout.

b. In the Explorer section, select the data file or folder you 
want to record and then click Add. 

c. Repeat until the Data CD Layout contains all of the files 
and folders that you want to record.

�Caution:  Home and car CD players may attempt to play back the 
data track of a Mixed-Mode CD with disastrous results–the data is 
played as a very loud and grating noise that can damage speakers. 
Some CD players detect a data track and either skip or mute it, but 
some do not.

 

 

 

 
 

What is a 
Mixed-Mode 
CD?
A Mixed-Mode CD is a 
single-session CD that 
contains both computer 
data and audio track; it 
typically is used for 
entertainment and 
educational programs. Data
is written to the first track 
on the CD followed by one
or more audio tracks. 
Mixed-Mode CDs are used
with CD-ROM, DVD-
ROM, or CD-RW drives 
only and cannot be played 
in home or car stereo CD 
players.

You can combine both 
audio and data on a single 
CD using Mixed-Mode or 
CD Extra. The difference 
between the two methods is
the order in which data and
audio are recorded.
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4. Add the audio files you want to record to the Audio CD 
Layout section of the Mixed-Mode Layout window.

a. Click Audio Layout in the left pane of the Mixed-Mode 
CD Layout.

b. If you are recording audio tracks from an existing music 
CD, insert the music CD into your CD-ROM, DVD-
ROM, or CD-RW drive (the source drive). If you are 
recording WAV or MP3 files, continue with the next step.

c. In the left pane of the Explorer section, select the
CD-ROM, DVD-ROM, or CD-RW drive containing the 
music CD; a list of the tracks on the CD is displayed to 
the right. 

d. In the right pane of the Explorer section select the track, 
WAV, or MP3 file from which you want to record, and 
then click Add. Repeat until the Audio CD Layout 
contains all of the tracks and files you want to record. 
During the actual recording process, Easy CD Creator 
prompts you to reinsert the appropriate music CD for the 
music track being recorded.

5. Insert a blank CD-R/CD-RW disc into your CD-RW drive 
(the destination drive).

6. Click Create CD. The CD Creation Setup box is displayed.

7. Click OK to start recording.
What is a 
Mixed-Mode 
CD? (continued)
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What is CD Extra?

Creating a CD Extra CD
1. Open Easy CD Creator from the Start menu. Click Start, 

point to Programs, point to Adaptec Easy CD Creator, 
point to Features, and then select Easy CD Creator.

2. Click the small arrow next to the New button on the toolbar 
and select CD Extra from the drop-down list. A CD Extra 
CD layout is displayed.

3. Add the audio files you want to record to the audio section of 
the CD Extra Layout.

a. Select the Audio CD Layout icon in the left pane of the 
CD, and insert a blank CD-R/CD-RW disc into your CD-
RW drive (the destination drive).

b. If you are recording tracks from an existing music CD, 
insert the music CD into your CD-ROM, DVD-ROM, or 
CD-RW drive (the source drive). If you are recording 
WAV or MP3 files, continue with the next step.

c. In the left pane of the Explorer section, select the CD-
ROM, DVD-ROM, or CD-RW drive containing the 
music CD; a list of the tracks on the CD is displayed to 
the right.

Note: If the information about the music CD is found locally on your 
hard drive, the CD title, artist name, and the name of each track are 
displayed. If this information is not displayed, you must connect to 
the Internet, and then click the Internet button on the toolbar to 
download the information from the online CDDB™ Disc Recognition 
Service.

d. In the right pane of the Explorer section, select the track, 
WAV, or MP3 file that you want to record, and then click 
Add. Repeat until the Audio CD Layout contains all of 
the tracks and files that you want to record.

 

 
 

 
 

 
 

 

What is CD 
Extra?
A CD Extra CD is a multi-
session CD that contains 
both audio files (tracks, 
WAV, or MP3) and 
computer data. The first 
session contains the audio 
files, so a home or car 
stereo CD player can play 
them. The second session 
contains data intended for 
your computer’s CD-ROM
drive. Many music CDs are
created as a CD Extra CD 
to provide music CD tracks
and a music video all on the
same CD.

When you create a CD 
Extra CD, the CD Layout 
contains both an Audio and
a Data section. First add the
tracks, WAV, or MP3 files 
to the Audio CD Layout; 
then add files and folders to
the Data CD Layout.
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Note: If you have tracks on other music CDs that you want to record, 
repeat steps 4b-4d for each music CD from which you want to record. 
During the actual recording process, Easy CD Creator prompts you to 
reinsert the appropriate music CD for the music track being recorded.

4. Add the data files you want to record to the data section of 
the CD Extra Layout.

a. After adding all the audio files that you want to record 
into the Audio CD Layout, click the Data CD Layout 
icon in the left pane of the CD Extra Layout window. 
The icon is labeled with the date (year:month:day).

b. In the Explorer section, select the data files or folders 
you want to record, and then click Add. Repeat until the 
Data CD Layout contains all of the files and folders that 
you want to record.

5. Insert a blank CD-R/CD-RW disc into your CD-RW drive 
(the destination drive).

6. Click Create CD. The CD Creation Setup box will be 
displayed.

7. Click OK to start recording.

Mixed-Mode and CD Extra Writing Tips
When combining data and audio on a single CD, determine 
which method to use by considering the system (for example, 
home/car CD players or a personal computer) on which the CD 
will be played. 

When to Use Mixed-Mode

Mixed-Mode CDs can be read back on any standard CD-ROM 
drive, including older CD-ROM drives that cannot read multi-
session CDs. Because the audio and data are both recorded in a 
single session, you do not need a multi-session CD-ROM drive.
What is CD 
Extra? 
(continued)
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When to Use CD Extra
Unlike Mixed-Mode, a CD Extra disc contains two sessions in 
which the first session contains audio and the second data. 
Home or car CD players play the tracks in the first session (the 
audio) but will never read beyond the first session, so the data 
track is never played.

The table below describes the differences between the two 
Methods.

Multimedia CDs
One reason for combining data and audio is to create 
multimedia CDs. Multimedia means the combination of text, 
graphics, and sound in an interactive application. Typical uses 
for multimedia CDs include:

➜ Informational: Such as multimedia presentations or 
product brochures

➜ Educational: Such as interactive software learning 
applications

➜ Entertainment: Such as computer software games

One feature of combining audio and data is that you can create 
an application to run on a computer using a standard CD-ROM 
or DVD-ROM drive, and to ensure that everyone can hear the 
audio, record it to CD in the standard CD-DA format (the same 
one used for Audio CDs).

Method Data Audio
Number of 
Sessions

Limitations

Mixed-
Mode

First 
track; 
CD-ROM 
or CD-
ROM XA 
format

Second and 
subsequent 
tracks

One Not recommended 
for home or car CD 
players

CD 
Extra

Second 
session; 
CD-ROM 
XA 
format

One or more 
tracks in the 
first session

Two 
(multi- 
session)

Multi-session 
CD-ROM drive 
required to read 
the data track
What is CD 
Extra? 
(continued)
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What is Jewel Case Creator?

Jewel Case Creator
Use Jewel Case Creator to make custom jewel case inserts and 
CD labels to indicate the title and contents of your CD.

Adding Text

The following sections describe how to add various types of 
text, including text for CD titles, artist names, and track titles as 
well as curved text and straight text, and text specific to Data 
CDs.

Note: To add a second line to a text box, resize the text box to accommodate 
a second line. Place your cursor at the end of the first line, then press 
Ctrl+Enter. 

Adding the Contents of an Existing CD

Using the Add CD Contents feature is the easiest and fastest 
way to enter text into Jewel Case Creator. For example, when 
you add the contents of an existing Audio CD and have an audio 
theme selected, information about the CD, such as title, artist, 
and tracks, is displayed in the appropriate text boxes. 

To get the contents of an existing CD:

1. Insert the existing CD into your CD-ROM, DVD-ROM, or 
CD-RW drive.

2. From the Add menu, select CD Contents.

Jewel Case Creator adds the information from the CD into the 
appropriate text boxes (such as Title, Artist, and Tracks). For 
Audio CDs, if the information cannot be found locally, Jewel 
Case Creator uses the Internet to download the information 
from the CDDB Disc Recognition Service.

 
 

 

What is Jewel 
Case Creator?

Labels and jewel cases must 
be purchased separately.

Jewel Case Creator comes 
with a variety of themes 
that include different 
graphics and text layouts 
for Audio and Data CDs. 

Give your insert and label a
custom look by adding your
own graphics, changing 
backgrounds, and by 
changing the layout and 
style of the text.

For descriptions on the 
various preference settings, 
see the “Jewel Case Creator”
section in the Online Help.

Tip

See also ...
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Adding the CD Title 

When either an Audio or Data CD theme is selected, Jewel Case 
Creator automatically includes a text box for a CD title.

1. Select the Front Cover or CD Label page view (to make sure 
that the Title text box is visible).

2. Double-click the Title text box to edit its contents.

3. Type the title of the CD and press Enter.

Adding the Artist’s Name

1. Select the Front Cover or CD Label view (to make sure that 
the Artist text box is visible).

2. Double-click the Artist text box to edit its contents.

3. Type the name of the CD artist and press Enter.

Adding Track Titles

1. From the Add menu, select Track. The Insert new track 
dialog box is displayed.

2. Type the following information:

• Track Number: (optional) if you wish, you can change 
the order in which the track is displayed in the list; 
otherwise, Jewel Case Creator numbers the tracks in the 
order in which you add them

• Track Name: the name of the track

• Track Time: (optional) the duration of the track. If you 
do not want to list the track times, click Preferences and 
clear Show Track Time

3. Click Add Track.

4. When you finish adding all the tracks, click Done.

 
 

 

 

 

What is Jewel 
Case Creator? 
(continued)

If you are using a theme that 
does not have a Title text box,
refer to the Online Help to find
out how to add straight text.

The new CD artist name is 
displayed on the front cover, 
the spines along the back 
cover, and on the CD label. 
Changes made on any one of 
these pages are also made on
the other pages.

The list of tracks you added is
displayed on the Inside and 
Back Cover page views.

You can add new text boxes
and place them anywhere 
you want in the cover and 
CD label views.

Tip

Did you know ...

Tip
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Adding Text for Data CDs

A typical theme for Data CDs includes text boxes for the 
following:

➜ Contents: A description of the contents of the CD. Usually 
displayed on the front cover.

➜ Title: The title of the CD. Usually displayed on the front 
cover.

➜ Volume ID: The Volume ID can include the name of the CD 
and/or the name for the volume set. When you make a cover 
or insert, the Volume ID contains the date and time the CD 
was created. Usually displayed along the back cover spines 
and CD label pages.

➜ Date: The date the CD was created. Usually displayed along 
the back cover spines and CD label pages.

Adding Information for Data CDs

1. Select the page view that contains the text box you want to 
edit.

2. Double-click the text box to edit its contents.

3. Type the text you want to add and press Enter.

4. To add additional information, such as file names, author, 
copyright, and so on, see Adding Text. 

 
 
 
 

 

 

 

What is Jewel 
Case Creator? 
(continued)

You can also assign the text by
a category, such as author, by
changing text categories. See
the Jewel Case Creator Online
Help.

You can add your own 
graphics to give your 
inserts and labels a custom
look. Jewel Case Creator 
supports .bmp, .jpg, or .jpeg
graphic files.

If you want to add a graphic 
that is displayed as the 
background of your cover and
CD label, see “Customizing 
Backgrounds” in the Online 
Help file.

See also ...

Tip
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Printing Covers and CD Labels

Using Standard Cover and Label Stock

For best results, you can use standard cover and label stock to 
print your covers and labels. Standard cover and label stock is 
available at many office supply and computer retail stores.

Jewel Case Creator has already measured and determined the 
print positions for a variety of cover and label stocks so that 
your covers and labels are correctly aligned on the particular 
stock. The predefined paper stocks are listed in the Page setup 
dialog box in the Current paper type drop-down list box.

If the stock you are using is not displayed in the paper type lists, 
you can determine the correct position by aligning the printed 
text with forms.

Aligning the Printed Text with Forms

For best results, you can make a photocopy of a preformatted 
cover or label stock, then print the desired page onto the 
photocopy to check the alignment. To modify the alignment, 
there are two options you can use: 

➜ Set Printed Location: to modify where the cover or label is 
printed on the page. This adjustment is on a cover/label 
basis and is useful for setting up the print locations for new 
cover or label stock that is not displayed in the Current 
Paper Type drop-down list box in the Page Setup dialog box. 

➜ Printer Adjustment: to shift the paper placement for a 
particular printer and correct for slight variances among 
printers. This adjustment is on a per-printer basis and is 
useful for cover or label stock that is displayed in the 
Current Paper Type drop-down list box but the alignment is 
slightly off. 

Repeat and adjust accordingly until the proper alignment is 
achieved before printing onto actual cover or label stock.

 

 

 

 
 

 

What is Jewel 
Case Creator? 
(continued)

The following topics 
describe the types of paper
to use, aligning the text 
with forms, selecting paper
types, and printing covers 
and labels.

Jewel Case Creator 
includes a list of paper 
types in which the 
positioning of the cover and
label pages is already 
determined for the selected
cover and label stock paper
types.

For best results, Adaptec 
recommends that you use a
CD label applicator to 
apply labels to CDs and 
follow the manufacturer’s 
instructions (CD label 
applicator and labels are 
sold separately).
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Selecting the Paper Type
1. From the File menu, select Page Setup.

2. Click the cover or CD label you want to print: Front/Inside 
Cover, Back Cover (U-Card), or CD Label.

3. From the Current paper type drop-down list box, select the 
paper you want to use. Jewel Case Creator lists the currently 
supported cover and label stocks. If the third-party cover or 
label stock you want to use is not listed, select Generic (plain 
paper) and see Aligning the Printed Text with Forms.

4. Continue selecting the paper types for each cover and/or 
label you want to print.

5. Click OK.

Inserting Covers
To cut covers to the proper size for inserting into jewel cases:

1. In the Edit menu under Preferences, select Print cut and 
fold lines on the Print tab. When you print a cover, the fold 
lines and tick marks are displayed around the cover.

2. Fold the cover along the fold lines and tick marks.

 
 

 

What is Jewel 
Case Creator? 
(continued)

You must select a paper type 
the first time you print a cover
or label. You can also change
previously selected paper 
types.

If you have Print Outlines 
selected in Printing 
Preferences, then a solid line,
instead of a dotted line, is 
printed.

Did you know ...

Did you know ...
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Troubleshooting

Testing Your System Configuration
Easy CD Creator includes a variety of system tests that check 
different parts of your system for compatibility with Easy CD 
Creator. This helps ensure that your system is configured for 
optimal performance with Easy CD Creator and improves the 
likelihood of creating a CD successfully.

You should perform the system tests if any of the following 
conditions apply:

➜ Before making your first CD

➜ After making changes to any of the following:

• Location of your temporary files 

• Selected devices (such as using different CD-RW)

• Adding devices (such as hard drives, Zip drives,
CD-ROM or DVD-ROM)

• Configuration settings

Systems Test

To run the Systems Test:

1. From the Tools menu, select System Tests. The System Test 
window is displayed.

2. Select one or more of the following tests:

• Data Transfer Rate Test: Determines the average rate 
data is read from the drive

• Audio Extraction Test: Determines the average rate 
digital audio is extracted from the drive

• Recording Test: Determines the recording speeds 
supported by the system

3. Click Test to perform the test.

4. Follow any on-screen instructions that may be displayed.

 

 

 

Troubleshooting
Easy CD Creator comes 
with a variety of system 
tests that check different 
parts of your system for 
compatibility with Easy CD
Creator. This helps to 
ensure your system is 
configured for optimal 
performance with Easy CD
Creator and improves the 
likelihood of making a CD
successfully.
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Resolving Common Problems 

Preventing Buffer Underruns

Note: If a buffer underrun occurs during an actual write operation rather 
than during a test operation, the CD may be ruined.

➜ Try closing other programs (disable screen savers, virus 
software, and other tasks or applications running in the 
background).

➜ Defragment your hard drive.

➜ Make sure that the temporary files are created on a local 
hard drive. Do not assign the location of temporary files to a 
directory on a network drive. Set the location for the 
temporary files by selecting the Options command under the 
Tools menu.

➜ Record at a slower speed.

➜ Do not record across a network. Copy the desired files or 
folders to your local hard drive.

➜ Check the Auto Resync box under Drive Properties (for the 
source drive).

Note: The Easy CD Creator software automatically turns on a feature called 
Audio Resync. Audio Resync helps the drive resync the buffer so that the 
extraction is clean without audio dropouts. When Easy CD Creator tests the 
drive, there are two read audio commands used at different parts of the CD: 
the center, the middle, and the outer edge. If there is dropout or slow 
extraction, it automatically turns on Audio Resync. Audio Resync affects the 
performance of the drive by about 50-60 percent, causing the audio 
extraction speed with resync on to be slower but more reliable.

 

 

 

 

Troubleshooting
(continued)
The following sections 
describe common problems
you may encounter and 
suggestions for resolving 
them. If you need further 
assistance, see Adaptec 
Customer Support on the 
Internet.

A buffer underrun is a 
common error condition 
that occurs when the flow 
of data from the source 
device (for example hard 
drive, DVD-ROM or CD-
ROM drive) to the CD-RW
drive is interrupted long 
enough for the CD-RW 
drive’s buffer to be 
emptied. Once a buffer 
underrun occurs, the CD 
creation process is halted. 
To successfully create a 
CD, a continuous data 
stream must be maintained
at the selected recording 
speed.
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Problems Reading Recordable CDs

If you have successfully recorded a CD but have problems 
reading it, here are some suggestions:

➜ If the CD can be read on the CD-RW drive but not on a 
standard CD-ROM or DVD-ROM drive, check CD 
Information under the CD menu to make sure that the 
session containing the data you just wrote is closed. 
CD-ROM or DVD-ROM drives cannot read data from a 
session that is open; the session must be closed.

➜ If the CD can be read on your CD-RW drive, but when you 
insert the CD in a standard CD-ROM or DVD-ROM drive, 
the following occurs:

• The CD is ejected

• You receive error messages

• You have random problems accessing some files or 
directories

You may have a CD-ROM or DVD-ROM drive that is not 
well calibrated to read recordable CDs. Try reading the CD 
in a different CD-ROM or DVD-ROM drive.

➜ Try a different brand of CD-R or CD-RW media. 

Problems Reading Multi-Session CDs 

If you can see only data recorded in the first session on the CD 
but not in subsequent sessions, your CD-ROM or DVD-ROM 
drive might not support multi-session at all.

 
Troubleshooting
(continued)
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Finding Error Message Descriptions

For specific error message information:

1. From the Help menu, select Contents and Index. 

2. Click the Index tab.

3. Type in Error messages. A list of specific error messages is 
displayed in the Topics Found dialog box.

Using Online Help

You will find most of the information you need in the Easy CD 
Creator Online Help which contains step-by-step instructions, 
reference information, and a glossary of terms.

To access Easy CD Creator or the User’s Guide Online Help:

➜ From the Help menu, select Contents and Index.

Visit the Adaptec Web site for the latest answers to frequently 
asked questions.

 

 

Troubleshooting
(continued)
See the Online Help for a 
list of common error 
messages along with 
descriptions and 
suggestions for resolving 
them.

If you receive an error 
message, you can also click 
Help on the error message 
dialog box to view the specific
topic describing the error 
message.

Did you know ...
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Appendix

Easy CD Creator Reference

Easy CD Creator Toolbar

The following table describes the buttons found on the Easy CD 
Creator toolbar:

Button Purpose

Creates a new CD Layout.

Moves up one directory level in the Explorer view.

Records the CD Layout to a CD.

Finds a file or folder on your system.

Adds the selected items to the CD Layout.

Deletes the selected items from the CD Layout.

Displays the properties of a selected item.

Displays different views. When you click the arrow to 
the right of the Views button, you can select Large 
Icons, Small Icons, List, and Details from the drop-
down list.

Shows/hides the animated CD Guide.
Appendix
CREATING YOUR OWN CDS   4-41



4-42 CREATING YOUR OWN CDS
The following buttons are available for Audio CD Layouts:

Easy CD Creator Menus

File Menu

The following table lists the commands under the File menu.

Button Purpose

Plays the selected audio track in the Explorer view.

Extracts the selected audio track in the Explorer view to 
a WAV or MP3 file.

Accesses the CDDB™ Disc Recognition Service on the 
Internet for artist name, CD title, and music CD track 
information for the selected music CD.

Command Description

New CD 
Layout

Creates a new CD Layout.

Open CD 
Layout

Opens an existing CD Layout. When you save a CD 
Layout for the first time, the Save As dialog box is 
displayed so you can name the file.

Save Saves the current CD Layout. When you save a CD 
Layout for the first time, the Save As dialog box is 
displayed so you can name the file.

Save As Saves the current CD Layout with a different name or to 
a different location.

Validate 
Layout

Verifies that the contents of a CD Layout have not been 
moved, deleted, renamed, or modified since you added 
them to the CD Layout.

Properties Displays the various properties of a selected item.

CD Layout 
Properties

Displays the various properties of the current CD 
Layout.
Appendix 
(continued)
   MY PRESARIO—LEARNING MORE



MY PRESARIO—LEARNING MORE
Edit Menu

The following table lists the commands under the Edit menu.

Create CD Records the files, folders, and/or tracks in the CD 
Layout to a CD.

Create CD 
Image

Writes the CD Layout to a CD image file (*.cif).

Create CD 
from CD 
Image

Records a CD image file (*.cif) to a CD.

Recent File Opens the most recent CD Layout.

Exit Closes Easy CD Creator.

Command Description

New Folder Creates a new folder. Available in all CD Layouts except 
the Audio CD Layout.

Cut Removes the selected item and places it on the 
Clipboard.

Paste Inserts the contents of the Clipboard into the CD Layout.

Add Selected Adds the selected items to the CD Layout.

Rename Changes the name of a file, folder, or track from the CD 
Layout.

Select All Selects all of the items in the CD Layout.

Command Description
Appendix 
(continued)
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View Menu

The following table lists the commands under the View menu.

Command Description

Toolbar Shows or hides the Toolbar.

Text Labels on 
Toolbar

Shows or hides the Toolbar button text labels.

Status Bar Shows or hides the Status Bar. The Status Bar 
displays information about the CD Layout and is 
located on the bottom of the Easy CD Creator 
Window.

CD Info Bar Shows or hides the CD Information Bar. The CD 
Information Bar displays the amount of free space 
remaining on the CD and is located on the bottom 
of the Easy CD Creator window.

Show Windows 
Explorer

Shows or hides the Windows Explorer section of 
the Easy CD Creator window.

Show Explorer 
Bar

Shows or hides the bar that separates the left and 
right pane of the Explorer section.

Split Adjusts the panes of the Easy CD Creator window 
to Left-Right or Up-Down orientation.

Large Icons Displays large icons to represent the contents of 
the Explorer section.

Small Icons Displays small icons to represent the contents of 
the Explorer section.

List Displays the names of the files and folders listed in 
the Explorer section.

Details Displays the details of the files and folders listed in 
the Explorer section, including file size and the 
date last modified.

Arrange Icons Sorts the contents of the Explorer section in the 
order specified.

File Ordering 
(Data CD Layout 
only)

Displays the File Ordering window.

Refresh Updates the contents of the window.
Appendix 
(continued)
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CD Menu

The following table lists the commands under the CD menu.

Tools Menu

The following table lists the commands under the Tools menu.

Command Description

Eject Opens the CD-RW drive tray to eject the CD.

Erase CD Erases the contents of a CD-RW CD.
You must have a CD-RW CD in a CD ReWritable 
drive to erase the contents of a CD.

CD Information Displays information about the CD, including the 
type of CD, the number of sessions, and the 
number of tracks on the CD. Also, use this 
command to close a session or to close the CD 
(which write-protects the CD).

CD Copy Makes an exact copy of a CD. Insert the source CD 
in your CD-ROM drive and a blank CD in your 
CD-RW drive, then select this option.

Command Description

Find Locates files or folders on your system.

System Tests Opens the Systems Tests dialog box to test the 
recording properties of your CD-ROM, CD-RW 
drive, or hard drive.

CD Drive 
Properties

Displays the various properties of your CD-ROM or 
CD-RW drive.

Options Displays the various options for the CDDB™ Music 
Service Internet downloads and temporary files.
Appendix 
(continued)
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Track Menu

The following table lists the commands under the Track menu 
when the Audio CD Layout window is active.

Command Description

Play Plays the selected tracks in the Explorer section with 
the Easy CD Creator CD Player.

Preview Plays the selected tracks in the CD Layout with the 
Easy CD Creator CD Player. It allows you to hear a 
track as it will be recorded to your CD.

Extract to file Converts an audio track in Explorer to a WAV or MP3 
file.

Edit audio file Opens the Sound Editor so you can edit the selected 
WAV file.

Merge Tracks Records two or more tracks into a single (composite) 
track.

Split Tracks Splits a composite track (two or more tracks 
recorded as a single track) into separate tracks.

Edit Audio 
Effects

Applies special effects such as Audio Pause, Fade In, 
Fade Out, and Cross Fade to the selected track in the 
CD Layout.

CDDB Music 
Info

Downloads information (such as CD title, artist name, 
and track names) for the selected CD from the 
CDDB™ Music Service on the Internet.
Appendix 
(continued)
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Internet Menu

The following table lists the commands under the Internet 
menu.

Help Menu

The following table lists the commands under the Help menu.

Command Description

Web-CheckUp Opens the Web-CheckUp program.

Adaptec On the 
Web

Provides Internet links to various Adaptec Web 
sites.

Adaptec Online 
Offers

Provides information about CD-recordable 
technology and products.

Online 
Registration

Registers Easy CD Creator online.

Command Description

Contents and 
Index

Opens the Easy CD Creator Online Help.

Easy CD Creator 
Basics

Describes a few Easy CD Creator and CD-
Recordable technology terms and concepts to help 
simplify the CD creation process.

Show/Hide CD 
Guide

Shows or Hides the CD Guide assistant tool.

Product Support Provides links to various product support 
resources.

What’s New Describes the new features and enhancements 
available in this version of Easy CD Creator.

About Easy CD 
Creator

Opens the About dialog box for Easy CD Creator, 
which displays the application’s version number 
and copyright notice.

 

 

 

Appendix 
(continued)

The Status Bar at the bottom 
of the Easy CD Creator 
window displays context-
sensitive messages about the 
function of the selected 
command or Toolbar button.

The CD Info Bar at the bottom
of the Easy CD Creator 
window displays the free 
space available on the CD to 
record the items listed in the 
CD Layout. Data CD Layouts
are displayed in MBs, and 
Audio CD Layouts are 
displayed in minutes and 
seconds.

See the Online Help for more
information about the Status 
and Info bars.

Tip

Tip

See also ...
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In This Chapter

Saving 
Energy

Your new Compaq Internet PC has thre

➜ Sleep (Standby)

➜ Awake

➜ Off (Shut down)

This chapter shows you the differences
each of these power setting modes and
the benefits associated with each.
5

e power states: 

 in 
 

Sleep Mode,   5-2

Computer Shutdown,   5-3

Power Schemes,   5-4
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Sleep Mode
You can put your computer 
into Sleep mode whenever 
you want.

Sleep mode is a low-power 
standby state that reduces 
the amount of electrical 
power consumed by your 
computer while you are not 
actively using it. 

Once your computer enters 
Sleep mode, you must wake 
it again to use your 
software.

Your computer uses 
Microsoft Windows 
Power Management to put 
itself into Sleep mode 
automatically after it has 
been idle for a while. You 
can specify the amount of 
time before an idle 
computer enters Sleep 
mode.
5-2 SAVING ENERGY
Sleep Mode

Putting Your Computer to Sleep
1. Save all your work and exit all programs.

2. Press the Sleep E button on the keyboard.

3. Or, click the Start button on the Windows desktop, select 
Shut Down, then Standby, and then click OK. 

4. The amber Sleep LED above the numeric keypad lights up, 
indicating that the computer is in Sleep mode.

Waking Your Computer
Press the Sleep E button on the keyboard, press any key on the 
keyboard, or move the mouse. The amber Sleep LED stops 
glowing, indicating that the system is active.

Adjusting Your Computer Sleep Setting
1. From the Windows 

desktop, click the Start 
button, point to Settings, 
and then click Control 
Panel. The Control Panel 
window is displayed.

2. Double-click the Power 
Management : icon. 
The Power Management 
Properties window is 
displayed.

3. On the Power Schemes 
tab, click the drop-down 
arrow next to the System standby box 1, and select a time.

4. Click Apply 2, and then click OK 3.
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Computer 
Shutdown
In the event of a system 
lockup, or if you need to 
shut down your computer 
to upgrade or replace 
components, you will need 
to shut down your 
computer completely.
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Computer Shutdown

Shutting Down Your Computer
1. Click the Start button on the Windows desktop.

2. Click Shut Down on the Start menu. 

3. Select Shut down.

4. Click OK.

System Lockup
Press the Start/Reset button on the computer for 4 seconds. 

�Caution:  Use this method of shutdown only in the event of a 
system lockup because it will cause Windows to run ScanDisk 
and you will lose any unsaved data.

Using a Surge Protector
It is recommended that you 
plug your monitor, computer, 
and printer into a surge 
protector. A surge protector 
may protect your computer 
from power dips and surges and 
also from electrical storms. You 
can purchase a surge protector 
from your local retailer.
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Power Schemes
Microsoft Windows is 
equipped with a power 
management utility that 
enables you to reduce the 
amount of power 
consumed by your 
computer. You can set 
the power management 
properties so that certain 
devices turn off after a 
specified period of 
inactivity.

If your computer is connected 
to a network or it has an 
“ALWAYS ON” DSL modem, 
you should set the power 
scheme to Always On. This 
scheme prevents the computer 
from going into Sleep mode 
and breaking the network or 
DSL connection.

If you find that the preset 
power management schemes 
do not fit your work habits, 
you can create your own 
personal power scheme.

Tip

Tip
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Power Schemes

Understanding Power Schemes
The following preset power schemes are available:

Your computer power scheme is set to Home/Office Desk. 
Once the specified amount of time has elapsed, the computer 
enters Sleep mode. Hardware and software components in Sleep 
mode quickly return to a fully active state when activity from 
the keyboard or mouse is detected. 

Creating Your Own Personal Power Scheme

1. From the Windows desktop, click Start, point to Settings, 
and then click Control Panel. The Control Panel window is 
displayed.

2. Double-click the Power Management : icon and complete 
the following steps:

a. Ensure that the Home/Office Desk power scheme is 
selected.

b. Click the down arrow next to the System standby box 
and select the amount of time to allow before the 
computer goes into Sleep mode.

c. Click the down arrow next to the Turn off monitor box 
and select the amount of time to allow before the 
monitor goes into Sleep mode.

d. Click the down arrow next to the Turn off hard disks 
box and select the amount of time to allow before the 
hard drive goes into Sleep mode.

Preset Options
System goes to 
Standby after...

Monitor turns off 
after...

Hard drive turns 
off after...

Home/Office 
Desk

20 minutes of 
no activity

15 minutes of 
no activity

30 minutes of 
no activity

Always On Never 15 minutes of 
no activity

1 hour of 
no activity
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3. Click Save As, type a name for your personal power scheme, 
and click OK.

4. Click Apply, and then click OK. Your personal power 
scheme is now activated.
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6More About 
Windows
In This Chapter

File Management,  6-2

Shortcuts for the 
Desktop,  6-8

Control Panel,  6-9
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This chapter expands on the information provided in your 
My Presario—Getting Started guide. It explains many of the 
easy-to-use features of Microsoft Windows.

Some of the topics discussed in this chapter include file 
management such as copying, moving, renaming, deleting, and 
restoring files. You will learn how to create the folders in which 
you place files, and how to create shortcuts to files that can be 
placed on the Windows desktop for your convenience. This 
chapter also explains how to change wallpaper (the background) 
and screen savers, allowing you to customize the desktop to 
your own taste.
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File 
Management
Windows Explorer displays 
the contents of your 
computer. You can use this 
program to locate, copy, 
move, or delete files or 
folders on any drive in your 
computer.

A quick way to open Windows 
Explorer is to right-click the 
Start button and then select 
Explore from the pop-up 
menu.

Tip
6-2  MORE ABOUT WINDOWS
File Management

Opening Windows Explorer
1. From the Windows taskbar, click the Start button. The Start 

menu is displayed.

2. Point to Programs and then click Windows Explorer. The 
Explorer window is displayed.
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Your diskette drive, hard 
drive, CD-ROM, CD-RW, 
DVD-ROM, and Zip drives 
are identified with icons 
and letters of the alphabet. 

An external drive is in a 
separate case and plugs into 
the outside of your computer. 

CD-ROM, CD-RW, and 
DVD-ROM drives are optical 
drives. If you have two optical 
drives, one of them is the 
primary optical drive while 
the other is a secondary 
optical drive.

You can also access the drives 
by going into Windows 
Explorer.

Did you know ...

Tip
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Identifying Your Storage Drives
1. From the Windows desktop, double-click the 

My Computer g icon. The icons for your drives are 
displayed in the My Computer window. The drive letters are 
found beneath the corresponding icons.

2. Use the icons below to identify your drives: 
s

Icon Description

h Diskette Drive

q Hard Drive

q Optional External Drive

æ CD-ROM, CD-RW, or DVD-ROM

æ Optional Secondary Optical Drive

n Zip Drive
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This procedure explains 
how to search for files or 
folders by entering a 
complete or partial name. 
You can also search for 
files based on other search 
criteria, such as the date the 
file was created or 
modified, the file type, the 
file size, or some text 
within the file. 

Using this procedure, you 
can place a copy of a file in 
a new location.

You can also access the Copy 
and Paste options by 
right-clicking a file or folder.

Tip
6-4  MORE ABOUT WINDOWS
Searching For Files or Folders 
1. From the Windows taskbar, 

click the Start button. The 
Start menu is displayed.

2. Point to Find and then click 
Files or Folders. The Find: 
All Files dialog box is 
displayed.

3. On the Name & Location tab, type the name of the file or 
folder (or as much as you can remember) in the Named box.

4. In the Look in box, click the down arrow and select the drive 
you want to search.

Note: If you leave the default setting (C:), Windows searches the entire 
hard drive (or drive C partition).

5. Select the Include subfolders check box (if it is not already 
selected).

6. Click the Find Now button. The files that meet the search 
criteria and their locations are displayed in the dialog box 
window.

Copying Files
1. From the Windows taskbar, click the Start button. The Start 

menu is displayed.

2. Point to Programs and then click Windows Explorer.

3. Locate and click the file you want to copy.

4. From the Edit menu, click Copy.

5. Open the folder into which you want to copy the file.

6. From the Edit menu, click Paste. The file is copied into the 
specified folder.
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This procedure allows you 
to move a file to a new 
location.

Follow this procedure to 
change the name of a file.
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Moving Files
1. From the Windows taskbar, click the Start button. The Start 

menu is displayed.

2. Point to Programs, and then click Windows Explorer.

3. Locate the file you want to move and click it.

�Caution:  Do not move files that are part of a program. Doing so 
may render the program unusable.

4. From the Edit menu, click Cut.

5. Open the folder into which you want to move the file.

6. From the Edit menu, click Paste. The file is moved to the 
specified folder.

Renaming Files
1. From the Windows taskbar, click the Start button. The Start 

menu is displayed.

2. Point to Programs and then click Windows Explorer.

3. Locate the file you want to rename and click it.

4. From the File menu, click Rename.

�Caution:  Changing the file name extension (a dot and three 
characters after the file name) may render the file unusable.

5. Type the new file name and press the Enter key.
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Follow this procedure to 
delete a file or folder. If you 
delete a folder, all of its 
content files are deleted.

When you delete a file from 
the hard drive, it’s placed in 
the Recycle Bin. It is not 
removed from the computer 
until you empty the Recycle 
Bin.

On occasion, you should go 
into your Windows Temp 
directory and delete the .tmp 
files to free up some space on 
your hard drive. These files 
are generated automatically 
and you do not need them.

If you accidentally delete a 
file, you can restore the file 
by retrieving it from the 
Recycle Bin.

Did you know ...

Tip
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Deleting Files and Folders
1. From the Windows taskbar, click the Start button. The Start 

menu is displayed.

2. Point to Programs and then click Windows Explorer.

3. Click the file or folder you want to delete.

�Caution:  Do not delete files that are part of a program. Doing so 
may render the program unusable. If you are unsure about a file’s 
function, do not delete it.

4. Press the Delete key. The Confirm File Delete dialog box is 
displayed.

�Caution:  Files deleted from a diskette or from a network drive are 
permanently erased. They are not sent to the Recycle Bin and 
cannot be restored.

5. Click the Yes button if you want to delete the file or folder. If 
you do not want to delete the file or folder, click the No 
button.

Restoring Deleted Files
1. On the Windows desktop, double-click the Recycle Bin K 

icon. The Recycle Bin window displays a list of all deleted 
files, their previous locations, and the dates they were 
deleted.

2. Click the file you want to restore.

3. From the File menu, click Restore. The file is removed from 
the Recycle Bin and restored to its original location.
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Deleted files sent to the 
Recycle Bin use space on 
the computer hard drive. 
To free up some space, 
periodically empty the 
Recycle Bin.

You can create a folder in 
which to organize and store 
related document files. For 
example, you can create a 
folder named Budget2000. 
Store all your financial 
files, such as expenses, 
profits, taxes, and so forth, 
in the Budget2000 folder.

Another way to create a new 
folder is to click the folder or 
drive (in the left panel of 
Windows Explorer) in which 
you want to place the new 
folder. Then right-click a 
blank area in the right panel, 
point to New on the pop-up 
menu and click Folder.

Tip
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Emptying the Recycle Bin
1. On the Windows desktop, double-click the Recycle Bin K 

icon. The Recycle Bin window displays a list of all deleted 
files, their previous locations, and the dates you deleted 
them.

2. From the File menu, click Empty Recycle Bin. The Confirm 
File Delete dialog box is displayed.

�Caution:  Files deleted from the Recycle Bin are permanently 
removed. They cannot be restored.

3. On the Confirm File Delete dialog box, click the Yes button 
to delete the file(s). If you do not want to delete the file(s), 
click the No button.

Creating Folders
1. From the Windows taskbar, click the Start button. The Start 

menu is displayed.

2. Point to Programs and then click Windows Explorer.

3. Click the drive or folder in which you want to place the new 
folder.

4. From the File menu, point to New and then click Folder. 
A new folder is created.

5. Type a name for the new folder and press Enter.
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Shortcuts for 
the Desktop
Shortcuts are icons 
displayed on the desktop 
that provide quick access to 
frequently used programs, 
files, folders, and drives.   
By double-clicking a 
shortcut, you can open its 
corresponding program, 
file, folder, or drive without 
having to locate it first. 
Shortcuts do not change the 
location of files; if you 
delete a shortcut, the 
original file is not affected.

To move shortcuts 
individually, position the 
mouse cursor over the icon, 
click the left mouse button 
and drag the icon to the 
desired location.
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Shortcuts for the Desktop

Creating a Shortcut
1. From the Windows taskbar, click the Start button. The Start 

menu is displayed.

2. Point to Programs and then click Windows Explorer.

3. Locate the file, folder, or drive for which you want a 
shortcut.

Note: To make a shortcut for a program, open the program folder and 
locate the file with an .exe extension.

4. Right-click the item and select Create Shortcut.

5. Click and drag the new shortcut to the desktop.

Note: If Windows Explorer takes up the entire screen, click the Restore 
button R to display the desktop behind the Explorer window so that you 
can drag the shortcut to the desktop.

Arranging and Positioning Shortcuts
1. Move the mouse cursor to a blank area on the Windows 

desktop and right-click.

2. From the pop-up menu, select Arrange Icons.

3. Select the option for the icon arrangement you prefer. The 
icons are automatically arranged.
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Control Panel
The Control Panel contains 
many of the tools used to 
change the look of the 
Windows operating system 
and how it works.
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Control Panel

Accessing the Control Panel
1. From the Windows taskbar, click the Start button. The Start 

menu is displayed.

2. Point to Settings and then click Control Panel. A window 
containing system setup icons is displayed.

3. Double-click an icon to see the settings you can change for 
that item. Typical icons include Display, Keyboard, Mouse, 
and Printers.

Note: The icons in the Control Panel vary depending on the hardware 
and software configuration of your computer. 
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The Display Properties 
window contains controls 
for customizing the way 
Windows looks on your 
monitor screen. For 
example, you can change 
the desktop wallpaper 
(background) and screen 
saver. 

A quick way to access the 
Display Properties window is 
to right-click a blank area of 
the desktop and select 
Properties from the pop-up 
menu.

Tip
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Setting Up Display Properties
1. From the Windows taskbar, click the Start button. The Start 

menu is displayed.

2. Point to Settings and then click Control Panel. A window 
containing system setup icons is displayed.

3. Double-click the Display & icon. The Display Properties 
window opens with the Background tab selected by default.

Note: Depending on the kind of monitor you have, there may be options 
for other display controls, such as energy-saving features. For more 
information, refer to the documentation that came with the monitor.
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This procedure shows you 
how to change the 
wallpaper (background 
appearance of the Windows 
desktop).

You can also download 
wallpaper from the Internet. 
Right-click a picture that you 
like on the Internet and select 
Set as Wallpaper from the 
pop-up menu.

Did you know ...
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Changing the Wallpaper
1. From the Windows taskbar, click the Start button. The Start 

menu is displayed.

2. Point to Settings and then click Control Panel. A window 
containing system setup icons is displayed.

3. Double-click the Display & icon. The Display Properties 
window opens with the Background tab selected by default.

4. Select the wallpaper 1 or pattern 2 you want to use for a 
background. The preview window displays your selection 3.

5. Click the OK button to apply the changes and exit the 
Display Properties window.
MORE ABOUT WINDOWS   6-11



A screen saver is a moving 
picture or pattern that 
appears on the screen when 
you stop using your 
computer for a specified 
period of time.

You can protect the screen 
saver with a password by 
selecting the Password 
protected check box, clicking 
the Change button, and typing 
a password in the Change 
Password dialog box. 
Afterwards, the correct 
password must be entered 
before the screen saver will 
close.

Tip
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Changing the Screen Saver
1. From the Windows taskbar, click the Start button. The Start 

menu is displayed.

2. Point to Settings and then click Control Panel. The Control 
Panel window displays system setup icons.

3. Double-click the Display & icon. The Display Properties 
window opens with the Background tab selected by default.

4. Click the Screen Saver tab.

5. Click the down arrow next to the Screen Saver box, and 
select a screen saver from the list. The image of the monitor 
allows you to preview the selected screen saver.

6. After making your selection, click the OK button.
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Connecting 
to the 
Internet

Before you can send and receive e-ma
must first connect to an Internet Servic
establish an ISP account. You can con
the 56K ITU V.90 Standard modem or 
(DSL) modem.

This chapter provides basic informatio
using your modem, downloading and u
the Internet, and creating e-mail attach
send files with your e-mail.
7

il or “surf the Web,” you 
e Provider (ISP) and then 
nect to the Internet using 
a Digital Subscriber Line 

n for identifying and 
ploading software from 
ments that enable you to 
In This Chapter

56K Modem,   7-2

DSL Modem,   7-3

Protect Yourself when 
Downloading Software 
from the Internet,   7-7

Advanced E-mail 
Functions,   7-9
CONNECTING TO THE INTERNET   7-1



56K Modem
Your Internet PC is 
equipped with a 56K 
data/fax modem. 
Optionally, you may have a 
DSL modem (available on 
select models). 

Select models may be 
equipped with a Home 
Phoneline networking card. 
For more information on 
home networking, refer to the 
“Connecting Computers” 
chapter in this guide.

See also ...
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56K Modem

Identifying Your 56K Modem
1. From the Windows taskbar, click the Start button. The Start 

menu is displayed.

2. Point to Settings and then click Control Panel. The Control 
Panel window is displayed.

3. Double-click the Modems i icon. The name of the installed 
modem is displayed on the Modems Properties window.

Using the 56K ITU V.90 Standard Modem
The ITU V.90 Standard defines modem data transmission at 
56 Kbps speeds. The download rate is faster than the upload 
rate. The theoretical maximum download speed is 56 Kbps, and 
the maximum upload speed is up to 33.6 Kbps. Although your 
modem is capable of download speeds of up to 56 Kbps, 
maximum achievable download transmission rates may not 
reach 56 Kbps, and the rate will vary depending on telephone 
line conditions.
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DSL Modem
DSL service allows you to 
download large files in 
minutes rather than hours, 
using low-cost, high-speed 
broadband data transfer 
technology over standard 
telephone lines.

To determine if DSL
service is available in your 
area, contact your 
telecommunications service 
provider and your Internet 
Service Provider.

Check with your DSL 
service provider to make 
sure the service they are 
offering is compatible with 
your DSL modem.

For questions about the 
DSL modem in your 
computer, visit the Compaq 
High-Speed Web site at:

www.compaq.com/
mypresario/highspeed

DSL connections are designed 
as “ALWAYS ON.” Refer to 
the “Saving Energy” chapter 
in this guide to avoid DSL 
disconnections due to the 
default Power Management 
operation.

See also ...
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DSL Modem

Understanding the Benefits of DSL 
DSL benefits include:

➜ Simultaneous talking and surfing. You can simultaneously 
talk on the phone, surf the Web, and download files using a 
single telephone line.

➜ Increased download transfer rate. You can download files 
from the Internet to your computer up to 50 times faster than 
with a 56K ITU V.90-compliant modem.

➜ Increased upload transfer rate. You can upload files from 
your computer to the Internet at a significantly faster rate 
than with a 56K ITU V.90-compliant modem.

➜ Constant connection. DSL service provides constant 
Internet access. You don’t have to dial your ISP and wait for 
a connection.
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If you decide to subscribe 
to DSL service, you must 
determine which modem is 
installed in your computer.
7-4 CONNECTING TO THE INTERNET
Identifying Your DSL Modem
1. Click the Start button on the Windows taskbar. The Start 

menu is displayed.

2. Point to Settings and then click Control Panel. The Control 
Panel window is displayed.

3. Double-click the Modems i icon. The name of the installed 
modem is displayed in the Modems Properties window.

Using Your DSL Modem
Your Internet PC may be equipped with a DSL modem. This 
feature is available on select models and uses high-speed 
broadband data communications technology known as Digital 
Subscriber Line (DSL). DSL uses standard telephone lines for 
data communications, but operates in a different frequency 
range than your telephone or 56K modem.

For more information about DSL and information on how to 
subscribe to DSL service, visit the following Compaq 
High-Speed Web site:

www.compaq.com/mypresario/highspeed

Note: Before establishing a DSL connection to the Internet, you must 
establish DSL service with your telecommunications service provider and 
Internet Service Provider (ISP).
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Before you can complete a 
DSL connection, you must 
contact your 
telecommunications service 
provider and ISP for 
information about 
establishing DSL service, 
as well as e-mail and 
Web-browser settings.
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Connecting Your DSL Modem
You must contact your telecommunications service provider and 
Internet Service Provider (ISP) to determine the availability of 
DSL service in your area. You may be required to have an 
external telephone line splitter installed (possibly at an 
additional cost) by your telecommunications service provider. 
In addition, your home telephone wiring may need to be 
inspected by your telecommunications service provider 
(possibly at an additional cost) to ensure that your home 
telephone wiring configuration will support DSL service.

Once you subscribe to DSL service, visit the following Compaq 
Web site for details about hooking up your modem:

www.compaq.com/mypresario/highspeed
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The DSL Modem Setup 
Wizard CD contains the 
drivers and software 
updates necessary to enable 
the DSL modem and the 
connection.

To run the DSL Modem 
Setup Wizard, insert the 
CD into the CD drive. The 
setup should start 
automatically. Follow the 
instructions on the screen to 
complete the setup.
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Installing the DSL Modem Upgrade
If the DSL Modem Setup Wizard CD does not start within 
30 seconds, complete the following steps:

1. Click the Start button on the Windows taskbar. The Start 
menu is displayed.

2. Click Run. The Run dialog 
box is displayed.

3. In the Run dialog box, type: 
E:\setup.exe (where “E” is 
the letter assigned to the 
CD drive).

4. Click OK and follow the instructions on the screen.

Accessing the Latest Modem Updates
To access the latest DSL modem updates, visit the Compaq Web 
site at:

www.compaq.com/mypresario/highspeed
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Protect
Yourself when 
Downloading 
Software from 
the Internet
When you download 
software files from the 
Internet, be sure that your 
anti-virus utility is running. 
Anti-virus software ensures 
that your computer does not 
become infected with a 
virus.

For more information on 
anti-virus software, see the 
“Preventive Maintenance” 
chapter in this guide.

See also ...
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Protect Yourself when Downloading Software from the Internet

Using Shareware
Shareware is software that is made available on the Internet as 
downloadable files. Restrictions may apply for the use of these 
files. Read all copyright materials before downloading software 
from the Internet.

Using Software “Fixes”
Fixes are updates (or “patches”) for the software on your 
computer. To access a software fix, go to the Web site of the 
software manufacturer and find the location of their updates.

For updates on all hardware-enabling software (the drivers that 
run your hardware) that came with your Internet PC, go to the 
following Web site to receive free SoftPaqs (“software fixes”):

www.compaq.com/support/files

�Caution:  Hardware-enabling software that does not come directly 
from the Compaq Web site may render your hardware unusable.

All third-party software (software that did not come with your 
computer) “patches” must come directly from the manufacturer.
CONNECTING TO THE INTERNET   7-7



If you download software 
from a Web site, follow the 
installation instructions that 
are usually displayed on the 
Web page. If installation 
instructions are not 
provided, complete the 
steps listed here.

Before downloading files of 
any kind from the Internet, 
make sure that call-waiting is 
disabled and that your 
anti-virus utility is running.

If the download process is 
interrupted, you must restart 
the download procedure from 
the beginning.

For more information on 
anti-virus software, see the 
“Preventive Maintenance” 
chapter.

Some software is downloaded 
in a compressed state. Most 
Web sites using this 
technology provide links to 
download the appropriate 
utility, such as WinZip, to 
decompress the files.

Tip

Did you know ...

See also ...

Did you know ...

1
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Installing Software Downloaded from the 
Internet
1. Before you start downloading, note the location on the hard 

drive where the files will be stored. Also, be sure that you 
have enough disk space available. See the “Installing New 
Components” chapter in this guide for information about 
checking your hard drive space.

2. After the download is complete, terminate your Internet 
connection. 

3. Close all other open programs.

4. From the Windows taskbar, click the Start button, point to 
Settings, and then click Control Panel. The Control Panel 
window is displayed.

5. Double-click the 
Add/Remove Programs ¤ 
icon. The Add/Remove 
Programs Properties 
window is displayed.

6. Click the Install button. The 
Install Program wizard is 
displayed.

7. Click the Next button. The 
Run Installation Program 
window is displayed.

8. Click the Browse buttton. 
The Browse dialog box is 
displayed.

9. Locate and select the 
Setup.exe or Install.exe file 
for the downloaded 
software.

0. Click the Open button to begin 
the installation process.
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Advanced E-mail Functions

Sending an E-mail Attachment in 
Microsoft Outlook Express
1. After typing an e-mail message in Outlook Express, click the 

Insert menu and select File Attachment. The Insert 
Attachment dialog box is displayed.

2. Locate the file that you want to attach to the e-mail. You may 
need to click the down arrow next to the Look in box to 
select the appropriate drive.

3. Click the file you want to attach to the e-mail.

4. Click the Attach button. The Insert Attachment dialog box 
closes and the file is inserted as an attachment to your e-mail.

 
 
 

 

Advanced 
E-mail 
Functions
E-mail is a great way to 
send files across the 
Internet, and the procedure
is simple. Just follow these
steps to attach a file to your
e-mail.

When you attach a file to an 
e-mail, your computer creates
a copy of the file. Your 
original file does not move 
from its location.

You can also insert an 
attachment by clicking the 
Attach button on the e-mail 
message instead of going to 
the File menu.

Did you know ...

Tip
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Opening an E-mail Attachment
To open an e-mail attachment, open the e-mail message and 
double-click the attachment icon. Once the file is open, you can:

➜ View the file. If you do not 
want to save, modify, or 
print the file, click the 
Close button P after 
viewing. The file closes and 
you are returned to the 
e-mail that contains the 
attachment.

➜ Save the file. You can save 
a file attachment while it is 
open. Or you can save the attachment without opening the 
file by clicking the File menu and selecting Save 
Attachments, and then specifying a drive or folder in the 
Save Attachments dialog box. You can specify a new name 
for the file in the File Name box if you do not want to use 
the current file name.

➜ Print the file. You can print the file attachment while it is 
open. Or you can print the attachment without opening the 
file by clicking the File menu and selecting Print. Then 
select the Print attached files with item(s) check box in the 
Print dialog box.

 

You may receive e-mails 
with attached files. If an 
e-mail contains an 
attachment, a paperclip V
icon is displayed next to the
e-mail.

While viewing an e-mail 
attachment, the e-mail 
message that contains the 
attachment is minimized on 
the Windows taskbar so that 
you can easily return to the 
message by clicking it.

Did you know ...
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Connecting 
Computers

Would you like to transfer a file between
copying it to a diskette—a method humo
“sneakernet”? Would you like to access 
time as someone else in your household
phone lines? Or would you like to play a
head” game with someone in your home?
more are possible when you connect you
network.

A home network allows two or more com
printer, Zip drive, scanner, Internet conn
peripheral device, as well as Internet acc
are economical as well as convenient an

In this chapter, you will learn the concep
and hardware/software requirements for
network.
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Networking 
Computers

A home network can be as 
simple or complicated as 
you want. It can consist of 
two computers linked to 
share files and an Internet 
connection, or it can be 
expanded to a complex 
household network with 
many computers connected 
at once.

The benefits of home 
networking include the 
following:

➜ Simultaneous Internet 
connections

➜ Multiple computers 
sharing one printer, 
modem, scanner, and 
other equipment

➜ Networked computers 
sharing files and 
applications

➜ Multi-player gaming
.

8-2  CONNECTING COMPUTERS
Networking Computers

What Is a Home Network? 

A network is two or more computers connected to each other. 
Each computer must have an adapter and must be connected to 
the other computer(s) on the network. Networks are created so 
that one computer can use a device—like a color printer—that 
is connected to a different computer.

A home network can also be used to share a single Internet 
connection among several computers. Family members can also 
share files between computers on the network.

How Is a Home Network Different From a 
Business Network?

The biggest difference between a home network and a 
traditional business network is the complexity of the products 
required to make it work.

Compaq's goal is to adapt business network technology to the 
needs of home-networking customers. Both hardware and 
software components that Compaq has developed to create 
home-networking features are easy for consumers to understand 
and use.
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Types of Home 
Networks

Three types of home 
network are:

➜ Ethernet

➜ Home phone line

➜ Wireless network

This section briefly 
describes each type of 
home network, its 
advantages and 
disadvantages, and the 
requirements necessary to 
use them to network your 
home computers.

.

Learn more about home 
networking at the Compaq 
Web site or toll-free number: 

www.compaq.com/athome

1-800-888-0263

All home networks are 
compatible with the 
following Internet access 
methods:

➜ Analog, dial-up modem 
(56K ITU V.90)

➜ Digital xDSL modem

➜ Cable modem

➜ ISDN modem

Tip
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Types of Home Networks

Ethernet Network

An Ethernet network 
connects your computers 
using a standard Category 5 
cable (which must be 
installed in your house) and 
an Ethernet hub. Each 
computer on the network 
requires an Ethernet 
adaptor 1. Ethernet is 
commonly used in corporate 
environments today.

Advantages:

➜ Faster data transfer rate (up to 100 Mbps)

➜ Wide acceptance in the business computer marketplace

➜ Ability to support virtually all popular network protocols

Disadvantages:

➜ Special planning for Category 5 wire installation and higher 
wire and installation costs required

➜ Installation of Ethernet hub and 10/100 Ethernet jacks 
required

➜ Faster data rate (100 Mbps) requires all the Ethernet 
adapters and the hub to be 10/100.

Requirements:

Item Description

Connection Connection 10/100-Mbps Ethernet adapter and 
NIC1 with necessary drivers

Cable category 5 UTP cable long enough to reach the hub

Hub 10/100-Mbps Ethernet hub with enough ports to 
accommodate all computers in the home network

Processor 486 MHz

Operating system Microsoft Windows 95 or Windows 98

Other CD-ROM drive 
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Perhaps the most exciting 
thing about home 
networking over existing 
phone lines is the flexibility 
it gives you. You can 
engage in a multiplayer 
game while sending a fax 
or talking over the phone. 

Mom and Dad can surf the 
Web to plan a family 
vacation while the kids use 
an online search engine to 
help with their homework. 

Many family members can 
be connected to the Internet 
at the same time (and each 
can surf wherever he or she 
chooses) with a single ISP 
account.
8-4  CONNECTING COMPUTERS
Home Phoneline Network

A Home Phoneline network uses an industry-certified adapter 
card that allows you to create a home network using your 
existing in-home phone wiring to connect your computers. You 
can print, access files, or play games over your home network 
and still use your phone for sharing Internet access, voice calls, 
or faxing using a single phone line.

Advantages:

➜ Uses existing home phone line wiring. No additional wiring 
or equipment is necessary unless you want to have a 
networked computer in an area without a working 
phone jack.

➜ Currently supports up to 10 Mbps

Disadvantages:

➜ Access is limited to those areas where phone jacks are 
installed.

➜ Data transfer rate is slower than 100 Mbps Ethernet.

Requirements:

Item Description

Connection Home Phoneline network-certified adapter with 
necessary drivers

Cable category Standard telephone wire long enough to reach the 
nearest phone jack

Processor Pentium 100 MHz

Operating system Microsoft Windows 95 or Windows 98

Other CD-ROM or diskette drive
PCI slot, USB connection, or PC card slot
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Wireless is by far the most 
expensive option, but it is 
potentially the most 
versatile. A wireless 
network allows you to be 
connected to a local 
network or the Internet but 
still be “untethered” by 
cables.
MY PRESARIO—LEARNING MORE
Wireless Network

A wireless network interconnects computers using radio 
frequency (RF) transmissions rather than wires. This type of 
network allows the creation of a cordless local area network 
(LAN) that lets you access files and print from any computer on 
the network, and it lets you share a single Internet connection. 

Advantages:

➜ No wiring or additional equipment (such as a hub) is 
necessary beyond the Home RF adapters

➜ Not limited by wiring constraints

Disadvantages:

➜ A slower data transfer rate than Home PNA and Ethernet 
(currently up to 600 Kb/s)

Requirements:

Item Description

Connection Compaq Home RF adapter

Cable category Not necessary

Processor Pentium class (100, 200, etc.)

Operating system Windows 98

Other USB port or PC card slot
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Setting Up a 
Network

To set up a network, you 
must:

➜ Install the network 
protocols and services

➜ Map the network drive

➜ Share printers and 
folders

However, the easiest way is 
to use the network setup 
wizard that is provided with 
your hardware.

The Network Neighborhood 
k icon will not appear on 
the Windows desktop until the 
network protocols are 
installed.

A protocol is the language 
computers use to 
communicate over a network. 
Computers must use the same 
protocol to communicate with 
one another.

Did you know ...

Did you know ...
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Setting Up a Network

Installing the Network Protocols

1. If a network is not yet set up, 
from the Windows desktop 
click Start, point to 
Settings, and then click 
Control Panel.

2. Double-click the 
Network l icon.

3. When the message Your 
network is not complete. 
Do you want to continue? 
is displayed, click Yes.

4. In the Network window, the Configuration tab is displayed:

a. Click Add.

b. Select Client and click Add.

c. Select Microsoft.

d. Select Client for Microsoft Networks, and then click 
OK.

e. Select File and Print Sharing…, then select both check 
boxes.

f. Click OK. In the Network window, the Configuration 
tab is displayed. Click Add.

5. In the Select Network Component Type window:

a. Click Protocol.

b. Click Add.

c. Select Microsoft.

d. Select IPX/SPX compatible Protocol.

e. Click OK.

f. Click Add.

g. Click Protocol.

h. Click Add.

i. Select Microsoft.
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j. Select TCP/IP.

k. Click OK.

6. Select the Identification Tab in the Network window and 
complete the following steps:

a. Enter a name for the computer. This name must be 
unique—different from the name of every other 
computer in the network. The name can contain a 
maximum of 15 letters, numbers, and the following 
special characters: 
!  @  #  $  %   ^  &   ( )  -   _  ' {} ~ 
Do not use blank spaces in the Computer name box.

b. Enter a Workgroup name. If you would like all 
computers to have access to each other, the Workgroup 
name must be the same for all of the computers on the 
network. The name can contain a maximum of 15 letters, 
numbers, and the following special characters:
!  @  #  $  %   ^  &   ( )  -   _  ' {} ~ 
Do not use blank spaces in the Workgroup name box.

c. Click OK. The System Settings Change window is 
displayed. Click Yes to restart your computer. The 
Microsoft Networking window is displayed.

7. Complete the following steps:

a. Enter a User name. Your user name needs to be easy to 
remember since you will use it every time you log on to 
your network.

b. Enter a Password.

c. Click OK.

8. Close the Control Panel window.

9. Repeat this procedure to add the next computer to the 
network.
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Mapping a 
Network Drive

Mapping to a directory 
means making a permanent 
connection to another 
computer.

If you wish to access a shared 
folder on another computer 
automatically each time you 
turn on your computer and log 
on to the network, you will 
need to map a network drive 
first.

To prevent others on the 
network from accessing 
sensitive files on your 
computer, you can set the 
access level of a folder by 
adjusting the shared files 
properties. The shared 
properties can be changed to 
meet your file security needs.

Tip

Did you know ...
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Mapping a Network Drive

Mapping a Network Drive

1. Right-click the My Computer g icon on the Windows 
desktop.

2. Click Map Network Drive. The Drive box automatically 
contains the next available drive letter.

3. Click the down arrow next to the text. Select the path of the 
drive you wish to map. Add the exact folder location to 
complete the path. Your path should look similar to the 
following:

C:\My Documents\Shared Files

4. Click the Reconnect at logon box. If the folder is password 
protected, you will be prompted for the password each time 
you log on to the network.

Securing Files

Microsoft Networking enables file sharing at the folder level; 
that is, either all or none of the files in a folder must be shared. 
You cannot share some files in a folder and keep others private.

If you want to share files on the network, you should create a 
special folder for those files and share only that folder. This 
feature provides the flexibility of allowing file sharing while 
keeping all programs and sensitive files on your hard 
disk secure.
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Sharing Folders 

Sharing folders can be very 
useful if you have a large 
amount of data that you 
want to share with someone 
else. Remember, however, 
that anyone with whom you 
share files can add, delete, 
and modify information.
MY PRESARIO—LEARNING MORE
Sharing Folders

Creating a Shared Folder

1. Double-click the My Computer g icon. 

2. Double-click C: (or the letter that corresponds to your hard 
drive).

3. On the menu bar, click File, point to New, and then click 
Folder. A New Folder is displayed in the window.

4. Type a name that indicates the folder is shared, such as 
Shared Files.

5. Move the files you wish to share into this folder.
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Sharing a Folder

1. Locate the folder by using Microsoft Windows Explorer.

2. Right-click the folder name.

3. Click Sharing.

4. Click Shared As. The folder name is displayed 
automatically in the Share Name box. You can change the 
share name if you want.

5. Typing a comment in the Comment text box is optional.

6. Click the Access Type you wish to activate:

➜ Read-Only—Others can read the files in the folder, but 
they cannot make any changes to those files.

➜ Full—Others on the network will have read and write 
access to the contents of the shared folder. They will be 
able to change or potentially delete all the files.

➜ Depends on Password—You can designate a Read-
Only or a Full Access password.

7. Click OK.
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Sharing a Printer

Setting Up Printer Sharing

1. From the Windows desktop, 
click the Start button, point 
to Settings, and then click 
Printers.

2. Right-click the desired 
printer and select Sharing.

3. Select Shared As. You may 
change the Share name, add 
a Comment, and set a 
Password, if desired.

4. Click OK. In the Printers window, an open hand holding the 
printer you share on the network is displayed.

5. Click the Close ∫ button in the upper right corner of the 
screen to close the Printers window.

 

Sharing a 
Printer

One of the advantages of 
installing a network is the 
ability to share resources, 
such as a printer.

Once you have set up a 
printer to be shared, you 
can connect all your 
computers to the network to
access the printer.
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Connecting to a Shared Printer

1. From the Windows desktop, click the Start button, point to 
Settings, and then click Printers.

2. Double-click the Add Printer $ icon. The Add Printer 
window is displayed.

3. Select Network Printer, and then click Next.

4. To find the network printer, click Browse. The Browse for 
Printer window is displayed.

5. Select the printer you want to use, and then click OK. The 
network printer path statement is displayed on the Add 
Printer window.

6. If you would like to print from MS-DOS based programs, 
select Yes, and then click Next. If you will not be printing 
from MS-DOS based programs, select No, then click Next. 
A message is displayed reminding you to put the printer 
online before you try printing. 

7. Click Next.

8. Select the printer manufacturer and model, and click Next.

9. You may either accept or change the default printer name. If 
you want this to be the default printer, select Yes and then 
click Finish. If you do not wish this to be the default printer, 
select No and then click Finish.
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Sharing Internet Access

Sharing Internet Access

If you have more than one computer connected to the Internet, 
you need to choose one of them as the Internet-Sharing PC. 
While two or more users are online, they share the bandwidth of 
the connection.

 

Sharing 
Internet Access

With home networking, 
multiple family members 
can surf the Internet from 
different computers at the 
same time using a single 
ISP account.

The computer that is 
physically connected to the 
Internet is called the Internet-
Sharing PC. Its connection 
provides all the other network
computers (referred to as 
“client computers”) with 
Internet access.

The Home Network Setup 
CD-ROM contains all the 
software required to install 
and configure 
Internet-sharing on your 
cordless network.

Did you know ...

Tip
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Preventive 
Maintenance
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What is 
Preventive 
Maintenance?
Your car needs it, people 
need it, and so do 
computers. Regular 
preventive maintenance 
helps you avoid common 
computer problems.

Preventive maintenance for 
your computer is easier 
than you might think. You 
don’t need any special tools 
or know-how. A few basic 
procedures will help keep 
your computer operating at 
its best.
9-2 PREVENTIVE MAINTENANCE
What is Preventive Maintenance?
Basic preventive maintenance procedures include the 
following:

➜ Creating backups of your files

➜ Deleting unwanted files

➜ Maximizing your hard drive

➜ Running VirusScan

Perform these preventive maintenance tasks at the intervals 
recommended below or more often if you use your computer a 
great deal.

Note: You may want to back up critical files more frequently.

Procedure Frequency

Back Up Files (see note below) Monthly

Delete Unwanted Files As Needed

Maximize Your Hard Drive Monthly

Run VirusScan As Needed
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Deleting 
Unwanted Files
The more you use your 
computer, the more files 
you will create. In time, the 
hard drive can become 
cluttered and performance 
may suffer. 

It’s easy to take an 
inventory of files stored on 
your computer and do some 
regular “house cleaning.”

When in doubt, don’t delete a 
file.

Tip
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Deleting Unwanted Files

Taking Inventory of Your Hard Drive
1. Double-click the 

My Computer g icon on 
the Windows desktop. The 
My Computer window is 
displayed.

2. Right-click the disk on which 
you need to free space, and 
click Properties on the pop-
up menu.

�Caution:  When deleting files, make 
sure you don’t delete any files that are 
necessary for system or program 
operation, including the following file 
extensions: .exe, .dll, or .ini.

3. On the General tab, click Disk 
Cleanup.

4. Click the files you want to 
delete.

5. Click OK.
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Deleted files are sent to the 
Recycle Bin, but still take 
up space on the computer 
hard drive. Emptying the 
Recycle Bin permanently 
deletes the files and frees 
up disk space.

When you delete mail in 
Microsoft Outlook, the mail is 
stored in the Deleted Items 
folder on the hard drive. You 
will want to delete this mail 
periodically from the hard 
drive.

Did you know ...
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Emptying the Recycle Bin
1. Double-click the Recycle 

Bin J icon on the Windows 
desktop.

�Caution:  Files that are 
emptied from the Recycle Bin 
cannot be retrieved.

2. Click individual files and 
press Delete. Or click the 
File menu, and then click 
Empty Recycle Bin to 
remove all files.

3. Click Yes to confirm the deletion.

Deleting Unwanted Mail
1. Right-click the Deleted 

Items Jicon on the 
Outlook toolbar.

2. Select Empty “Deleted 
Items” Folder.

3. Click Yes.
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To speed up the display of 
frequently visited Web pages, 
Internet Explorer stores them 
on the hard drive in the 
Temporary Internet Files 
folder. You can set the size of 
this folder or empty it to 
control how much space it 
uses on the hard drive.

Increasing the space you set 
for the Temporary Internet 
Files folder allows previously 
visited pages to be displayed 
faster, but decreases the 
amount of space available for 
other files on your computer. 

Did you know ...

Tip
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Deleting Temporary Internet Files
1. Double-click the Microsoft 

Internet Explorer A icon on 
the Windows desktop.

2. From the Tools menu in 
Internet Explorer, click 
Internet Options.

3. Click Delete Files.

4. Click OK.

Increasing Temporary Internet File Space
1. Double-click the 

Microsoft Internet 
Explorer A icon on the 
Windows desktop.

2. From the Tools menu, 
click Internet Options.

3. Click Settings.

4. To increase the amount 
of space to store pages 
in, click the slider and 
move it to the right.

5. Click OK to verify the new setting.

6. Click OK to apply the setting.
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Deleting the Internet 
History File creates more 
disk space on your 
computer hard drive.

The Internet History file keeps 
track of the Web sites you visit. 
If you forget a URL, you can 
check the History list.

With the Windows 
Maintenance Wizard, you can 
schedule preventive 
maintenance utilities to run 
automatically to:

➜ Make your programs run 
faster 

➜ Check the hard drive for 
problems

➜ Free up hard drive space

Tip

Did you know ...
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Deleting the Internet History File
1. Double-click the Microsoft 

Internet Explorer A icon 
on the Windows desktop.

2. On the Tools menu in 
Internet Explorer, click 
Internet Options. 

3. Click the General tab. 

4. Click Clear History.

5. Click OK to clear the 
Internet History file.

Note: The History area allows you to designate the number of days that the 
History list keeps track of your pages.
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Optimizing the 
Computer Hard 
Drive
You can use ScanDisk to 
check your hard drive for 
technical errors and repair 
any damaged areas.

ScanDisk and Defragmenter 
take less time to complete 
when run on a regular basis.

When only a few 
passengers are on a bus, 
each person can sit 
wherever he wants. But as 
the bus gets crowded, 
passengers must move 
closer together so that all 
the seats can be filled.

When you optimize the 
computer hard drive, you’re 
moving files closer together 
so that hard drive space is 
used more efficiently. This 
helps programs run faster 
and speeds up access to 
your hard drive.

Tip
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Optimizing the Computer Hard Drive

Using ScanDisk 
1. Close all open programs in 

the system tray, such as 
Compaq Service 
Connection and printer. 
(The system tray is located 
at the far right of the 
Windows taskbar at the 
bottom of the screen.)

2. From the Windows taskbar, 
click the Start button, then point to Programs, then 
Accessories, then System Tools, and then click Scan Disk.

3. Select the drive you want to 
scan.

4. Click Start to begin scanning.

Using Disk Defragmenter
1. Close all open 

programs.

2. From the Windows 
taskbar, click the Start 
button, then point to 
Programs, then 
Accessories, then System Tools, and then click Disk 
Defragmenter. 

3. Select the drive you want to defragment.

4. Click OK to begin defragmenting.

Note: If you haven’t defragmented the hard drive for a while, the operation 
may take an hour or longer.
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Anti-Virus 
Software
A computer virus can 
destroy information on 
your hard drive. A virus can 
enter your computer 
through: 

➜ a diskette

➜ a CD, DVD, CD-R, or 
CD-RW disc

➜ e-mail

➜ infected files 
downloaded from the 
Internet

Some viruses affect your 
computer immediately; 
others are set to activate on 
a certain date.

Your computer is equipped 
with anti-virus software. 
Scanning your computer 
for viruses is an important 
part of keeping your files 
safe from becoming 
infected with computer 
viruses. 

However, hundreds of new 
viruses are created each 
month, so you should 
update the anti-virus tool 
often.
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Anti-Virus Software

Scanning for Viruses
1. Press the Help G button on 

the keyboard.

2. Click the McAfee 
VirusScan * icon. The 
VirusScan Launcher is 
displayed.

3. Click Scan.The McAfee 
VirusScan window is displayed. 

1. From the VirusScan window, 
select the Where & What 
tab. The C drive, your local 
hard drive, is the default. If 
you want to scan a different 
drive, click Browse and 
select another drive letter. 

2. Click Scan Now.

Updating McAfee VirusScan
1. Press the Internet ∆ button 

on the Internet keyboard.

2. In the Address box type 
www.mcafee.com. The 
McAfee home page is 
displayed.

3. Click the Anti-Virus tab.

4. Click Update VirusScan.
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An important part of 
computer preventive 
maintenance is making sure 
you’re prepared for any 
possible emergencies. 

In this section you will 
create an Anti-Virus 
Emergency diskette.

If your computer is infected 
with a virus, you may not be 
able to access the hard drive 
or start Windows. An 
Emergency Diskette contains 
the operating system files 
necessary to restart your 
computer.

If you ever need to start your 
computer from the Emergency 
Diskette, you should 
immediately perform a scan of 
your computer and its 
contents. 

Did you know ...

Did you know ...
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Creating an Anti-Virus Emergency 
Diskette
1. Click the McAfee 

VirusScan * icon. The 
VirusScan Launcher is 
displayed 

2. Click Tools. The Utility 
Toolbox is displayed.

3. Click Emergency Disk. 
The Emergency Disk 
Wizard is displayed. 

4. Insert a formatted diskette in
the diskette drive.

5. Click Don’t Format. 

6. Click Next. 

7. Click Finish.

8. Label the disk VirusScan 
Emergency Diskette, and store 
it in a cool and dry place. 
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Compaq 
Support
If you have a computer 
problem or question, you 
can check the following 
resources for answers:

➜ Press the Help G  
button on the keyboard 
to access the Compaq 
Service and Support 
folder for personalized 
Web support and 
computing tips.

➜ Review the “Need 
Some Help?” chapter in 
this guide for 
suggestions on how to 
fix the problem.

➜ Review the tools in this 
topic to find answers.
9-10 PREVENTIVE MAINTENANCE
Compaq Support

Press the Help G button on the keyboard to access the following 
Compaq support tools:

Icon Compaq Support Tools

Compaq Service 
Connection

D

This maintenance program keeps your computer in 
superior operating condition, with secure, automated 
software updates over the Internet. Look for the 
spinning D that notifies you of updates, and click 
Install. Then sit back and relax while you receive the 
latest technical information!

McAfee Anti-Virus

*

Need the right tool to protect data on your computer 
from viruses? Check out the McAfee Anti-Virus 
software found in your Service and Support folder. 
The McAfee VirusScan detects and destroys 
potentially destructive viruses and provides you with 
free anti-virus updates for one year after registering. 
Protect your investment with McAfee!

Compaq Remote 
Support (available 
in select regions)

¿

Instead of making a trip to the repair center, try the 
Compaq Remote Support feature. Ask our skilled 
support technicians to use Carbon Copy to access 
your computer, diagnose, and solve your problem 
remotely. You can watch while the technician works 
on your computer and even chat with the technician.

Internet Support

«

With Internet Support, you are one click away from a 
wide variety of Web-based service tools that will 
make your entire computing experience easier. Visit 
the Compaq Support Forum (available in select 
regions) to get personal assistance from an online 
technician, get the latest software updates, and 
much, much more!
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Recovery CD
The Recovery CD can 
reinstall the software to the 
state it was in when you 
purchased the computer. 

You also have the option of 
restoring your computer to 
the way it was when you 
performed the last User 
Backup.

Everything added to the drive 
since the last User Backup 
will be lost after you perform 
a user recovery.

Did you know ...
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Recovery CD

Using the Recovery CD
Restarting your computer with the Recovery CD in the drive 
displays the following menu:

➜ The Emergency Diskette option creates a recovery diskette, 
which stores the software option information that came with 
your computer. This information will be needed to restore 
your computer to the condition it was in when you first 
unpacked it.

➜ The User Backup option creates a backup of the current 
Windows configuration on the C drive. The backup is stored 
in USER.PQI files on the D drive. 

➜ The User Restore option extracts the data in the USER.PQI 
files from the D drive and restores the desktop to the settings 
as they existed at the time of your last user backup.

➜ The Factory Restore option restores the computer to its 
original factory condition. You will need to reenter your 
factory registration information again, and you may be 
prompted to insert your emergency diskette.

➜ The Exit option exits the Recovery CD.
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QuickRestore
Compaq QuickRestore 
enables you to restore your 
system files from a separate 
partition on your hard 
drive.

Before you perform any 
restore or backup tasks, create 
a QuickRestore Emergency 
Diskette. For the steps 
required to create this diskette, 
see “Creating a QuickRestore 
Emergency Diskette.”

Selective Restore allows 
you to select certain 
Compaq drivers or 
applications you want to 
reinstall without 
reformatting your hard 
drive. 

Tip
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Quick Restore

Quick Restore Options
The five options for QuickRestore are listed below.

NOTE: Do not leave your computer unattended while QuickRestore is running 
because you are periodically required to enter information. If you do not enter the 
required information, your computer may not complete the QuickRestore 
process.

Selective Restore
1. From the Windows desktop, double-click the Compaq 

Support icon.

2. Click the QuickRestore icon. The QuickRestore main menu 
is displayed.

3. Place your cursor over the Selective Restore icon. If you see 
a message stating that no applications were found, there may 
be some files missing or corrupted, and you may need to 
contact Compaq Technical Support to resolve the problem. 
Otherwise, proceed to the next step.

QuickRestore

Restore Option Description

Selective Restore Restores selected Compaq drivers or applications that 
you want to reinstall without reformatting your hard drive.

User Backup Backs up all information and files on your hard drive and 
stores them in a separate partition on your drive.

User Restore Restores your hard drive to the state it was in at your last 
User Backup.

Quick Restore 
Emergency Diskette

Allows you to save your computer’s unique setup 
information for use in case of an emergency. Store the 
diskette in a safe place.

Factory Restore Restores your computer to its original factory-installed 
software state.
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QuickRestore
(Continued)

The User Backup backs up 
all of the information and 
files on your hard drive and 
stores them in a separate 
partition on your drive for 
later use. Complete a User 
Backup to protect your 
personal files and data.
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4. The Selective Restore menu is displayed. From the Selective 
Restore menu, you can choose from several drivers or 
applications. Click the icon representing the application or 
driver you want to reinstall.

5. A message is displayed asking if you want to restore the 
software. Click Yes to continue. QuickRestore then restores 
the driver you selected.

6. You will be prompted to restart your computer. Save all open 
files and close all applications.

7. Restart your computer by clicking Start, Shutdown, and 
Restart. Click OK.

8. Repeat this procedure to reinstall as many drivers or 
applications as you need.

User Backup
1. From the Windows desktop, double-click the Compaq 

Support icon.

2. Click the QuickRestore icon. The QuickRestore main menu 
is displayed.

3. Place your cursor over the User Backup icon. If you see a 
message that says User Backup cannot be performed on this 
machine, call Compaq Technical Support at the telephone 
number listed on your warranty documentation. Otherwise, 
proceed to the next step.

4. Click the Continue button.

5. A message is displayed asking if you want to copy the data to 
the D: drive. Click Yes to continue. The system saves your 
files to the D: partition and then restarts automatically.

IMPORTANT: You may be notified that your backup device is not large 
enough to complete User Backup. You can increase the partition size unless 
your hard drive is completely full. See the following section to increase the 
size of the User Backup partition.
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QuickRestore
(Continued)

User Restore restores your 
system to the configuration 
that was saved the last time 
you completed User 
Backup.

The User Restore option is 
not used as often as User 
Backup, and should be 
performed only when you 
need to restore your system 
to its last User Backup 
condition
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Increasing the Size of the User Backup 
Partition

�Caution:  Increasing the size of your SystemSave partition 
may take several minutes to complete. Do not press any keys 
to turn off your computer while increasing the size of the 
partition. Failure to observe this caution can result in damage 
or permanent loss of important files.

A message is displayed asking you if you want to resize your 
SystemSave partition. The Resize SystemSave option is the 
default option. To increase the size of the partition, click the 
OK button. Be aware that the size of the C: drive will decrease 
as the size of the SystemSave partition increases.

The computer automatically begins resizing the partition and 
then completes User Backup.

User Restore
IMPORTANT: You must have performed User Backup at least once to use this option.

1. From the Windows desktop, double-click the Compaq 
Support icon.

2. Click the QuickRestore icon.

3. Place your cursor over the User Restore icon.

Note: If no backup files are found, this means that you have not performed 
User Backup. You cannot perform User Restore unless you have performed 
User Backup at least once.

4. Click the Continue button.

5. The computer asks you if you want to continue with the 
restore. Click Yes to continue.

�Caution:  In the next step, any files, programs, and data 
installed or created after your last User Backup will be deleted 
after you press Enter.
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QuickRestore
(Continued)

Before you perform any 
restore or backup tasks, 
create an Emergency 
Diskette. The Emergency 
Diskette is not bootable, 
and QuickRestore may 
require it during a restore 
procedure.
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6. Press Enter to continue.

The computer begins to restore the files from the SystemSave 
partition. When User Restore is complete, the system 
automatically restarts.

Creating a QuickRestore Emergency 
Diskette
Note: Be sure to have a blank, formatted, 3½-inch diskette available.

1. From the Windows desktop, double-click the Compaq 
Support icon.

2. Click the QuickRestore icon. The QuickRestore main menu 
is displayed.

3. Move your cursor over the Make Emergency Diskette icon. 
If you see a message that says no removable media device 
was found, call Compaq Technical Support at the telephone 
number listed on your warranty documentation. Otherwise, 
proceed to the next step.

4. Click the Continue button.

5. When a message is displayed asking if you want to create a 
QuickRestore Emergency Diskette, click Yes.

6. You are prompted to have a formatted, blank diskette ready. 
Click OK.

7. When you are prompted, insert the diskette into the diskette 
drive and click OK.

8. When you are prompted that your recovery diskette has been 
successfully created, click OK.

9. When QuickRestore is finished creating the Emergency 
Diskette, remove the diskette from the drive and store it in a 
safe place for emergency use.

IMPORTANT: Label your diskette “Compaq Emergency Diskette” so that it is easy to 
locate during a system emergency.
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QuickRestore
(Continued)
Factory Restore returns 
your computer to its 
original, factory-installed 
software configuration. 
This option reformats your 
hard drive and removes all 
data from your computer.
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Factory Restore

�Caution:  Factory Restore deletes all of the information and data stored on 
your computer’s hard drive. All added personal files, software, and other 
data will be lost. Before completing Factory Restore, copy your data to 
diskettes or save your data to an external device to prevent permanent loss 
of your data.

1. From the Windows desktop, double-click the Compaq 
Support icon.

2. Click the QuickRestore icon. The QuickRestore main menu 
is displayed.

3. Move your cursor over the Factory Restore button.

Note: If no factory image is found on the D: drive, use the QuickRestore CDs 
to perform this function. Otherwise, proceed to the next step.

4. Click the Continue button.

5. When a message is displayed asking if you want to replace 
all the programs on your hard drive with the original 
Compaq factory software, click Yes to continue.

�Caution:  In the next step, if you have not copied or backed up your 
personal files, software, or other data onto a separate data storage device 
to be recopied onto your hard drive, they will be lost after you press Enter.

6. Press Enter to continue.

When Factory Restore is finished, the system automatically 
restarts.

7. After Factory Restore is complete, you may be prompted to 
provide the startup information again to reinstall Windows. 
Follow the prompts to restore your computer to its original 
factory condition.
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Compaq Remote Support

Using Compaq Remote Support
1. Call the Compaq Customer 

Support number for your 
region. The number is listed 
in the Certificate of 
Warranty that came with 
your computer.

2. The service representative 
will ask you to click the
Help G button on the 
keyboard.

3. Click the Compaq Remote 
Support ¿ icon. 

4. Click OK. The message, 
“Compaq Remote Support is 
waiting for a call” is displayed. 
The Compaq support technician 
is dialing into your computer.

5. Do not answer the telephone 
when it rings. Compaq Remote 
Support will connect with your 
computer on the second ring. If 
for any reason you need to exit 
the application, click Cancel.

6. Once a connection has been 
established, the Compaq Legal 
Disclaimer window is 
displayed. After reading the 
terms and conditions, click 
Agree to allow the support 
technician to diagnose your 
computer remotely.

 

 

 
l 
Compaq 
Remote 
Support
Compaq Remote Support 
allows you to use the 
computer modem to 
connect directly to a 
support technician. 

A Compaq technician can 
diagnose and resolve most 
of your computer problems
remotely. You can watch 
your monitor and 
communicate directly with
the service technician on 
the telephone while the 
technician is solving your 
problem.

If for any reason the 
support technician cannot 
connect to your computer, 
you will receive an error 
message notifying you of 
the failed connection. If this
happens, the technician wil
call you back. You should 
answer the telephone to 
speak with the technician.
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Diagnosing Symptoms
1. Press the Help G button on the keyboard to access Compaq 

Support tools.

2. Click the Compaq Diagnostics % icon. A series of icons is 
displayed at the top of the window.

3. Click an icon to view information about the component 
being tested. Refer to the following table for descriptions of 
the tabs.

Tab Description

Overview Contains information about your computer

Test Selects the devices you want tested

Status Shows progress of tests and faults detected

Log Shows a record of all device tests and detailed 
results

Error Reports details of errors detected

 

 

 

Compaq Diagnostics 
provides an easy way to 
perform system checks and
diagnose problems. 

A progress bar is displayed
on the Windows desktop 
while the application 
analyzes your computer for
information about its 
components.

After approximately one 
minute, a Summary 
window with the 
component information is 
displayed.
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Taking Inventory of Your Software
1. Press the Help G button on the keyboard to access Compaq 

Support tools.

2. Double-click the Compaq Support Ì icon.

3. Double-click the System Record ¬ icon.

The System Record tab displays the Base.log, which displays 
all the devices that came with your computer, and the 
Now.log, which displays all the devices you have added or 
changed. The changes you have made to your computer are 
highlighted in red. For example, if your computer came with 
64 megabytes (Mb) of memory and you upgrade it to 96 Mb 
of memory, your Base.log displays 64 Mb of memory and the 
Now.log displays 96 Mb. The memory line in the Base.log and 
the memory line in the Now.log are noted in red lettering, 
indicating that a change has been made to the original amount 
of memory in your computer.
System Record reports all 
the devices that came with 
your computer and all the 
devices you have added or 
changed since you 
purchased your computer. 
System Record highlights 
these changes in red. This 
feature allows you to 
isolate and diagnose 
possible problems with 
your computer.
PREVENTIVE MAINTENANCE   9-19



9-20 PREVENTIVE MAINTENANCE
Compaq Service Connection

Turning Compaq Service Connection 
On and Off

Turning On 

1. Double-click the Compaq 
Support Ì icon on the 
Windows desktop.

2. Double-click the Service 
Connection D icon.

The Compaq Service 
Connection will remain active, 
ready to perform updates when you log onto the Internet.

Turning Off 

1. Right-click the Service Connection D icon on the 
Windows taskbar.

2. Select Shutdown Compaq Service Connection.

Note: If you are actively using your modem when the Compaq Service 
Connection software initiates an update, the software waits until the 
modem is idle before downloading any information. You will not be 
interrupted while using your Web browser or e-mail programs.

 
Compaq Service
Connection
The Compaq Service 
Connection software 
installed on your computer 
is an innovative way of 
preventing computer 
problems. The service 
automatically sends you 
free, secure software 
updates that will keep your 
computer in peak operating 
condition. You decide when 
to install the updates.

A small notice, displayed as 
a rotating D, appears on 
the bottom-right corner of 
the Windows desktop when 
an update is available. 

If the Service Connection 
D icon is visible on the 
Windows taskbar, the 
service is already active.

The Compaq Service 
Connection software 
operates in the background 
while you are performing 
other tasks on your 
computer. You will only be 
aware that it is working 
when a notice is displayed.
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Displaying Notice Updates
1. Double-click the Notice (rotating D) to reveal the update 

identification.

2. Install, postpone, or delete the download by clicking the 
appropriate button.

➜ If you ignore the Notice, it will disappear after a minute or 
two. However, the update will be available for you to 
download at any time during the next 10 days.

➜ If you do not download the update within 10 days, it will 
be canceled automatically.

Displaying Downloaded Notices
1. Double-click the Compaq Support Ì icon on the 

Windows desktop.

2. Double-click the Service Connection D icon. A list of 
updates is displayed in the window. The updates that have 
not yet been accepted are highlighted in bold.
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Privacy and Data Security 
Compaq Service Connection is committed to providing you 
with beneficial software updates and information. To provide 
you with these services, non-personal information limited to 
your computer model number, serial number, and software ID 
files is communicated to the Compaq server. Files sent to your 
computer are protected by a personalized security number, 
similar to a Personal Identification Number (PIN), to ensure 
that you receive the correct information.

If you wish to cancel updates from Compaq Service 
Connection, you can turn it off at any time.
Compaq Service 
Connection does not 
access, share, or send any 
personal information, files, 
or data on your computer 
over the Internet.
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Installing 
New 
Components

Your Compaq Internet PC is easily u
with an Easy Access panel to allow 
components. This chapter provides i
most hardware components and shou
to the instructions that came with yo

Note: If you would like to replace the system
please contact the Compaq Product Informa
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the components, read the Warning and Ca
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 board or microprocessor, 
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Internal
Components

Your Computer is 
constructed with an Easy 
Access panel. This design 
makes accessing the 
internal parts easy.

Failure to disconnect the 
computer from the power 
source may result in personal 
injury.

�Caution: Before working with 
the components inside the 
computer, you must ground 
yourself and the equipment to 
prevent static electricity from 
damaging the parts. To 
discharge any static buildup, 
you should touch a metal part 
of the computer chassis 
before touching any internal 
parts.

The screw securing the Easy 
Access panel does not need to 
be replaced. It is used for 
shipping purposes only.

Warning

Did you know ...
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Internal Components

Accessing Internal Computer Components

1. Press the Power button to 
turn off the computer. 

2. Disconnect the power cable 
from the wall and 
computer.

3. Remove the screw 
securing the Easy Access 
panel. 

4. Locate the latch directly 
below the screw, pull 
down, and hold in the 
down position.

5. Grab the handle and slide 
the Easy Access panel from 
the chassis.

6. Turn the computer on its 
side, with the open side 
facing up.
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Upgrading 
Components

The CD-ROM, CD-RW, 
and DVD-ROM drives are 
often called optical drives 
because they use light to 
read and write information 
to a Compact Disc (CD) or 
Digital Versatile Disc 
(DVD). 

Your CD-ROM drive reads 
data from a CD. CDs are a 
popular choice for software 
and data distribution due to 
the combination of large 
storage capacity and high 
quality performance. 

The CD-RW drive uses 
advanced technology to 
write and rewrite to 
compact disc(s). CD-RW 
drives are capable of 
writing multiple formats, 
such as saving data or video 
and audio files.

The DVD-ROM drive 
allows you to listen to 
music or watch movies.

You do not have to place the 
lock in the up position after 
replacing the new drive(s).

Did you know ...
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Upgrading Components

Upgrading the CD-ROM, CD-RW,
and DVD-ROM Drives

1. Complete the “Accessing 
Internal Computer 
Components” procedure.

2. Locate the drive door lock 
inside the chassis.

3. Rotate the lock to the down 
position to unlock the upper 
front panel door.

4. Press the indention located 
on the lower front panel to 
open the lower door. 
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The upper front panel door is 
designed with finger holes to 
make opening the door easy.

The drive data cable has a 
color pull-tab to help you 
identify the cable.

The drive rails snap on and off 
the drive(s). Save the drive 
rails that came with your 
computer. They will be used 
on your new drive(s).

Tip

Tip

Tip

1
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5. Grasp under the bottom of 
the upper front panel door, 
lift up, and gently remove 
from the hooks.

6. Press both sides of the drive 
rails and pull the empty drive 
bay from the front of the computer.

7. Remove the rails from the empty 
drive bay and attach them to the 
new drive by connecting them to 
the industry standard holes located 
on each side.

8. Slide the drive into the empty 
drive bay.

9. Connect the data cable to the 
new drive.

0. Connect the audio and 
power cables to the new 
drive.
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This procedure shows you 
how to determine the 
amount of memory 
currently loaded on your 
Internet PC.
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Determining the Amount of Memory

1. From the Windows taskbar, click the Start button, point to 
Settings, and then click Control Panel. The Control Panel 
window is displayed.

2. Double-click the System m icon. The System Properties 
window is displayed.

3. Click the General tab. The amount of memory displayed 
may not include the amount of memory automatically 
allocated for video display functions.
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Memory is the workspace 
for your computer. Data 
and instructions are stored 
temporarily in memory. 
The most powerful 
processor and the fastest 
hard drive will not perform 
well without the work room 
to keep the program and 
data close at hand.

There are several different 
types of memory modules. 
Your computer uses 
Synchronous Dynamic 
Access Memory 
(SDRAM).

If a blank screen is displayed 
after replacing the memory 
module, the memory is 
incorrectly installed. Repeat 
the procedure to ensure that 
the memory module is 
properly positioned.

It is advisable to upgrade 
memory modules of identical 
type and speed to match what 
was originally installed in 
your computer.

Did you know ...

Tip
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Upgrading Computer Memory

1. Complete the “Accessing Internal Computer Components” 
procedure.

2. Pull outward on the release latches found on both ends of the 
memory slot.

3. Align the memory module with the memory slot 1 on the 
system board.

4. Push the module carefully and firmly into the slot, ensuring 
that the latches 2 on both ends snap into place.

Note: Press gently to ensure that the memory module is properly 
positioned.
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Adding 
Components

This procedure shows you 
how to determine the size 
of your hard drive and how 
much space is still free.

You should check the amount 
of free space on your hard 
drive before downloading or 
installing software programs. 
If you do not have enough free 
space, you will receive an 
error message and the 
program will not be loaded 
onto your computer.

Did you know ...
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Adding Components

Identifying Your Hard Drive Size

1. Double-click the My 
Computer g icon on the 
Windows desktop. The My 
Computer window is 
displayed.

2. Right-click the Hard Drive 
q icon (drive C).

3. Select Properties from the 
pop-up menu. The 
Properties window is 
displayed. The size of the 
hard drive and the amount of 
free space remaining are found 
on the General tab.

Note: Your hard drive may be partitioned into two drives, the 
C drive and the D drive. These two drives make up your total hard drive 
capacity. Your D drive contains important operating system backup files 
and diagnostics.
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The hard drive is used to 
store information 
permanently inside your 
computer. Before adding an 
additional hard drive, back 
up the important data files 
of your original hard drive 
for safekeeping.

Save the screw securing the 
hard drive for your 
replacement hard drive.

The hard drive data cable has 
a color pull-tab to help you 
identify the cable.

Tip

Did you know ...
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Adding an Additional Hard Drive

1. Complete the “Accessing Internal Computer Components” 
procedure.

2. Install the optional drive inside the bracket and replace the 
screw that secures the hard drive to the bracket.

3. Mount the hard drive bracket tabs into the hooks on the 
original hard drive bracket.
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4. Insert the screw and secure the optional hard drive bracket to 
the chassis base.

�Caution:  Dropping the hard drive might damage the read/write 
head, which can cause damage to the head or loss of data.
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5. Connect the hard drive data cable 1 and power cable 2 to 
the new hard drive.
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Adding an Expansion or Option Card

Note: Some Presarios come with AGP slots for graphics card options only.

1. Complete the “Accessing Internal Computer Components” 
procedure.

2. Align the card with the connector on the system board 1 and 
rear connector slot 2 on the chassis. 

3. Insert the card carefully and firmly into the slot.

4. Place the slot screw into the chassis slot to secure the 
expansion card to the chassis.

 
 
 

 

 

An expansion card is a 
circuit board that fits into a
computer expansion slot to
add a particular function: a
modem, sound or audio 
card, Network Interface 
Card (NIC), or Small 
Computer System Interface
(SCSI) adapter.

This topic shows you how 
to upgrade expansion and 
option cards in your 
computer. 

The type and number of 
expansion slots may vary by 
model.

Be sure the expansion card is
properly positioned into the 
rear connector slot on the 
chassis.

Did you know ...

Tip
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Replacing the MyStyle Accent Kit

Removing the Front MyStyle Accent Panels

1. Complete the “Accessing Internal Computer Components” 
procedure, but do not turn the computer on its side.

2. Locate the lock on the inside 
front of your computer and 
move it to the unlocked 
position.

3. Push in on the indentation at 
the top of the lower bezel 
(CD storage door) to release 
the latch and open the door.

4. While the lower bezel is 
open, put your fingers in the 
finger holes under the upper 
bezel (marked with arrows 
on the computer). Then pull 
the upper bezel toward you 
to remove it.

 

 
 

Replacing the 
MyStyle Accent
Kit

You can personalize your 
Presario by replacing the 
front bezel with your 
favorite color! Purchase a 
MyStyle Accent Kit at your
local retailer or on the Web
at:

www.compaq.com

The MyStyle Accent Kit 
includes a front bezel for 
your PC, an Internet 
Keyboard plate, and 
speaker grills.
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5. To remove the lower bezel, 
make sure it is in the open 
position 1 and push in on the 
tabs (marked with arrows on 
the computer) with your 
thumbs. Then push the base 
of the bezel in and pull it 
straight up to release it from 
the hinge 2.

Replacing the Front MyStyle Accent Panels

1. Slide the tabs on the top of the 
upper bezel into the slots at 
the top of the computer and 
snap the bezel into place.

2. Slide the hinged base of the 
lower bezel (CD storage door) 
into the slots on the computer 
and snap the lower bezel 
down into place 1.

3. Close the CD storage 
door 2.
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Replacing the MyStyle Accent Keyboard 
Plate

1. Locate the finger holes on the 
back of the keyboard and 
gently pull up on the plate to 
remove it.

2. To replace the plate, slide the 
tabbed portion of the plate 
into the slot on top of the 
keyboard and snap the plate 
into place.

Replacing the MyStyle Accent Speaker 
Grills

1. Place your fingers over the 
top of the speaker grill and 
pull the grill outward.

2. To replace the speaker grill, 
align the pins on the speaker 
grill with the slots on the 
speaker and snap the grill into 
place.
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Installing Additional Software

When selecting software for your computer, read the packaging 
to verify that it is compatible with your version of the Microsoft 
Windows operating system and the specifications of your 
Internet PC.

Note: If the software documentation contains installation instructions, use 
those instructions. If not, you can complete the following steps for installing 
software from a CD or a diskette.

Software can be installed from a CD or a diskette, or it can be 
downloaded from a Web site. Many software CDs automatically 
begin the installation process when placed in the CD drive. If 
you have a software CD that does not automatically begin the 
installation process, you can install the software by using the 
Microsoft Windows Add/Remove Programs utility.

Installing Software from a CD or Diskette

1. Close all open programs.

2. From the Windows taskbar, click the Start button, point to 
Settings, and then click Control Panel. The Control Panel 
window is displayed.

3. Double-click the Add/Remove Programs ¤ icon. The 
Add/Remove Programs Properties window is displayed. 

4. Click the Install button.

5. Insert the CD or diskette into 
the proper drive and click the 
Next button. The computer 
will find the CD or diskette 
and begin the installation 
process.

 
 

Installing 
Additional 
Software

After using your computer 
and exploring the 
preinstalled software, you 
may want to purchase and 
install additional software.

This procedure shows you 
how to install software 
from a diskette or from a 
CD that does not 
automatically install.

It is advisable that you 
determine the size of your 
hard drive and the amount of 
free space remaining before 
you download or install 
software. Refer to the 
“Identifying Your Hard Drive
Size” topic in this chapter for
details.

Tip
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Installing a Program File Downloaded 
from the Web

1. Before you start downloading, note the location on the hard 
drive where the files will be stored. Also, be sure that you 
have enough disk space available. See the “Identifying Your 
Hard Drive Size” topic in this chapter for information on 
checking your hard drive space.

2. After the download is complete, terminate your Internet 
connection. 

3. Close all other open programs.

4. From the Windows taskbar, click the Start button, point to 
Settings, and then click Control Panel. The Control Panel 
window is displayed.

5. Double-click the 
Add/Remove Programs ¤ 
icon. The Add/Remove 
Programs Properties 
window is displayed.

6. Click the Install button. The 
Install Program wizard is 
displayed. 

7. Click the Next button. The 
Run Installation Program 
window is displayed. 

8. Click the Browse buttton. 
The Browse dialog box is 
displayed.

9. Locate and select the 
Setup.exe or Install.exe file 
for the downloaded 
software.

10. Click the Open button to 
begin the installation process.

 

 

 
, 

 

If you choose to download
software from a Web site, 
follow the installation 
instructions included on the
Web page. If installation 
instructions are not 
available, follow this 
procedure.

If you want to save a program
downloaded from the Internet
you must install the program 
file(s) on your hard drive.

Before downloading files of 
any kind from the Internet, 
make sure that call-waiting is
disabled and that your 
anti-virus utility is running.

If the download process is 
interrupted, you must restart 
the procedure from the 
beginning.

Did you know ...

Tip

Did you know ...
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Reinstalling Deleted Drivers

If a driver is accidentally deleted or the Windows operating 
system is reinstalled, the driver subdirectory allows you to 
restore individual drivers rather than restore all the original 
software. The drivers you can restore are Audio, Video, Display, 
Modem, and CD-ROM.

Note: The QuickRestore CD does not include the drivers specific to the 
software that you purchased.

Drivers may be reinstalled by selecting the Selective Restore 
option from QuickRestore on your hard drive. Refer to the 
“Quick Restore” section in this guide for details.
Drivers are programs that 
enable the Windows 
operating system to 
recognize and operate 
devices installed in or 
attached to your computer.
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Need Some 
Help?

This chapter provides information for
common problems that may occur wit
contacting a technician, you can easily
computer problems on your own.
11

 identifying and fixing 
h your computer. Without 
 diagnose and fix many 
In This Chapter

Helpful Hints,   11-2

Troubleshooting,   11-3
NEED SOME HELP?   11-1



Helpful Hints

For Compaq.NET technical 
support, dial (toll free) 
1-800-952-3513.

For Compaq.NET customer 
support, dial (toll free)
1-800-952-3512.

To avoid long-distance 
charges when connecting to 
the Internet, always use a 
local area telephone number.

For additional 
troubleshooting information 
related to your printer or 
monitor, see the 
documentation that came with 
your equipment.

Did you know ...

See also ...
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Helpful Hints

If you encounter problems with your computer, monitor, or 
software, review the following check list before taking further 
action:

➜ Check that the computer and monitor are plugged into a 
working electrical outlet.

➜ Check to see that the computer is turned on and the power 
light ∏ located on the front of the computer is on.

➜ Check to see that the monitor is turned on and the power 
light ∏ on the front of the monitor is on.

➜ Turn up the brightness and contrast controls of the monitor 
if the screen is dim.

➜ Check all cable connections for loose or incorrect 
connections.

➜ Remove the diskette from the diskette drive before turning 
on your computer.

➜ Run Windows Diagnostics to determine and repair minor 
problems.

Entering BIOS (CMOS) Setup

To enter the BIOS setup: As the computer powers on, press the 
F10 key while the cursor is displayed in the upper right corner 
of the screen with the word COMPAQ displayed in red on a 
black background (before Windows starts).

.

Contacting Technical Support

If you are unable to fix your computer after reviewing this 
chapter and checking the Compaq Web site, contact Technical 
Support at the number listed in your Certificate of Warranty.
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Troubleshooting

If a solution does not fix 
your problem, try all the 
other solutions for the 
symptom, or try the 
solution a second time.

Symptom

No sound.

Sound is too low.
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Troubleshooting

Information in this section is divided into three areas: Symptom, 
Problem, and Solution. 

The Symptom line describes the symptom or warning for the 
type of problem you are having. The Problem column identifies 
one or more reasons why the symptom has occurred. And the 
Solution column describes what you should do to try to fix the 
problem. 

Note: Some of the symptoms listed for certain problems will not apply to 
your computer. For specific problems relating to the monitor or printer, refer 
to the documentation that came with the equipment.

Audio 

Problem Solution

Speaker cables are 
not properly 
connected.

Shut down your computer using the normal 
shutdown procedure. Reconnect the speakers. 
Refer to the Quick Setup poster for instructions.

Volume has been 
muted.

On the Windows taskbar, click the Volume ÷ icon 
and clear the Mute check box.

Computer is in Sleep 
mode. You can tell 
that your computer 
is in Sleep mode 
when the Power 
Status light on the 
front of your 
computer is not lit.

See Waking Your Computer in the chapter “Using 
Your Computer” in this guide.

Powered speakers 
are not being used.

Use powered speakers.

Volume has been set 
too low.

Click the Volume ÷ icon on the Windows taskbar, 
click the Volume slider bar, and then drag it up. Or 
press the Volume Up button on your Compaq 
Internet keyboard.
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Sound is distorted.

Audio recordings from digital 
camera sound are distorted.

Volume ÷ icon is missing 
from Windows taskbar.

Audio CD or DVD does not play.

Symptom
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Volume is too high. 1. Click the Volume ÷ icon on the Windows 
taskbar. 

2. Click the Volume slider bar and drag it down. 
Or press the Volume Down button on your 
Compaq Internet keyboard.

Speakers may be 
damaged.

Call Compaq Technical Support. Refer to your 
Certificate of Warranty for details.

DVD is not set up 
properly.

Change settings in the DVDeck program:
1. From the Windows taskbar, click the Start 

button, point to Programs, then DVDeck, and 
then click DVDeck. The DVDeck dialog box is 
displayed.

2. Click the Options tab.
3. Click the AVI Interleave Options button.

In the Interleave Factor area, change the default 
setting to 4:1.

4. Click OK to apply the new settings.

Multimedia settings 
have been changed.

1. From the Windows taskbar, click Start, point to 
Settings, and then click Control Panel. The 
Control Panel window is displayed.

2. Double-click the Multimedia icon. The 
Multimedia dialog box is displayed.

3. Select the Show volume control on taskbar 
option.

4. Click OK to apply the new setting.

See CD or DVD topics in this section.

Problem Solution
   MY PRESARIO—LEARNING MORE



Symptom

CD-ROM, CD-RW, or DVD-ROM 
drive cannot read a disc or 
takes too long to start.

Recording audio CDs is difficult 
or impossible.
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CD-ROM, CD-RW, or DVD-ROM

Problem Solution

CD has been inserted 
upside down.

Reinsert the CD with the label facing up.

The DVD-ROM drive 
will take longer to start 
because it has to 
determine the type of 
media being played, 
such as audio or video.

Wait at least 30 seconds to let the DVD-ROM 
drive determine the type of media being played. 
If the disc still does not start, read the other 
solutions listed in this topic.

CD or DVD disc is dirty. Clean CD or DVD with a CD cleaning kit, which is 
available in most computer stores.

Windows does not 
detect CD or DVD 
driver.

1. From the Windows taskbar, click Start, point 
to Settings, and then click Control Panel. 
The Control Panel window is displayed.

2. Double-click the System m icon. The System 
Properties dialog box is displayed.

3. Click the Device Manager tab.
4. Click the plus sign ’ next to the CD or DVD 

drive, and select the installed driver. 
5. Click the Remove button, and click OK twice.
6. Restart your computer, and let Windows 

detect the CD or DVD driver.

Wrong or poor quality 
media type.

Verify that you are using the correct media for 
the drive.
Try a different brand of media. Quality varies 
widely between manufacturers.
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Symptom

Not reading drive: “Abort, 
Retry, Fail?” message appears.

“Non-system disk or disk 
error” message is displayed.
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Diskette Drive and Zip Drive

Problem Solution

A non-formatted 
diskette has been 
inserted.

To format the diskette:
1. Double-click the My Computer g icon on 

the Windows desktop.
2. Select the diskette (A) drive.
3. Click File, and point to Format.
4. Select desired options, and click Start to 

begin formatting the diskette.

Diskette is damaged. Replace the diskette with a new one.

A diskette that does 
not contain system 
files needed to start 
your computer has 
been inserted in drive.

When drive activity stops, remove the diskette 
and press the Spacebar. The computer should 
start up.

Disk error has 
occurred.

Restart your computer by pressing the 
Start/Reset button. If the error returns, see the 
next problem “System files have been 
damaged.”

System files have been 
damaged.

1. Insert a start-up disk in the diskette drive.
2. Restart your computer.
3. At the A:> prompt, type SYS C: and press the 

Enter key. The following message is 
displayed: SYSTEM TRANSFERRED. This task 
will restore the system files to the hard drive. 

4. Restart your computer.

Hard drive has failed. Call Compaq Technical Support. Refer to your 
Certificate of Warranty for details.
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Diskette drive light stays on.

Diskette drive cannot save 
information to diskette.

Diskette drive cannot read a 
diskette.

Symptom
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Diskette has been 
improperly inserted.

Remove the diskette and reinsert it as follows: 
Insert the edge with the sliding cover into the 
drive, face up, and push all the way in until the 
diskette stops.

Diskette is damaged. Remove the diskette and insert a new diskette. If 
the problem persists, run the Windows 
Maintenance Wizard to repair the drive:
1. From the Windows taskbar, click the Start 

button, point to Programs, then 
Accessories, then System Tools, and then 
click Maintenance Wizard. The Maintenance 
Wizard is displayed.

2. Select the Perform maintenance now 
option.

3. Click OK.

Diskette is not 
formatted.

To format the diskette:
1. Double-click the My Computer g icon on 

the Windows desktop.
2. Select the diskette (A) drive. 
3. Click File, and point to Format.
4. Select the desired options, and click Start to 

begin formatting the diskette.

Diskette is 
write-protected.

Slide the write-protection tab to the unlocked 
position on the diskette.

Diskette is full or file is 
too big.

Use another diskette or compress the file to 
reduce the size.

File save command not 
properly executed.

When saving information to the diskette drive, 
verify that you are using the correct drive letter.

Diskette is damaged. Replace the damaged diskette.

Diskette drive has 
failed.

Call Compaq Technical Support. Refer to your 
Certificate of Warranty for details.

Diskette is not 
formatted.

To format the diskette:
1. Double-click the My Computer g icon on 

the Windows desktop.
2. Select the diskette (A) drive.
3. Click File, and point to Format.
4. Select the desired options, and click Start to 

begin formatting the diskette.

Problem Solution
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Zip drive (available on select 
models) cannot read a disk.

Zip drive (available on select 
models) indicator light 
continuously blinks.

Symptom

Screen is blank, and monitor 
power light is not lit.

Screen is blank.

Symptom
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Display (Monitor) 

The wrong diskette 
type is being used.

Check the type of drive you have and use the 
correct diskette type.

Diskette drive has 
failed.

Call Compaq Technical Support. Refer to your 
Certificate of Warranty for details.

Windows does not 
detect Zip driver.

Reinstall the driver for your Zip drive.

Wrong disk is being 
used.

Verify that the disk is a Zip disk and that it is 
compatible with your Zip drive.

Windows is not 
enabled. 

Zip drive cannot be used in DOS mode.

Zip disk is not inserted 
properly.

Push the Disk Eject button to remove disk, and 
then reinsert.

Problem Solution

Monitor power cable is 
not connected to 
monitor or wall outlet.

Reconnect the power plug on back of monitor 
and at wall outlet.

Monitor is not turned 
on.

Press the Power button on the front of the 
monitor.

Monitor connector 
cable is not properly 
connected to back of 
computer.

Inspect the monitor video connector for bent 
pins. If there are no bent pins, reconnect the 
monitor connector cable at the back of your 
computer.

Screen saver is 
enabled.

Press any key or move mouse to make screen 
display visible again.

Computer is in Sleep 
mode, as shown on 
the keyboard LED 
panel. 

See Waking Your Computer in the “Using Your 
Computer” chapter in this guide.

If you have a flat-panel 
monitor (available on 
select models), you 
may need a Digital 
Video Interface and 
connector. 

Refer to your Certificate of Warranty for details.

Problem Solution
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Display fills only part of the 
screen.

Display is too faint.

Resolution cannot be adjusted 
to desired setting.

Symptom
MY PRESARIO—LEARNING MORE
If you are using a 
flat-panel monitor 
(available on select 
models), your 
resolution settings are 
not set properly.

1. On the Windows taskbar, click Start, point to 
Settings, and then click Control Panel. The 
Control Panel window is displayed.

2. Double-click the Display & icon. The Display 
Properties dialog box is displayed.

3. Click the Settings tab.
4. Click the resolution slider for the Screen and 

drag it to the right. Repeat this step for the 
Desktop resolution slider. Increase the 
resolutions to the maximum allowable.

5. Click OK to accept the new settings.

Brightness and 
contrast controls are 
not set properly.

Adjust the brightness and contrast controls on 
your monitor.

Windows does not 
detect display driver.

1. On the Windows taskbar, click Start, point to 
Settings, and then click Control Panel. The 
Control Panel window is displayed.

2. Double-click the System g icon. The 
System Properties dialog box is displayed.

3. Click the Device Manager tab.
4. Click the ’ next to Display Adapters and 

select the installed display adapter.
5. Click the Remove button, and click OK.
6. Restart your computer, and let Windows 

detect the display driver.

Problem Solution
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Symptom

Computer seems to be locked 
up.

Hard drive error message is 
displayed.

Hard drive fault protection error 
message is displayed.
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Hard Drive 

Problem Solution

Program in use has 
stopped responding to 
commands.

Attempt a normal Windows shutdown. If this 
fails, press the Reset button for four or more 
seconds to turn off the power. To restart your 
computer, press the Reset button again.

Part of the hard drive 
has failed.

Run the Windows Maintenance Wizard to repair 
the drive:
1. From the Windows taskbar, click the Start 

button, point to Programs, then 
Accessories, then System Tools, and then 
click Maintenance Wizard. The 
Maintenance Wizard is displayed.

2. Select the Perform maintenance now 
option.

3. Click OK.

Part of hard drive is 
about to fail or could 
already have failed.

Call Compaq Technical Support. Refer to your 
Certificate of Warranty for details.
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Symptom

Cannot connect to the Internet.

Cannot automatically launch 
Internet programs.

Internet takes too long to 
download Web sites.
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Internet Access 

Problem Solution

Internet Service 
Provider (ISP) account 
is not set up properly.

Verify Internet settings or contact your ISP for 
assistance.

Modem is not set up 
properly.

Reconnect the modem, verifying the following 
connections: telephone line to telephone (for 
external phone sets), and telephone line to wall 
jack (from computer to wall). 

Web browser is not set 
up properly.

Verify that the Web browser is installed and set 
up to work with your ISP.

You must log in to your 
ISP before some 
programs will start. 

Log in to your ISP and launch the desired 
program.

Modem is not set up 
properly.

Verify that correct modem speed and COM port 
are selected:
1. From the Windows taskbar, click Start, point 

to Settings, and then click Control Panel. 
The Control Panel window is displayed.

2. Double-click Modems. Windows detects the 
modem(s) you have installed.

3. Click the Properties button. An identification 
window is displayed.

4. Verify that the correct modem port is set and 
the maximum speed of your modem is 
selected. Reset these settings if necessary.

5. Click OK to close the identification window.
6. Click Close to close the Modems Properties 

window.
7. Click The Close P button in the upper right 

corner of the Control Panel window to return 
to the Windows desktop.
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Symptom

Keyboard commands and 
typing are not recognized by 
computer.

Mouse does not respond to 
movement or is too slow.

Mouse will only move vertically 
or horizontally.
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Keyboard and Scroll Mouse 

Problem Solution

Keyboard connector is 
not properly 
connected. 

1. From the Windows taskbar, click the Start 
button, and then click Shut Down... The Shut 
Down Windows dialog box is displayed.

2. Select the Shut down option.
3. Click OK.
4. After the shutdown is complete, reconnect 

the keyboard to the back of your computer 
and restart your computer.

Program in use has 
stopped responding to 
commands.

Shut down your computer using the mouse. 
Refer to the problem below, “Mouse connector is 
not properly connected.”

Keyboard needs repair. Refer to your Certificate of Warranty for details.

Mouse connector is 
not properly 
connected. 

Shut down your computer using the keyboard: 
1. Press the Ctrl and Esc keys at the same time 

to display the Start menu.
2. Use the up or down arrow key to select Shut 

Down..., and then press the Enter key. 
3. Select the Shut down option. You may need 

to use the up or down arrow key.
4. Press the Enter key to select OK.
5. After the shutdown is complete, reconnect 

the mouse connector on the back of your 
computer (or the keyboard) and restart your 
computer.

Mouse roller ball is 
dirty. 

Remove roller ball cover from bottom of mouse 
and clean with mouse cleaning kit available from 
most computer stores.

Program in use has 
stopped responding to 
commands.

Shut down your computer using the keyboard. 
Refer to the preceding problem “Mouse 
connector is not properly connected” for details 
on how to shut down using the keyboard. 

Mouse needs repair. Replace mouse. See your Certificate of Warranty 
for details.
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Memory 

Problem Solution

All memory in 
computer is being 
used by open 
programs, and 
memory is needed for 
desired task.

To avoid Windows automatically running 
unnecessary programs at startup:
1. Click the Start button on the Windows 

taskbar.
2. Select Run. The Run dialog box is displayed.
3. In the Open box, type MSCONFIG.
4. Click OK. The System Configuration Utility 

dialog box is displayed.
5. Click the Startup tab, and clear the check 

box(es) for any unnecessary programs.
6. Close one or more programs, and restart 

Windows to recover memory. 
Symptom

Insufficient memory message 
is displayed.
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Power 

Problem Solution

Line voltage selection 
switch is not in the 
proper position for 
your region (115V/
230V).

Set the line voltage selection switch to the 
correct setting for your region, or call Compaq 
Technical Support for assistance. Refer to your 
Certificate of Warranty for details.

Wall outlet is bad. Test the outlet by connecting a different 
electrical device to outlet.

Software being used is 
not Microsoft-certified 
for your version of 
Windows.

Verify that the software is certified by Microsoft 
for your version of Windows (see program 
packaging for this information).

Configuration files are 
corrupt.

If possible, save all data, close all programs, and 
restart your computer. If the error message 
returns, you may need to back up your data files 
and use the QuickRestore utility.

� Caution:  QuickRestore reformats your 
hard drive; all data files will be lost.

System files may have 
been damaged. You 
will need to insert a 
start-up disk or 
Windows Start-Up disk 
to restart your 
computer. 

1. Insert a start-up disk in the diskette drive.
2. Restart your computer. 
3. At the A:> prompt, type SYS C: and press the 

Enter key. The following message will be 
displayed: SYSTEM TRANSFERRED. This task 
will restore the system files to your hard 
drive. 

4. Restart your computer.
If this task does not restart your computer, call 
Compaq Technical Support. Refer to your 
Certificate of Warranty for details.

Wrong memory 
modules were used in 
upgrade, or memory 
modules were installed 
in the wrong location.

Verify the accuracy of memory modules 
installation by calling Compaq Technical 
Support. Refer to your Certificate of Warranty for 
details.

Hard drive has been 
damaged.

Call Compaq Technical Support. Refer to your 
Certificate of Warranty for details.
Symptom

Computer will not turn on.

“Illegal Operation has 
Occurred” error message is 
displayed.

Computer will not start.
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A diskette has been 
inserted in drive that 
does not contain the 
system files necessary 
to start your computer.

When drive activity stops, remove the diskette 
and press the spacebar. Your computer will start 
up.

Disk error has 
occurred.

Restart your computer by pressing the Start/
Reset button. If the error returns, see the next 
problem “System files have been damaged.”

System files have been 
damaged.

1. Insert a start-up disk in the diskette drive.
2. Restart your computer. 
3. At the A:\ prompt, type SYS C: and press the 

Enter key. The following message will be 
displayed: SYSTEM TRANSFERRED. This task 
will restore the system files to your hard 
drive. 

4. Restart your computer.

Hard drive has failed. Call Compaq Technical Support. Refer to your 
Certificate of Warranty for details.

Problem Solution
“Non-system disk or disk 
error” message is displayed.

Symptom
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Printer 

Problems Solutions

Printer cartridge is out 
of black ink.

Replace the printer cartridge.

� Caution:  Do not attempt to install a 
printer cartridge by moving the printer 
carriage manually.

1. From the Windows taskbar, click the Start 
button, point to Programs, and then click the 
printer model you have installed on your 
computer.

2. Select Printer Control.
3. Select the Cartridges tab.
4. In the Cartridge pull-down menu, choose the 

cartridge you want to install.
5. In the Action pull-down menu, select the 

action you want.
6. Click Install/Reinstall Cartridge. The 

cartridge carriage moves to the loading 
position in the middle of the printer. 

7. Lift the printer access door.
8. Remove the old cartridge, if necessary, and 

install the new cartridge.
9. Close the printer access door.

10. Click Continue.

The print cartridge may 
be out of ink.

Replace the cartridge by following the directions 
in the previous problem, “Printer cartridge is out 
of black ink.”

Print cartridge nozzle 
may be blocked.

Be sure the tape covering the nozzle of the print 
cartridge has been removed.
Symptom

Printer prints in colors other 
than black.

Printer seems to be printing, 
but no characters appear on 
the paper.
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Drivers are improperly 
installed.

Uninstall and reinstall the printer drivers:
1. From the Windows taskbar, click the Start 

button, click Programs, point to your printer 
model, and then click Uninstall Drivers.

2. Follow the instructions on the screen. The 
program will uninstall your printer drivers.

3. To reinstall the printer drivers, insert the 
Printer Driver CD that came with your printer 
into the CD-ROM drive. On some systems the 
installation program automatically runs so 
that you can follow the instructions on the 
screen. To run the setup program manually, 
complete the following steps:

4. From the Windows taskbar, click the Start 
button, point to Programs, and then click 
Windows Explorer.

5. Select the CD-ROM drive that contains the 
printer driver CD.

6. Double-click the file Setup.exe to run the 
setup program.

7. Follow the instructions on the screen.

Problems Solutions
Poor print quality.

Symptom
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Cartridge may be 
running out of ink.

Replace the cartridge by following the directions 
in the “Printer cartridge is out of black ink” 
problem at the first of this section.

Cartridge nozzles may 
need cleaning.

1. From the Windows taskbar, click the Start 
button, point to Programs, and then click the 
printer model you have installed on your 
computer.

2. Select Printer Control.
3. Click the Cartridges tab.
4. Select Clean Print Nozzles. The cleaning 

pattern prints.
5. Follow the test instructions on the screen to 

obtain satisfactory print quality. You may 
need to run the test as many as three times.

6. If the print quality is not satisfactory, reinstall 
the print cartridge and rerun the test. 

7. If the quality is still unsatisfactory, wipe the 
print cartridge nozzles.

Cartridge needs to be 
aligned.

1. From the Windows taskbar, click the Start 
button, point to Programs, and then click the 
printer model you have installed on your 
computer.

2. Select Printer Control.
3. Select the Cartridges tab.
4. Click the Align Cartridges button. The 

cartridge alignment page prints. Follow the 
instructions on the screen to test and correct 
the alignment of your print cartridge.

5. Click OK.

Problems Solutions
Symptom
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Fax Modem 

Problems Solutions

Fax modem is not 
connected properly. 

Reconnect the fax modem, verifying the 
following connections: telephone line to 
telephone (for external phone sets) and 
telephone line to wall jack (from computer 
to wall). 

Ten-digit phone 
number is not properly 
entered or number 
being dialed is not a 
fax number.

Verify whether mandatory area code is included 
in number being dialed and correct fax number 
is being dialed.

Computer or fax 
machine is turned off, 
or third-party program 
is closed.

Some third-party fax software can receive faxes 
only when the program is open.

Fax modem has failed. Call Compaq Technical Support. Refer to your 
Certificate of Warranty for details.
Symptom

Cannot send or receive faxes.

Connection has failed.
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Line connection 
failure.

Redial the fax number to resend the fax.

Call-waiting enabled 
on line.

Refer to third-party software for instructions on 
how to disable call waiting, or contact your local 
telephone company.

Third-party fax 
software does not 
detect the fax modem 
driver.

Verify that correct fax modem speed and COM 
port are selected:
1. From the Windows taskbar, click Start, point 

to Settings, and then click Control Panel. 
The Control Panel window is displayed. 

2. Double-click Modems. Windows detects the 
modem you have installed. 

3. Click the Properties button. An identification 
window is displayed.

4. Verify that the correct modem port is set and 
the maximum speed of your modem is 
selected. Reset these if necessary.

5. Click OK to close the identification window. 
6. Click close to close the Modems Properties 

window.
7. Click the Close P button in the upper right 

corner of the Control Panel window to return 
to the Windows desktop.

Third-party fax 
software is conflicting 
with another program.

Close all programs except the fax software, and 
redial the fax number.

The receiver for 
another telephone on 
the same line was 
picked up.

Verify that all telephone handsets on the same 
line are on their bases.

Fax machine where 
call is being placed 
has run out of paper.

Call location where the fax is being sent and ask 
if the fax machine has paper.

Computer needs 
repair.

Call Compaq Technical Support. Refer to your 
Certificate of Warranty for details.

Problems Solutions
Fax starts to send but stops 
before the transmission is 
complete.

Symptom
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Games

Problems Solutions

Minimum hardware or 
software requirements 
set by game 
manufacturer have not 
been met.

Review the game documentation or packaging 
for minimum requirements.

Game was not set up 
properly when 
installed.

Reinstall the program, noting any settings and 
default selections that pertain to your computer, 
and restart the game.

Incorrect version of 
game.

Contact game manufacturer for updated version 
of game.
Symptom

Game crashes frequently.

Graphics are distorted or 
screen goes blank during 
game’s introduction. 
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This chapter includes special notices
to Compaq products. Some are speci
Please read the chapter contents that 

Government 
Approvals 
12

 and regulations that apply 
fic to individual countries. 
affect your location.
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12-12
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Regulations
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Notices and Regulations

Federal Communications Commission 
Notice

This equipment has been tested and found to comply with the 
limits for a Class B digital device pursuant to Part 15 of the 
FCC Rules. These limits are designed to provide reasonable 
protection against harmful interference in a residential 
installation. This equipment generates, uses, and can radiate 
radio frequency energy and, if not installed and used in 
accordance with the instructions, may cause harmful 
interference to radio communications. However, there is no 
guarantee that interference will not occur in a particular 
installation. If this equipment does cause harmful interference 
to radio or television reception (which can be determined by 
turning the equipment off and on), the user is encouraged to try 
to correct the interference by taking one or more of the 
following measures:

➜ Reorient or relocate the receiving antenna.

➜ Increase the separation between the equipment and the 
receiver.

➜ Connect the equipment and the receiver to outlets that are on 
different circuits.

➜ Consult the dealer or an experienced radio or television 
technician for help.
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Modifications

The FCC requires the user to be notified that any changes or 
modifications made to this device that are not expressly 
approved by Compaq Computer Corporation may void the 
user's authority to operate the equipment.

This device complies with Part 15 of the FCC Rules. Operation 
is subject to the following two conditions: (1) this device may 
not cause harmful interference, and (2) this device must accept 
any interference received, including interference that may cause 
undesired operation.

For questions regarding your product, call 800-652-6672 
(800-OK-COMPAQ) or contact:

Compaq Computer Corporation
P.O. Box 692000, Mail Stop 530113

Houston, Texas 77269-2000

For questions regarding this FCC declaration, call 281-514-
3333 or contact:

Compaq Computer Corporation
P.O. Box 692000, Mail Stop 510101

Houston, Texas 77269-2000

To identify this product, refer to the Part, Series, or Model 
number found on the product.
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Canadian Notice

This Class B digital apparatus meets all requirements of the 
Canadian Interference-Causing Equipment Regulations.
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European Notice

Equipment with CE marking complies with the EMC Directive 
(89/336/EEC) and the Low Voltage Directive (73/23/EEC) 
issued by the European Community, and if this product has 
telecommunication functionality, the R&TTE Directive
(1999/5/EC).

Compliance with these directives implies conformity to the 
following European Norms or Regulations (in parentheses are 
the equivalent international standards and regulations):

➜ EN 55022 (CISPR 22) – Electromagnetic Interference

➜ EN 50082-1 (IEC 802-2. IEC 801-3, IEC 802-4) –
Electromagnetic Immunity

➜ EN 60950 (IEC 60950) – Product Safety
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Telecom Network Approvals

The following two icons and associated statements may be 
found on desktop and mini-tower computers. They are intended 
to communicate how to access the telecommunications 
regulatory approval information for your product. 

As an alternative to viewing the approval information on your 
product, country approval information may also be found on the 
Compaq Web site. To view this approval information, visit 
www.compaq.com and perform a site search for the words, 
“telecom network approvals.” If a selection is available for your 
product, you may view and print the approval information.
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U.S. Regulations Governing the Use of Modems

This equipment complies with Part 68 of the FCC rules. 
Located on the bottom of the portable computers and on the 
modem in desktop computers is a label that contains, among 
other information, the FCC Registration Number and Ringer 
Equivalence Number (REN) for this equipment. Upon request, 
you must provide this information to your telephone company.

Ringer Equivalence Number (REN)

The REN is useful to determine the quantity of devices you may 
connect to your telephone line and still have all the devices ring 
when your telephone number is called. In most (but not all) 
areas, the sum of the RENs of all devices connected to one line 
should not exceed five (5.0). To find out the number of devices 
you may connect to your telephone line as determined by the 
REN, you should contact your local telephone company to 
determine the maximum REN for your calling area.

The REN for the modem contained in this product does not 
exceed 1.0.

An FCC Compliant 6-position modular plug is provided with 
this equipment. This equipment is designed to be connected to 
the telephone network or premises wiring using a compatible 
6-position modular jack that is FCC Part 68 Compliant.

If your telephone equipment causes harm to the telephone 
network, the telephone company may discontinue your service 
temporarily. If possible, they will notify you in advance. 
However, if advance notice is not practical, you will be notified 
as soon as possible. You will also be informed of your right to 
file a complaint with the FCC.

Your telephone company may make changes in its facilities, 
equipment, operations, or procedures that could affect the 
proper functioning of your equipment. If they do, you will be 
notified in advance to give you an opportunity to maintain 
uninterrupted telephone service.
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If you experience trouble with this telephone equipment, 
contact your local telephone company for information about 
obtaining service or repairs. Your telephone company may ask 
that you disconnect this equipment from the network until the 
problem has been corrected, or until you are sure that the 
equipment is not malfunctioning.

This equipment may not be used on coin service provided by 
the telephone company. Connection to party lines is subject to 
state tariffs.

For the Compaq Customer Support Center and your nearest 
Compaq Technical Support in North America, call 
800-345-1518 or write:

Compaq Customer Support Center
P.O. Box 692000

Houston, Texas 77269-2000
 MY PRESARIO—LEARNING MORE



Telephone 
Consumer 
Protection Act 
of 1991
MY PRESARIO—LEARNING MORE
Telephone Consumer Protection Act of 1991

The Telephone Consumer Protection Act of 1991 makes it 
unlawful for any person to use a computer or other electronic 
device to send any message via a telephone facsimile machine 
unless such message clearly contains, in a margin at the top or 
bottom of each transmitted page, or on the first page of the 
transmission, the date and time it is sent and an identification of 
the business, entity, or individual sending the message and the 
telephone number of the sending machine or such business, 
entity, or individual.
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Canadian Regulations Governing the Use of Modems

Notice: The Industry Canada label identifies certified 
equipment. This certification means that the equipment meets 
certain telecommunications network protective, operational, 
and safety requirements. The department does not guarantee 
that the equipment will operate to the user’s satisfaction.

Before installing the equipment, users should ensure that it is 
permissible to connect to the facilities of the local 
telecommunications company. The equipment must also be 
installed using an acceptable method of connection. In some 
cases, the company’s inside wiring associated with a single-line 
individual service may be extended by means of a certified 
connector assembly (telephone extension cord). The customer 
should be aware that compliance with the above conditions may 
not prevent degradation of service in some situations.

Repairs to certified equipment should be made by an authorized 
Canadian maintenance facility designated by the supplier. Any 
repairs or alterations made by the user to this equipment, or 
equipment malfunctions, may cause the telecommunications 
company to request the user to disconnect the equipment.

For their own protection, users should ensure that the electrical 
ground connections of the power utility, telephone lines, and 
internal metallic water pipe system, if present, are connected 
together. This precaution may be particularly important in rural 
areas.

Notice: The Ringer Equivalence Number (REN) assigned to 
each terminal device provides an indication of the maximum 
number of terminals allowed to be connected to a telephone 
interface. The termination on an interface may consist of any 
combination of devices, subject only to the requirement that the 
sum of the Ringer Equivalence Numbers of all the devices does 
not exceed five (5).
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The REN for the modem contained in this product does not 
exceed 1.0.

For the location of the authorized Canadian maintenance 
facility nearest you, call 800-652-6672 (800-OK-COMPAQ).

Compaq Canada, Inc.
45 Vogell Road

Richmond Hill, Ontario L4B 3P6
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Modem 
Statements

Your computer is provided 
with a battery-powered, 
real-time clock circuit. 
Danger of explosion and risk 
of personal injury exists if the 
battery is incorrectly replaced 
or mistreated. Do not attempt 
to recharge the battery, 
disassemble it, remove it, 
immerse it in water, or dispose 
of it in fire.

Some studies have suggested 
that long periods of typing, 
improper workstation setup, 
incorrect work habits, or 
problems in your personal 
health may be linked to 
discomfort or serious injuries. 
Refer to your Safety & 
Comfort Guide for more 
information about choosing a 
workspace and creating a 
comfortable work 
environment.

Warning

Warning
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Modem Statements

Safety

Safety is important when you are operating your computer. 
Follow the guidelines in this section to enjoy your computing 
experience.

Batteries

For information about real-time clock battery replacement, 
contact your Compaq Authorized Dealer, reseller, or service 
provider.

This computer may contain a lithium-ion or nickel-metal-hydride 
battery pack. There is a risk of fire and chemical burn if the battery 
pack is handled improperly. Do not disassemble, crunch, puncture, or 
short external contacts, dispose of in water or fire, or expose to 
temperatures higher than 140°F (60°C).

�Caution:  Do not dispose of batteries with general household waste. 
To dispose of them or recycle them, use the public collection system 
in accordance with local regulations or return them to Compaq, an 
authorized Compaq Partner, or the point-of-sale. In North America, 
dispose of nickel-metal-hydride or lithium-ion batteries by taking 
advantage of the Compaq battery recycling program. You will be 
provided with a postage-paid battery pack mailer pre-addressed to 
a reclamation facility where the metals are recycled.

Only authorized technicians trained by Compaq should attempt to 
repair this equipment. All troubleshooting and repair procedures are 
detailed to allow only subassembly/module-level repair. Because of 
the complexity of the individual boards and subassemblies, no one 
should attempt to make repairs at the component level or to make 
modifications to any printed wiring board. Improper repairs can 
create a safety hazard.

Warning

Warning
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Using the Computer

A very small portion of the population may experience epileptic 
seizures when viewing certain kinds of flashing lights or patterns that 
are commonly present in our daily environment. These persons may 
experience seizures while watching some kinds of television pictures 
or playing certain games, including games played on the Internet PC. 
Players who have not had any previous seizures may nonetheless have 
an undetected epileptic condition. Consult your physician if you 
experience any of the following symptoms while playing games: 
altered vision, muscle twitching, other involuntary movements, loss of 
awareness of your surroundings, mental confusion, or convulsions.

Warning
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Energy Compliance

Agency labels are on the computer.

Energy Star Compliance 

Compaq Internet PC products marked with the Energy Star 
Logo L are compliant with Energy Star Computers Program 
2.0 standard of the U.S. Environmental Protection Agency 
(EPA). The EPA Energy Star Logo does not imply endorsement 
by the EPA. As an Energy Star Partner, Compaq Computer 
Corporation has determined that products marked with the 
Energy Star Logo meet the Energy Star guidelines for energy 
efficiency.

The Energy Star Computers Program was created by the EPA to 
promote energy efficiency and reduce air pollution through 
more energy-efficient equipment in homes, offices, and 
factories. Compaq products achieve this standard by reducing 
power consumption when not being used. Instructions for using 
the energy saving features of your computer are located in the 
power management section of the documentation that came 
with your computer.

The power management feature of your computer is supported 
when used with the following operating system: Microsoft 
Windows Operating System.

L
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The power management feature, when used in conjunction with 
an external Energy Star compliant monitor, will support the 
power-down features of the monitor. The power management 
feature allows an external monitor to go into low-power mode 
when the screen saver timeout occurs. To take advantage of 
these energy savings, the monitor’s power management feature 
has been preset to power down the monitor after a period of 
system inactivity. Refer to the Saving Energy section of the 
documentation that came with your computer for instructions 
on modifying or disabling this feature.

�Caution:  Using the Energy Save Monitor feature with non-Energy 
Star compliant monitors may cause video distortion when the 
screen saver timeout occurs.

�Caution:  The power management feature is not compatible with 
some non-Compaq bus-mastering ISA devices. Using the power 
management feature with some of these devices may cause errors 
when the system is placed in the low power state. 
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This Glossary defines commonly used terms to help new users understand computer 
concepts. 

Glossary
1394 port A new type of connector for 
plugging in peripherals with extremely fast 
data-transfer rates, such as video cameras. 
The 1394 standard synchronizes audio and 
video files by delivering data at the 
intended rate—in real time. See 
peripheral. See also USB port.

A
Acrobat Reader Software created by 

Adobe Systems that can be downloaded 
free of charge from the Adobe Web site 
(www.Adobe.com). The Acrobat Reader 
allows you to view an electronic document 
with the exact layout (font, colors, and 
graphics) that the author intended. 
Regardless of the program the author used 
to create the document, every computer 
with the Acrobat Reader installed can 
display the document with the same layout 
once the file is converted to PDF format. 
(To view an ordinary e-mail attachment in 
its original format, your computer must 
have the same program, the same or later 
version of the program, and the same fonts 

as the author used.) To save printing and 
postage costs, companies, professional 
organizations, and clubs distribute 
newsletters to employees and members 
over the Internet. With the Acrobat Reader, 
you can view and print the newsletter in its 
original format. See PDF. See also font.

anti-virus utility A program that detects, 
and in many case repairs, the damage 
caused by a computer virus. See virus. See 
also utility.

application A technical term for a 
computer program. See program.

audio/video streaming See streaming.

authoring What you do to create a 
program that may eventually be stored on a 
CD. For example, if you want to create a 
multimedia game or presentation, you need 
authoring software that allows you to
combine sound, graphics, and text with 
user interactivity. When you finish creating 
your program with the authoring software, 
use Easy CD Creator to record it on CD.
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B
back up To copy files in case the original 

files are lost or damaged. Backup copies 
can be stored on the hard drive or on a 
diskette, Zip disk, or CD-R disc. Regular 
backups of all data files on removable 
storage media are recommended in case of 
hard drive failure.

bit The smallest possible piece of 
computer information—a single digit 
(either a 1 or a 0). See digital.

bitmap Defines a display space and the 
color of each pixel or bit in the display 
space. A GIF and a JPEG are examples of 
graphic image file types that contain 
bitmaps.

boot To start or restart the computer. 
During the start-up process, information 
necessary for the computer to operate is 
loaded into memory. See main memory.

browser Software that searches for, 
displays, and downloads text, graphics, 
sound, and video from the Internet. 
Microsoft Internet Explorer and Netscape 
Navigator are two popular browsers.

buffer A temporary storage area in 
memory. It acts as a holding area where 
data with different transfer rates can be 
collected, then sent as a steady stream to 
the device that processes data for 
permanent storage. In CD recorders, the 
buffer helps to prevent buffer underruns.

buffer underrun  The inability of your 
computer to keep up the steady stream of 
data required for CD recording. The CD 
recorder has an internal memory buffer to 
protect against interruptions and 
slowdowns; however, if the interruption is 
so long that the buffer is completely 
emptied, a buffer underrun occurs, writing 
stops, and the CD can be damaged beyond 
repair.

bug A mistake in the design of computer 
software. Because of their complexity, 
designs may have minor bugs. As soon as 
the manufacturer becomes aware of the 
problem, modifications are made to correct 
it. These modifications, called fixes or 
patches, can be downloaded from the 
manufacturer’s Web site. If a major bug is 
discovered, the manufacturer releases a 
new version of the software. Visit the 
Compaq Web site (www.compaq.com) 
from time to time for the latest information 
about your computer, including software 
updates that you can download. And visit 
the manufacturer’s Web site for any 
software or peripherals that you purchase 
for your computer. See peripheral. 

bulletin board An electronic notice board 
on the Internet where people can post 
notices for others with similar interests. 
Professional organizations and clubs often 
have bulletin boards for members to share 
information and opinions.
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byte Eight bits of data strung together to 
make a message that the computer can 
interpret. Most information is organized 
into bytes, the standard unit of data. One 
byte of data is required to represent a 
single character that you can see on the 
screen (a letter, number, punctuation mark, 
or other symbol). For example, the byte 
01001000 represents the capital letter H. 
See bit.

C
cable modem A modem that allows you 

to access the Internet through your cable 
service provider. Continuously connected 
to the Internet, it allows high-speed, 
high-capacity data transfer.

CD (compact disc)  Media used in a CD 
player (digital recordings of music) or 
CD-ROM drive (computer data, such as 
programs). Both types of compact disc are 
read-only; once data is recorded or written 
to them, they can only be played or read.

CD-DA  Compact disc-digital audio. 
Jointly developed by Philips and Sony and 
launched in October, 1982, CD-DA was 
the first incarnation of the compact disc, 
used to digitally record and play back 
music. The standard under which CD-DA 
discs are recorded is known as the Red 
Book.

CD Extra, CD Plus, or Enhanced CD
A multisession CD containing a number of 
audio tracks in the first session, and one 
CD-ROM XA data track in the second 
session. Additional characteristics are 
defined in the Blue Book standard. An 
alternative to mixed-mode for combining 
standard CD-DA audio, which can be 
played in a normal audio player, and a 
computer application on a single CD.

CD-I A compact disc format developed by 
Philips, designed to allow interactive 
multimedia applications to be run on a 
player attached to a television. The 
standard document defining CD-I is called 
the Green Book.

CD-R (CD-recordable) Media used in a 
CD-R drive to record or write data that 
cannot be erased. The base is a circular 
piece of clear plastic, molded with a spiral 
track to ensure that the CD-R drive follows 
the same spiral path as that stamped on a 
conventional CD. The plastic layer is 
covered first with an organic dye that is 
photosensitive, then a reflective layer of 
silver alloy or 24-carat gold, and finally 
lacquer to protect the metal from air and 
dust. Depending on the dye and metal used 
in manufacture, the disc may be gold/gold 
(gold on top and bottom), green/gold, 
silver/blue, or silver/silver. When referring 
to CD media, “CD-R” is often used to refer 
to write-once CDs in contrast to CD-RW. 
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CD-R drive A drive that uses a low-power 
laser to burn pits into the dye layer of a 
CD-R, where digital data is written. The 
marks are permanent. When the finalized 
disc is played or read, the metal layer 
reflects laser light in much the same way 
as the aluminum layer in a music CD or 
CD-ROM. For this reason, the write-once 
CD-R can be read by most of the newer 
CD players, CD-ROM, and DVD-ROM 
drives. 

CD-ROM (CD read-only media) Media 
used in a CD-ROM drive. The data is read-
only; you cannot erase or record over it. 
The disc has three layers. The base is a 
circular piece of clear plastic, 
mechanically stamped with tiny 
indentations, or pits, in which digital data 
is written. The plastic layer is covered with 
a sheet of shiny aluminum to reflect laser 
light. And the aluminum is coated with 
lacquer to protect it from air and dust. 
Specifications for the CD-ROM were first 
defined in the Yellow Book. 

CD-ROM drive A drive that reads a 
CD-ROM (or music CD) by shining a laser 
into the clear plastic base and interpreting 
the way the laser light is reflected by the 
shiny aluminum layer. The CD-ROM drive 
is read-only; it cannot write to a disc. Most 
modern drives can also read a CD-R 
(unless written in multi-sessions by a 
CD-RW drive). Only the newest 
multi-session CD-ROM drives can read a 
CD-RW written in multi-sessions. 

CD-ROM XA “XA” stands for Extended 
Architecture. CD-ROM XA is an 
extension of the Yellow Book standard, 
generally consistent with the ISO 9660 
logical format but designed to add better 
audio and video capabilities taken from the 
CD-I standard so that CD-ROM could 
more easily be used for multimedia 
applications. CD-ROM XA was 
abandoned as an independent multimedia 
format, but Photo CDs are written in the 
CD-ROM XA physical format.

CD-RW (CD-rewritable) Media used in a 
CD-RW drive to record data that can be 
overwritten thousands of times. The clear 
plastic base is molded with a spiral track to 
ensure that the CD-RW drive follows the 
same spiral path as the one stamped on a 
conventional CD. The middle (recording) 
layer is a phase-change crystalline mixture. 
Sandwiched between two layers that draw 
away excess heat during the writing 
process, the phase-change layer gives the 
disc a metallic grey color. The media can 
be used for single-session or multi-session 
writing (recording different tracks on 
different occasions). Advanced 
multi-session technology is not 
backward-compatible. Only multi-read 
capable CD-ROM and newer DVD-ROM 
drives can read CD-RWs written in 
multi-sessions. Because of the lower 
reflectivity of the phase-change recording 
layer, older CD players and CD-ROM 
drives cannot read CD-RWs, even when 
written in a single session. CD-RW 
technology is improving, but the quality of 
recordings is not yet comparable to CD-R 
recordings. 
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CD-RW drive  A drive with three laser 
powers that can write to a CD-RW, erase 
the data, or read the data. A high-power 
laser melts the crystalline recording layer. 
It cools quickly, sets without forming 
crystals, and absorbs the laser beam. Data 
is written in pits that form as the 
noncrystalline material shrinks. A 
medium-power laser erases the data. It 
melts the recording layer at a lower 
temperature for a longer period of time. As 
the phase-change material cools, crystals 
form that reflect the laser beam. The 
high-power laser can then overwrite the 
crystalline material. A low-power laser, 
which does not alter the state of the 
recording layer, reads the data. A CD-RW 
drive can read CD-ROMs, CD-Rs, and 
CD-RWs. It can write to both CD-Rs and 
CD-RWs.

CD Text An audio CD format in which up 
to 5000 characters of CD information 
(title, artist, and song titles) are written into 
the Table of Contents of the CDs. The 
information is displayed when the CD is 
played back on CD Text-enabled players.

chat An Internet feature that allows you to 
exchange typed messages with another 
person (or group of people) in real time. A 
message you type instantly displays on the 
other person’s computer. 

click (left-click) To press and quickly 
release the left mouse button to select an 
item.

close disc To “close” a recordable disc so 
that no further data can be written to it. 
This is done when the last session’s lead-in 
is written. The next writable address on the 
CD is not recorded in the lead-in, so that 
the CD-Recorder in subsequent attempts to 
write has no way of knowing where to 
begin writing. Note: It is not necessary to 
close a CD to read it in a normal CD-ROM 
drive.

close session When a session is closed, 
information about its contents is written 
into the Table of Contents of the CDs, and 
a lead-in and lead-out are written to 
prepare the CD for subsequent sessions.

coaster Popular term for a ruined 
recordable CD, named after the round 
object you rest your drinking glass on to 
avoid marking the table.

Ctrl+Alt+Delete Pressing and holding 
down the Ctrl key, then the Alt key, then 
the Delete key, and then releasing all three 
keys to close a program that is locked (not 
responding). Note: Unsaved data is lost. 
Use Ctrl+Alt+Delete a second time to 
shut down and restart a computer that is 
locked. Unsaved data is erased from 
memory. When the computer restarts, it 
displays an error message that Windows 
was not properly shut down and it scans 
the hard drive for errors. Before installing 
new software, close all open programs. 
Then use Ctrl+Alt+Delete to close all 
programs, one by one, that run in the 
background—except Windows Explorer 
and Systray. These two programs are 
needed for the installation. If you 
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accidentally close Windows Explorer or 
Systray, shut down the computer. Restart 
the computer and close the programs 
again. Insert the installation CD (or 
diskette), and follow the manufacturer’s 
instructions. Closing all programs, 
including those running in the background, 
ensures a clean installation without file 
conflicts.

component a device installed inside the 
computer. Examples are the CD-ROM, 
CD-R, CD-RW, DVD-ROM, Zip, diskette, 
and hard drives, memory chips, modem, 
graphics cards, and sound cards. See 
peripheral.

cursor The blinking vertical line on the 
screen that indicates where the next 
character appears when you type.

D
data Information that can be processed by 

a computer. See digital.

data file Files that you create with a 
computer program. Most programs are 
designed to process a specific type of data. 
For example, spreadsheet programs allow 
you to create data files primarily with 
numbers; word processing programs 
primarily with letters; page design 
programs, with text and graphics; drawing 
programs, with lines; photo manipulation 
programs, with photos and drawings; and 
music programs, with sounds.

database A collection of related data that 
is designed to retrieve useful information 
easily.

dedicated line A telephone line that is 
always connected to the modem (inside the 
computer) to provide constant access to the 
Internet. A separate telephone line is used 
for phone calls. See modem.

default The option that the program 
automatically chooses for you when you 
do not indicate a choice yourself. For 
example, when you print a document, the 
Print dialog box asks which pages to print 
(the default is All) and how many copies to 
print (the default is 1). You can change the 
settings, and you can designate the new 
settings as the default.

desktop See Windows desktop.

desktop computer A personal computer 
designed to be placed on a desk. It is not 
portable as is a laptop or notebook 
computer.

dialog box A small window that requests 
information from the user before a 
command can be carried out digitally.

digital A system that uses electronic 
signals to transfer data in the form of bits. 
A bit is represented by a single digit. 
Computers use only two digits—either a 0 
or a 1—in various combinations. See bit 
and byte. 
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digital audio extraction The process of 
copying CD-DA audio tracks digitally, 
from your CD-Recorder or CD-ROM drive 
to a hard drive or to a recordable CD. Not 
all CD-ROM drives support this, but most 
CD-Recorders do.

disc-at-once A method of writing CDs in 
which one or more tracks are written in a 
single operation, and the CD is closed 
without ever turning off the writing laser. 
Contrast with track-at-once. Not all 
CD-Recorders support disc-at-once.

disc image A single large file which is an 
exact representation of the whole set of 
data and programs as it will appear on a 
CD in terms of both content and logical 
format. This may be an ISO 9660 image or 
some proprietary format such as the .cif 
format used by Easy CD Creator.

discussion group A group discussion 
held on the Internet on a topic of mutual 
interest. Instead of meeting in a classroom, 
students may meet for group discussions 
on the Internet. 

directory See folder.

disk High-capacity storage media, such as 
the hard drive inside the computer and the 
removable media used in a Zip or Jaz 
drive.

diskette Low-capacity, removable storage 
media made of flexible plastic film 
encased in a hard plastic shell. Since the 
plastic film is flexible, the 3.5-inch 
diskette is sometimes referred to as a 
floppy disk. 

diskette drive The drive that reads and 
writes to a diskette.

double-click To push down and quickly 
release the left mouse button twice in rapid 
succession to open an item.

download To receive files from another 
computer on the Internet.

drive A device that reads and sometimes 
writes to storage media. Examples are 
CD-ROM, CD-R, CD-RW, DVD-ROM, 
Zip, diskette, and hard drives.

driver Software that enables the operating 
system (OS) to recognize and operate 
devices installed in or attached to the 
computer, such as a printer. All drives that 
use removable media and all peripheral 
devices have drivers. You can download 
updated drivers from the manufacturer’s 
Web site. See drive and peripheral. See 
also OS.

drop-down menu A list of options that 
drops down when you click a menu name 
on the menu bar or click the down arrow 
on a dialog box.

DSL (digital subscriber line)  
A telephone line that carries both voice 
and data signals, allowing you to talk on 
the phone and surf the Internet at the same 
time. The data part of the line, which is 
continuously connected to the Internet, 
allows high-speed, high-capacity data 
transfer. Your local telephone company 
provides the necessary equipment—a DSL 
modem, a network interface card, (NIC) 
and a splitter. See NIC.
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DSL modem A modem that connects to 
the Internet using digital subscriber line 
service through an existing copper 
telephone line. 

DVD-ROM (DVD read-only media)
A CD-sized disc that stores full-length 
movies, music videos, and multimedia 
computer games with three-dimensional 
graphics. Both single-sided and 
double-sided discs are available.

DVD-ROM drive A drive that reads DVDs. 
Backward-compatible with CD 
technology, it also reads old music CDs, 
CD-ROMs, CD-Rs, and CD-RWs.

E
e-mail (electronic mail) Messages sent 

over the Internet.

encrypt To translate data into a secret 
code. You must have access to a secret key 
or password to read an encrypted file. See 
secure Web site.

Explorer See Microsoft Internet Explorer 
and Windows Explorer.

F
fax modem A modem that allows your 

computer to transmit and receive faxes. It 
can transmit documents to fax machines 
and other computers with fax modems. It 
can broadcast a fax to several sites at once.

file extension A dot and three letters after 
a file name that indicate the program in 

which the file was created. For example, 
filename.doc. The file extension .doc 
indicates that the file was created in 
Microsoft Word.

floppy disk An older term for diskette. 
See diskette.

folder Represented by an icon that looks 
like a yellow manila folder, a computer 
folder contains other folders (subfolders) 
and files. Both MS-DOS and early 
versions of Microsoft Windows used the 
term directory (and subdirectories) for 
folder (and subfolders).

font A complete set of letters, numbers, 
punctuation marks, and symbols in a 
particular typeface. When you use a word 
processing program, you can choose from 
a long list of fonts to give your document 
personality. Typefaces can suggest 
masculinity, femininity, strength, delicacy, 
formality, frivolity, friendliness, warmth, 
coldness, classical tradition, or 
contemporary trends. Matching the 
personality of the typeface with the content 
of the text is a challenge for desktop 
publishers.

G
game port A connector on the back of the 

computer for plugging in a gamepad, 
joystick, or steering wheel. See joystick.

gap The gap (more correctly called a 
pause) is a space dividing tracks on a CD. 
In some situations, a gap is required by 
standards such as the Red Book. For 
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example, if you have data and audio tracks 
within the same session, they must be 
separated by a gap. Also, there must be a 
gap of two to three seconds preceding the 
first track on a CD.

GIF (pronounced giff). A file format for 
graphics displayed on the Internet. These 
are easily identified by the file extension 
.gif. You can save a GIF file from a Web 
site to your computer. Point to the image 
with the cursor and right click. A shortcut 
menu is displayed. Select Save Picture 
As… The Save As dialog box appears. 
Select a folder, name the file, and click the 
Save button. See file extension. See also 
JPEG.

graphical interface Communication 
between a person and a computer by 
means of images. With a pointing device 
such as a mouse, you can click an icon to 
tell the computer what you want. See icon. 
See also interface.

graphics Pictures or illustrations, 
including drawings, pie charts, bar graphs, 
street maps, architectural and engineering 
designs, fashion designs, musical scores, 
cartoons, animated images, and 
photographs. A graphics card enables the 
monitor to display these items on the 
screen. See SVGA.

H
hard disk Internal media for permanent 

storage of system files, programs, utilities, 
and data files. The hard disk consists of 
flat, round platters. Each side of each 

platter has a head that floats on a thin 
cushion of air over the surface of the 
rapidly spinning disk and reads 
electronically stored data or writes data 
onto the disk. If the computer is dropped, 
a head may fall onto and dig into a platter 
and cause the hard drive to become 
unreadable.

hard drive  The drive that reads and writes 
to the hard disk. If you have a large hard 
drive, it may be divided into several 
partitions. Each partition is designated by a 
different icon and a consecutive drive 
letter, beginning with the letter C. Partition 
C: contains the files the computer uses to 
start up. The other partitions contain no 
preinstalled files.

hardware The physical components of a 
computer—the parts you can physically 
touch. See software.

HTML (hypertext markup language)
The standard language for documents 
designed for viewing on the Web with a 
browser. Tags embedded in the documents 
mark the locations of other electronic files. 
Click the hyperlinks to jump from one Web 
site to another. Documents formatted for a 
browser can be identified by the file 
extension .htm or .html. See hyperlink. See 
also file extension.

http:// (hypertext transfer protocol)
This protocol commands the Web server to 
locate the Web site you requested and 
transmit the Web site to your computer. 
You communicate a request to your 
computer by using the keyboard or mouse. 
You type the Web site address (URL) in the 
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address box of the browser or click a 
hyperlink on a Web page. Your computer 
communicates the request to the Web 
server by using hypertext transfer protocol. 
The Web server communicates the request 
to other servers and computers connected 
to the Web. Throughout the world, servers 
and computers recognize the same 
protocol. Their common language makes 
the World Wide Web possible. See URL, 
browser, hyperlink, and server. 

hyperlink An embedded link to another 
document or Web site. When you position 
the cursor over a hyperlink (colored text or 
image), a small hand S is displayed. When 
you click the hyperlink, the browser 
displays the new document or Web site. 
See HTML.

I
icon A small picture that represents a 

menu command, file, program, tool, or 
peripheral. 

interactive A computer program that 
responds to you as if you were having a 
conversation. You give instructions; the 
computer performs an action (or requests 
additional information). Computer games 
and multimedia tutorials are interactive 
programs. 

interface A means of communication 
between two entities. A person and a 
computer interface through an operating 
system (OS). Two computers interface 
through protocol. Computers on the Web 

use hypertext transfer protocol (http://). 
See OS and http://.

Internet A worldwide collection of 
computer networks that are interconnected 
so that users can share electronic 
information.

Internet Explorer See Microsoft Internet 
Explorer.

Internet keyboard A keyboard that 
resembles a typewriter keyboard but is 
equipped with special buttons programmed 
to connect to the Internet.

Internet phone A video telephone that 
allows you to make long-distance calls 
over the Internet.

ISO 9660 Format The most common 
international standard for the logical 
format for files and directories on a 
CD-ROM. Some other common logical 
formats such as Joliet and Rock Ridge are 
extensions of ISO 9660.

ISP (Internet service provider)
A company that provides access to the 
Internet. To use the service, you need the 
ISP software, a user name, a password, and 
access phone number(s).

J
jewel case The hinged plastic case in 

which CDs are often stored.

jewel case sleeve The pieces of paper that 
can be inserted into the jewel case to help 
identify the contents of the CD stored in 
the case.
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joystick A lever that moves in all 
directions to control the movement of a 
pointer or objects on the screen. It is used 
for computer games in which you drive, 
fly, or shoot objects displayed on the 
monitor.

JPEG (pronounced J-peg). A file format for 
graphics, especially photographs, 
displayed on the Internet. It is easily 
identified by the file extension .jpg. JPEG 
files, which store more information per 
pixel than GIF files, are used for complex, 
high-resolution images. See GIF. See also 
pixel.

L
lead-in An area at the beginning of each 

session on a recordable session that is left 
blank for the session’s table of contents. 
The lead-in is written when a session is 
closed, and takes up 4500 sectors, 
approximately one minute, on a CD. The 
lead-in also contains the next writable 
address on the CD so that future sessions 
can be added, unless the CD is closed.

lead-out An area at the end of a session 
which indicates that the end of data has 
been reached. The first lead-out on a CD is 
6750 sectors long. Any subsequent lead-
outs are 2250 sectors, or about 30 seconds.

link See hyperlink.

link block A block, also known as a sector, 
of digital rubbish that is written each time 
the recording laser is turned on (before) or 
off (after) writing a track or a packet. See 
also Run-in/Run-out Blocks.

linked multi-session A CD containing 
more than one session, in which all (or 
selected) data from the various sessions 
can be seen as if they had been recorded in 
a single session.

listserv See mailing list.

logical block The smallest addressable 
space on a CD. Each logical block is 
identified by a unique Logical Block 
Number (LBN), each of which is assigned 
in order starting from 0 at the beginning of 
the CD. Under the ISO 9660 standard, all 
data on a CD is addressed in terms of 
Logical Block Numbers.

logical format/logical structure/file 
system A file system, such as ISO 9660, 
that translates the sector-by-sector view of 
a CD into a virtual tree of directories and 
files. This system makes it easier for both 
people and computers to use the 
information on the CD. UDF is another 
example of a file system that can be used 
to write CDs.

log on To gain access to a computer 
network or the Internet by entering a user 
name and password. See network.
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M
mailing list An electronic mail-

forwarding service that allows subscribers 
to send e-mail to a single address where 
the message is copied and sent to all 
addresses on the list. Clubs and 
professional organizations use this service, 
sometimes called a listserv, to contact 
members quickly, cheaply, and effortlessly.

main memory RAM memory chips 
inside the computer. Every program you 
launch and every file you open must be 
copied from a storage disk, disc, or 
diskette into main memory. The amount of 
main memory in your computer determines 
how many programs you can run and how 
much data you can process at one time. 
Memory is measured in megabytes 
(1 million bytes or characters) of 
information. Most personal computers 
come with a minimum of 32 megabytes of 
main memory—the minimum 
recommendation for Windows-based 
programs. You can install extra memory 
(refer to “Upgrading Your Computer” in 
this guide). See RAM. See also byte.

mastering Technically refers to the 
process of creating a glass master from 
which CDs are reproduced in quantity. In 
desktop recordable CD systems, mastering 
is done together with premastering by the 
desktop CD-Recorder, and the term is 
generally used to mean recording.

maximize To enlarge the screen (or 
maximize the window) in a 
Windows-based program by clicking the 
Maximize button T, the button with an 
open square in the upper-right corner of a 
window that has not been maximized. See 
Microsoft Windows. See also minimize.

microprocessor A silicon chip inside your 
computer that processes the instructions 
and data from input devices (such as the 
keyboard and mouse) and communicates 
them to output devices (such as the 
monitor, speakers, and printer).

Microsoft Internet Explorer A Web 
browser developed by the Microsoft   
Corporation. See browser.

Microsoft Windows The most popular 
computer operating system in the world. It 
is characterized by the use of windows and 
icons. Each running program and open file 
has its own window. Instead of 
memorizing commands, you click icons to 
communicate with the computer. Clicking 
the Minimize button shrinks a program to 
a button on the taskbar. Clicking the button 
again redisplays the program as a window. 
You can have several windows open at the 
same time and toggle from one to another 
by using Alt+Tab (press and hold down 
the Alt key, press the Tab key, and then 
release both keys). A palette with an icon 
for each program is displayed. Click the 
icon for the program you want.
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MIDI (musical instrument digital inter-
face)  (pronounced middy). A file format 
used to store electronic music sounds. A 
sound card that supports MIDI files allows 
the computer to generate the synthesized 
musical sounds found in games, 
CD-ROMs, and multimedia presentation 
packages. The format is easily identified 
by the file extension .mid. See file 
extension. See also music software.

MIDI connector A connector on the back 
of the computer for plugging in a 
synthesizer keyboard. A MIDI connector 
allows you to record sounds created by a 
synthesizer and then manipulate the data to 
produce new sounds, such as changing the 
key of a composition. See MIDI. See also 
music software.

minimize To shrink a running program 
window into an icon on the Windows 
taskbar by clicking the Minimize Q 
button—the button with the minus sign in 
the upper-right corner of a window. Click 
the button on the taskbar to view the 
window again. See Microsoft Windows. 
See also maximize.

mixed-mode disc A CD that includes 
both computer data and CD-DA tracks. 
The data is all contained in track one, and 
the audio in one or more of the following 
tracks. Contrast with CD Extra.

modem A device in the computer that 
converts data from digital format to analog 
format so that it can be transferred through 
a standard telephone line to another 
computer. The modem in the receiving 
computer converts the data back to digital 
format. See digital.

mouse A device that you move across the 
top of your desk (or a mousepad) to move 
the pointer or cursor on the screen. Click to 
select an item, double-click to launch a 
program, and right-click to display a 
shortcut menu. See mouse pointer and 
cursor. See also click, double-click, and 
right-click.

mouse pointer The arrow on the screen 
that moves with the mouse.

MP3 The file extension for MPEG 
(pronounced M-peg), audio layer 3, sound 
files. The format is easily identified by the 
file extension .mp3. This format 
compresses sound data from a stereo music 
CD to 1/12th its original size without 
sacrificing sound quality. Because of their 
small size, MP3 files can be transferred 
over the Internet easily. You can download 
individual songs or entire CDs in MP3 
format to your computer. See file 
extension. 

MPEG Motion Picture Experts Group, a 
standards organization responsible for the 
MPEG1 and MPEG2 standards for the 
compression of full-motion video.

multimedia Two or more media formats 
used together, such as text, graphics, 
animation, audio, or video.

multiread An OSTA (Optical Storage 
Technology Association) standard for 
CD-ROM and DVD-ROM drives. Drives 
that follow the multiread standard can read 
commercial CDs (audio and data), CD-R 
discs, and CD-RW discs. They can also 
read CDs written in fixed- or 
variable-length packets.
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multi-session A method of adding data 
incrementally to a CD in more than one 
recording session. If data is linked between 
sessions, all data on a multi-session CD, 
when read on a multi-session CD-ROM 
drive, may be seen as part of a single 
logical structure. Multi-session is different 
from packet writing. See packet writing.

mutli-volume A CD containing multiple 
sessions that are not linked together. Each 
“volume” on the CD must be read as if it 
were a separate CD. You can read different 
sessions on a CD by using the Session 
Selector in Easy CD Creator Deluxe.

music software Programs for composing 
and editing music. When you play a tune 
on a synthesizer keyboard connected to a 
computer, the music program translates 
what you play into a written score. Music 
software creates MIDI files. See MIDI and 
MIDI connector.

N
navigate To move through a Web site or 

online document by clicking the 
hyperlinks. See hyperlink.

Netscape Navigator A Web browser 
developed by the Netscape 
Communications Corporation. See 
browser.

network Two or more computers linked 
together to share resources, such as 
programs, files, and printers.

newsgroup A discussion group on the 
Internet where people can post or read 

messages on thousands of topics, such as 
professional basketball, environmental 
protection, Himalayan cats, Scottish 
bagpipes, Irish clog dancing, soufflés, 
macramé, book reviews, mountain bikes, 
political candidates, and cartoon strips. 
Imagine a topic, and you can probably find 
a newsgroup that discusses it.

newsreader A program that lets you read 
and post messages to newsgroups.

news server A server that receives the 
Usenet news feed (all the individual 
messages collected from 100,000 news 
servers around the world). You access the 
news server through your Internet Service 
Provider. See Usenet. See also newsgroup.

NIC (network interface card)
A computer circuit board or card installed 
in a computer so that the computer can be 
connected to a network. Personal 
computers and workstations on local area 
networks (LANs) typically contain a 
network interface card specifically 
designed for the LAN transmission 
technology, such as Ethernet or Token 
Ring.

O
online To be communicating with another 

computer through a modem or network. 
You are online when you log on and 
establish a connection. You are offline 
when you lose or terminate a connection. 
See modem and network.
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online Help A manual that is displayed on 
the screen while you are actually working 
in a program and need help. It can be 
accessed through the Help menu at the top 
of the screen. Help for the Windows 
operating system can be accessed from the 
Start button on the taskbar.

online shopping Ordering products on 
the Internet. You can purchase books, 
flowers, music CDs, toys, groceries, 
stocks, airline tickets, and cars.

on the fly To write on the fly means to 
write directly from source data to CD data 
without first writing a disc image.

OS (operating system) The interface that 
permits a person and a computer to “talk” 
to one another. Microsoft Windows, the 
most popular operating system, displays 
icons, menus, and dialog boxes to find out 
what you want. You use a mouse and 
keyboard to reply. See Microsoft Windows. 
See also interface.

P
packet writing A method of writing data 

on a CD in small increments. Packets can 
be of fixed or variable length. Adaptec’s 
DirectCD software supports packet 
writing. Contrast with track-at-once and 
disc-at-once.

parallel port A connector on the back of 
the computer for plugging in a parallel 
cable attached to a parallel device, such as 
a printer. Data is transferred, one byte at a 
time, through eight data wires (one for 

each bit in the byte). All eight bits travel 
side by side and arrive at the same time. A 
parallel port is faster than a serial port, 
which lets data through one bit at a time. 
See byte. See also serial port.

path A sequence of information that 
directs the operating system to a file. For 
example, C:\Windows\Clouds.bmp is the 
path to a bitmap file named Clouds. It is 
located in a folder named Windows, which 
is located on the C drive.

peripheral An external device connected 
to a computer, such as a monitor, 
keyboard, mouse, joystick, scanner, 
printer, and digital camera. See component.

PDF (portable document format) A file 
format that has captured all the elements of 
a printed document as an electronic image 
that you can view, navigate, print, or 
forward to someone else. PDF files are 
created using Adobe Acrobat, Acrobat 
Capture, or similar products. To view and 
use the files, you need the free Acrobat 
Reader, which you can easily download. 
Once you have downloaded the Reader, it 
starts automatically whenever you want to 
look at a PDF file.

photo CD A CD format based on the 
CD-ROM XA and Orange Book Hybrid 
Disc specifications; it is used to store 
photographic images for display and 
printing.

physical format The physical format of a 
CD determines how data is recorded in 
each sector. The various physical formats 
are defined by the color book standards, 
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such as Red Book, Yellow Book, and 
Orange Book.

pixel (short for picture element) One of 
the individual dots that compose a 
graphical image. See graphics.

PMA (program memory area)  An area 
on a recordable CD that temporarily 
contains the table of contents information 
when tracks are written in a session that is 
not yet closed. When the session is closed, 
this same information is written in the 
session lead-in.

playlist Tracks chosen to be played from a 
CD or DVD.

plug-and-play A feature introduced with 
Windows 95 to simplify the use of some 
peripheral devices. Once the device is 
installed (in accordance with the 
manufacturer’s instructions), you can plug 
it into the computer while the computer is 
running. The operating system 
automatically recognizes the new device. 
In order to connect a non-plug-and-play 
device, you must first shut down the 
computer. See peripheral.

pop-up menu A list of options that pops 
up when you right-click an icon on the 
desktop or taskbar, the vacant part of the 
desktop, a selection in a document, or a file 
in Windows Explorer. See right-click.

premastering The process of preparing 
data to be recorded onto a CD. This 
includes dividing the data into sectors and 
recording those sectors with the 
appropriate header (address) and error 
correction information. In the case of 

recordable CD systems, premastering and 
mastering are done in one operation, 
resulting in a ready-to-read CD.

processor (short for microprocessor). The 
brains of the computer. 
See microprocessor.

product key A unique series of letters and 
numbers that are assigned to each software 
package you buy. You are asked to enter 
the product key when you install the 
software. When you register the software, 
you transmit the product key to the 
manufacturer for entry in a customer 
database. Registration activates your 
warranty. When you telephone for 
technical support, you are asked for the 
product key. The technician matches it 
against the database to determine whether 
you qualify for support. You should keep a 
record of all product keys to protect your 
investment. They are comparable to the 
serial numbers on hardware. See software. 
See also hardware.

program A set of instructions, written in a 
programming language understood by the 
computer, that tells the hardware what 
tasks to perform. Some programs are 
installed at the factory as ROM chips that 
cannot be altered; they are essential for 
operating the microprocessor. These 
programs are called firmware. Most 
programs are installed as software from 
removable storage media. The word 
“program,” however, is commonly used 
for a specific type of software: applications 
that create data files. See data files. See 
also hardware and software.
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R
RAM (random access memory) The 

main memory of the computer. It holds a 
copy of the operating system (OS), any 
programs that are running on the computer, 
and any data that is being processed. RAM 
is temporary memory; turning off the 
computer clears RAM. The more RAM 
your computer has, the faster the programs 
respond. See main memory, OS, program, 
and data file. See also ROM.

random erase The ability to erase a single 
file at a time from a CD-ReWritable CD, 
freeing up CD space for immediate re-use, 
just as you would do on a hard or floppy 
disk. (Available with CD-RW CDs and 
DirectCD).

recordable disc The media used in 
recordable CD systems. The blank CD is 
made of a bottom layer of polycarbonate, 
with a preformed track spiral, which the 
recording laser follows when inscribing 
information onto the CD. A translucent 
layer of recordable material is laid on top 
of the polycarbonate, then a reflective 
layer (gold or silver colored). On top there 
is a thin layer of lacquer and sometimes a 
printed label. The standard recordable CD 
is “write-once,” where data written to it 
cannot be erased, although it is possible to 
add data in a later session. See 
multi-session. For erasable and rewritable 
CDs, see CD-RW.

right-click To press and quickly release 
the right mouse button to display a menu 
of options. See pop-up menu.

ROM (read-only memory) Memory that 
contains the basic instructions for the 
microprocessor. ROM is permanent 
memory; turning off the computer does not 
erase it. Since you cannot change or write 
to ROM, it is referred to as read-only. See 
microprocessor. See also RAM.

Run-In/Run-Out Blocks Blocks of 
written data before and after a packet or a 
track. These blocks allow the recorder to 
synchronize with the data on the CD and to 
finish up interleaved data. Four run-in 
blocks and two run-out blocks are written 
for each packet.

S
scanner A device that creates digital 

images of printed documents and 
photographs. Optical character recognition 
(OCR) and photo manipulation programs 
allow you to save and edit the images on 
your computer. See digital.

screen saver A moving picture or pattern 
that appears on the screen when you stop 
using your computer for a specified period 
of time. Originally designed to protect the 
monitor, screen savers are now used for 
amusement. 

scroll To gradually move information 
across the screen when a document or Web 
page is too long or too wide to view all at 
once. Scroll bars are located along the right 
side and across the bottom of a window. 
When scroll arrows are present at the ends 
of the bars, you know that some 
information is off the screen. Click one of 
MY PRESARIO—LEARNING MORE    GLOSSARY  17



the arrows to scroll the information into 
view. See click.

scroll mouse A mouse with a scroll wheel 
(between the two mouse buttons) for 
automatic scrolling through long 
documents or Web pages. See scroll and 
mouse.

search engine A program, accessed on 
the Internet, that allows you to search large 
databases for information by using 
keywords or phrases. See database.

sector The smallest recordable unit on a 
CD. A CD can contain [(75 sectors per 
second) x (60 seconds per minute) x 
(number of minutes on a CD)] sectors. The 
amount of data contained in the sector 
depends on the physical format in which it 
is recorded; for “regular” CD-ROM data, 
you can fit 2048 bytes (2 kilobytes) of data 
into a sector.

secure Web site A Web site that encrypts 
data to protect it from unauthorized use. 
When you purchase items over the 
Internet, you are asked to type your name, 
mailing address, e-mail address, and credit 
card information on an electronic form. 
Sending information to a secure Web site is 
comparable to giving it over the telephone 
when you order from a catalog. (Never 
send your social security number over the 
Internet. Criminals can steal your identity 
with your social security number.) See 
encrypt.

sequential erase Erasing the entire CD so 
that it can be re-used. (Available with 
CD-RW CDs).

serial port A small connector on the back 
of the computer (or keyboard) for plugging 
in a thin cable attached to a serial device, 
such as a mouse. Serial devices transfer 
data one bit at a time through a data wire. 
The serial cable has two wires for 
bi-directional communication (sending and 
receiving information simultaneously). See 
bit. See also parallel port.

server A computer with a large hard drive 
that serves (provides information to) other 
computers connected to it on a network. In 
a local area network, several computers in 
the same room or all the computers in a 
high-rise office building may be connected 
to a server. The server stores everyone’s 
files. The Internet is the largest computer 
network in the world. It is a network of 
servers. When you send or receive e-mail, 
it travels through a series of servers to 
which both the sender’s and receiver’s 
computer are connected through a modem. 
When you enter a Web site address in the 
address box of your browser, Internet 
protocol commands the Web server to 
locate the site you requested, transmit the 
files to your computer, and display them on 
your monitor.

session As defined in the Orange Book, a 
recorded segment of a CD that may 
contain one or more tracks of any type 
(data or audio). In data recording, there is 
usually only one track per session. In audio 
recording, all audio tracks are contained in 
a single session. A lead-in and lead-out are 
recorded for every session on a CD.
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session-at-once Session-at-once is a 
subset of disc-at-once, used for CD Extra. 
In session-at-once recording, a first session 
containing multiple audio tracks is 
recorded in a single pass; the laser is then 
turned off, but the CD is not closed. A 
second (data) session is then written and 
the CD is closed.

shareware Software you can try before 
you buy. After a trial period, usually 30 
days, the program either uninstalls or 
refuses you access unless you pay for it. 
You can download shareware from the 
Internet. See software.

shortcut An icon on the Windows desktop 
that you double-click to launch a program. 
Without the shortcut, you click the Start 
button on the Windows taskbar, point to 
Programs to display a menu of programs 
installed on your computer, and click the 
one you want to launch. You can create 
shortcuts to your favorite programs. See 
icon and double-click.

shortcut menu A menu that pops up 
when you right-click an icon on the 
Windows desktop or taskbar, the vacant 
part of the desktop, a selection in a 
document, or a file in Windows Explorer. 
The options on the pop-up menu are the 
most commonly used commands that relate 
to the item you right-clicked. See 
right-click. 

sleep mode A low-power state that saves 
electricity when the computer is on but not 
in use.

software A program you can install on a 
computer from a diskette, CD, DVD, Zip 

disk, or the Internet. Software can be 
upgraded or uninstalled. It may contain 
system files for an operating system (OS), 
an application for creating data files, a 
utility for making the computer run 
efficiently, or a game for entertainment. 
See OS, data file, and utility.

streaming To deliver real-time 
multimedia content for you to play while it 
is being downloaded from the Internet, not 
afterwards. Several tools use advanced 
streaming technology: Microsoft Media 
Player, RealNetworks RealPlayer, and 
Vivo VideoNow. 

surf To jump from place to place on the 
Internet, searching for topics of interest, by 
clicking hyperlinks. Instead of searching 
for specific information, surfing is an 
undirected type of Web browsing. You 
amuse yourself by clicking whatever 
catches your interest. See hyperlink.

surge protector A device that protects a 
computer from fluctuations in power. A 
surge protector regulates the flow of 
electricity to the computer and prevents 
high-voltage surges from reaching and 
possibly damaging the equipment.

SVGA (super video graphics array)
A video display standard that offers greater 
resolution and color depth than VGA. The 
resolution (clarity and sharpness) of an 
image is determined by the number of 
pixels that can be displayed per square 
inch. Color depth is determined by the 
number of colors (from 256 to 16 million) 
that can be displayed simultaneously. The 
number of both pixels and colors is limited 
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by the amount of video memory on the 
SVGA system. See pixel.

system file A resource file that contains 
resources needed by the operating system, 
such as fonts, icons, and default dialog 
boxes.

 T
taskbar See Windows task bar.

table of contents For a whole CD or any 
session within a CD, it shows the number 
of tracks, their starting locations, and the 
total length of the data area. The table of 
contents does not show the length of each 
track, only its starting point.

track Every time you write to a CD, you 
create at least one track that is preceded by 
a gap. Any session may contain one or 
more tracks, and the tracks within a session 
may be of the same or of different types. 
For example, a mixed-mode CD contains 
data and audio tracks.

track-at-once A method of writing data to 
a CD. Each time a track (data or audio) is 
completed, the recording laser is stopped, 
even if another track will be written 
immediately afterwards. Link and run 
blocks are written when the laser is turned 
on and off.

U
UDF (Universal Disk Format)  A file 

system endorsed by OSTA (Optical 

Storage Technology Association) for use 
with packet writing and other recordable 
optical disc technologies. Also known as 
EAN.

upload To send information to another 
computer on the Internet.

UPS (uninterruptible power supply)
A device that provides a short-term backup 
power supply as well as surge protection. 
See surge protector.

URL (uniform resource locator)
The address of a Web site, for example, 
www.compaq.com.

USB port (universal serial bus port)
A connector for plugging in multiple, 
ultra-high-speed peripherals. USB ports 
are gradually replacing serial and parallel 
ports and are eliminating the need for so 
many connectors and cables. (Multiple 
USB peripherals can be linked together in 
a daisy chain to share the same port.) 
Windows 98 included a built-in driver for 
USB peripherals. Windows Millennium 
supports a new USB standard that is 40 
times faster than the previous standard. See 
serial port and parallel port. See also 
peripheral and driver.

Usenet (users’ network) A worldwide 
network of computers set up to transmit 
messages to newsgroups. See newsgroups.

utility A small program that helps your 
computer to manage system resources for 
optimum performance. For example, 
anti-virus, diagnostic, file back up, file 
compression, and font management 
utilities. 
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V
V.90 standard A standard adopted in 

1998 to resolve competition between two 
technologies for 56Kbps modems. (If your 
modem does not conform to the V.90 
standard, you can visit the manufacturer’s 
Web site and download a software update.)

video CD A standard for displaying full 
motion pictures with associated audio on 
CD. The video and sound are compressed 
together using the MPEG1 standard and 
recorded onto a CD Bridge CD. Video CDs 
contain one data track recorded in 
CD-ROM XA Mode 2 Form 2. It is always 
the first track on the CD (Track1). The ISO 
9660 file structure and a CD-I application 
program are recorded on this track, as well 
as the Video CD information area that 
gives general information about the Video 
CD. After the data track, video is written in 
one or more subsequent tracks within the 
same session. These tracks are also 
recorded in Mode 2 Form 2. The session is 
closed after all tracks have been written.

video phone See Internet phone.

virus A program written to cause harm to 
computers. A virus can cause unusual 
messages to be displayed on the screen, 
destroy information on the hard drive, or 
cause your hard drive to crash. Some 
viruses affect your computer immediately; 
others are set to activate on a certain date. 
See anti-virus utility. See also program, 
hard disk, and hard drive.

W
WAV A file format used to store sounds. 

WAV sound files can be identified by the 
file extension .wav. Microsoft and IBM 
developed the format for Windows-based 
programs that support sound. See file 
extension.

Web See World Wide Web.

Web browser See browser.

window A framed area that is displayed 
on the Windows desktop after you select 
an item or open a program.

Windows See Microsoft Windows.

Windows desktop The main screen you 
see when your computer completes startup. 
The desktop displays icons (small pictures) 
that represent items in the operating 
system (such as My Computer and Recycle 
Bin), shortcuts to programs installed on 
your computer, and shortcuts to folders or 
files. See shortcut.

Windows Explorer A file management 
program that lets you see the hierarchy of 
folders on your computer and the files and 
subfolders stored in each folder. 
Visualizing the hierarchy is useful for 
copying and moving files. You can open 
the folder that contains the file you want to 
move or copy, click and drag the file to a 
new folder, and then drop it in. To find 
Windows Explorer, click the Start button, 
and point to Programs. You can also 
create a shortcut to Windows Explorer.
MY PRESARIO—LEARNING MORE    GLOSSARY  21



Windows taskbar The gray bar across the 
bottom of the screen that you see when 
your computer completes startup. The 
Start button is on the left end of the 
taskbar, and the systray (a tray with icons 
and the computer clock) is on the right. 
Programs that are running but minimized 
into buttons are displayed in the middle of 
the taskbar. 

wizard Part of a program that guides you 
through a complex process, such as signing 
up with an Internet service provider or 
posting a Web site to a server. Most 
programs on CD-ROMs have wizards to 
guide you through the installation process.

World Wide Web A system of Internet 
servers that supports documents formatted 
in HTML. See HTML. See also server.

Z
Zip disk High-capacity, removable storage 

media made by Iomega Corporation. 

Zip drive The drive that reads and writes 
to a Zip disk. A Zip drive can be internal 
(installed inside the computer) or external 
(a peripheral). An external Zip drive is 
portable; it can be taken to a friend’s house 
or a client’s office.

zipped file A file that has been squeezed 
to a smaller size by compression software, 
such as WinZip, developed by Niko Max 
Computing. An archive (group of related 
files that are zipped together) can be 
transmitted as an e-mail attachment much 
faster than individual files. An archive 

takes up less storage space on your disk 
and can be identified by the file extension 
.zip. An archive contains a self-extracting 
program with the file extension .exe (for 
executable). Double-click the executable 
file, and a wizard guides you through the 
process of unzipping the files. See file 
extension and wizard.
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reassigning 3-4

N
name

user 8-7
network

Ethernet 8-3
home phoneline 8-4
installing protocols 8-6, 8-7
mapping a drive 8-8
setting up 8-6

Network Neighborhood
icon 8-6

networking
entering user name 8-7
setting password 8-7

networking PCs
accessing files 8-8
sharing folders 8-8

non-system disk 11-15
notices

European 12-4, 12-5
FCC 12-2

Now.log 9-19

O
option card

adding 10-11

P
password 8-7
patches

using 7-7
port
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1394 2-2, 2-4
audio 2-3
Ethernet 2-3
modem 2-3
mouse 2-6
parallel 2-3, 2-4, 2-5, 2-6, 2-10
power 2-3, 2-4
PS2 2-3, 2-4
serial 2-3, 2-4, 2-6
USB 2-2, 2-3, 2-4, 2-5, 2-6, 2-10

power
button 2-6
connections 2-5
port 2-4
problems with 11-14

Power Management
icon 5-4

power management 5-1, 5-4, 12-14, 12-15
for Windows 5-4
preset schemes 5-4
setting 3-10
sleep mode 5-2

power schemes
customizing 5-4
sleep mode 5-4
standby 5-4

power state
Awake 5-1
Off 5-1
sleep mode 5-1
Standby 5-1

preventive maintenance 9-1, 9-3
creating backup files 9-2
deleting files 9-2
disk defragmenter 9-7
emergencies 9-9
maximizing your hard drive 9-2
running VirusScan 9-2

ScanDisk 9-7
printer

cartridge 11-16, 11-18
connecting to a shared printer 8-12
driver 11-17
problems with 11-16
searching for 8-12
setting up 2-10
sharing 8-11

privacy 9-22
problems

audio driver 11-3
CD/DVD audio 11-4
computer 9-10
configuration files corrupted 11-14
diagnosing symptoms 9-18
digital camera audio 11-4
diskette 11-6, 11-7, 11-8
DVD-ROM 11-4
fax 11-19
games 11-21
hard drive 11-10
hard drive failure 11-6, 11-15
identifying 11-3
inserting CD 11-5
insufficient memory 11-13
Internet 11-11
keyboard commands 11-12
memory 11-14
modem 11-11
monitor 11-8, 11-9
mouse
multimedia settings 11-4
non-formatted diskette 11-6
power 11-14
prevention of 9-20
printer 11-16, 11-18
recording CD 11-5
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screen resolution 11-9
sleep mode 11-3
speakers 11-3
system files 11-15
system files damaged 11-6, 11-15
telephone equipment 12-8
volume 11-3
Web browser 11-11
Zip drive 11-8

program support
Service and Support House 3-3

protocols
IPX/SPX 8-6
TCP/IP 8-7

Q
Quick Set-Up poster 2-7

R
read-only access 8-10
records

system 9-19
Recovery CD 9-11

emergency diskette 9-11
exit 9-11
factory restore 9-11
user backup 9-11
user restore 9-11

recycle bin 6-6
emptying 6-7, 9-4
restoring deleted files 6-7

reducing view 3-7
regulations

government 12-1
remote support 9-10, 9-17
replacing

battery 12-12
CD/CD-RW drive 10-3
DVD-ROM drive 10-3

memory 10-6
Ringer Equivalence Number (REN) 12-7, 
12-10, 12-11
Run dialog box 7-6

S
safety

guidelines 12-12
ScanDisk

using 9-7
screen saver

changing 6-12
password protected 6-12

scroll mouse
See also mouse
choosing button assignments 3-8
clicking 3-6
controlling cursor movements 3-8
customizing 3-8
double-clicking 3-6
dragging and dropping files 3-6
setting up 3-8
settings 3-8
wheel 3-6

SDRAM 10-6
security 9-22
See also... notices

defined 1-3
service and support 9-10
Service and Support House 3-3
Setup.exe 7-8, 10-16
Shareware

using 7-7
shortcut

arranging 6-8
creating 6-8
defined 6-8

sleep mode 5-1, 5-4, 11-8
adjusting settings 5-2
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waking 5-2
software

adding 10-15
downloading 7-7, 7-8
fixes 7-7
installing downloaded files 7-8, 10-16
installing from a Web site 10-16
Microsoft Windows compatibility 10-15
patches 7-7
updates 9-20

speaker grill
removing 10-14

speakers
Problems with 11-3

Start button 6-2
Start menu 6-2
start-up disk 11-14
status lights 3-2
support

for the Web 9-10
remote 9-17
tools 9-10

surge protector 1-5, 2-7, 5-3
system board

components 2-5
replacing 10-1

system files 11-14
system lockup

restarting 5-3
System Record 9-19

accessing 9-19
Base.log 9-19
icon 9-19
Now.log 9-19

T
technical support

contacting 11-2

telecommunications network approvals 12-6
Telephone Consumer Protection Act of 1991 
12-9
temporary Internet files

deleting 9-5
increasing space 9-5

text
dragging and dropping 3-6
moving and copying 3-6
selecting large amounts 3-7

Tip notices
defined 1-3

tools 9-10
transfer rate

download 7-3
upload 7-3

trash
emptying 6-7, 9-4

U
update notices

displaying 9-21
upgrading components 10-2
upgrading your computer 10-1
user name 8-7
user restore 9-11
utility

Add/Remove Programs 10-15
Utility Toolbox 9-9

V
virus

McAfee VirusScan 9-8
virus See also anti-virus
VirusScan 9-2
volume

problems with 11-3
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W
warning

battery 12-12
Warning notices

defined 1-3
warranty 1-4
WAV file 4-11
WAV files 4-28, 4-29
Web

downloading files 7-8, 10-16
Web support 9-10
Windows

tools for support 9-10
Windows desktop

Network Neighborhood 8-6
storage drives 6-3

Windows Explorer
opening 6-2

Windows taskbar 6-8
changing screen saver 6-12
Control Panel 6-11
display properties 6-10

Z
Zip drive

problems with 11-8
zoom 3-7
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